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Working with Axiom Enterprise
Decision Support

Axiom Enterprise Decision Support is primarily a web-based application that helps you easily walk
through the process of configuring default system settings, managing data, setting up and processing
methods, reclasses, and overhead allocations. You can also manage unit cost calculations and cost
assignments as well as manage and view reports.

When you log into the system and launch the application, the Axiom Enterprise Decision Support home
page displays a series of card buttons that open utilities, reports, and other functions. Cards can include
multiple levels, depending on the number of tasks to complete. A breadcrumb link at the top of the page
informs you of where you are in the system. You can use these links to quickly and easily move through
the system.

Card are grouped into the following functional areas:

l Data Control - Dimension, statistics, costing, and data import management
l Data Enhancement & Refinement - Service linemanagement and processing, population

management, episode building, and encounter viewing
l Cost Accounting - System configuration, data management, methods and assumptions

management, method processing, reclass and overhead allocation management and processing,
RVU development, unit cost calculations, and cost assignment

l Reporting - Axiom Intelligence report building and standard Excel reports
l Administration - Security management, job process management, product configuration

1
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� Costing Process Guide
The Costing Process Guide is a series of grouped utilities and functions specifically for configuring and
managing the cost accounting processes. The guide is accessed by clicking the Costing Process Guide
card on the home page.

The guide works, as follows:

1. Tasks are grouped together into similar areas and sub-areas. For example, you can find all of the
tasks associated with setting up and managing methods and assumptions in theMethod and
Assumptions section. Next to the card, the page displays a description. Click the card to navigate
to the task(s) for that area.

2. The status column on the right side of the page displays tasks as Completed, In Progress, or Not
Started. You can click the circle to toggle the status from one status type to another. For example,
if all of the tasks for Data Management are now complete, click the circle to toggle the status from
In Progress to Complete.
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NOTE: All of the tasks in a specific area need to bemarked as complete in order for the button
above it to bemarked as complete. For example, in Data Management area, all of the tasks in
Data Management must bemarked complete in order for the Status column for the Data
Management button to bemarked as complete.

3. The Checklist View provides a list of tasks to complete as part of the set up and configuration
process.

TIP: You can toggle back and forth between the Guide View and the Checklist View.

4. If you need help configuring a specific area, click the question mark in the upper right corner of
each screen. A help panel displays conceptual information or contextual instructions for the page
that displays. For more detailed help, the instructions include links to fuller topics in the online
help. To access the full online help for Axiom Enterprise Decision Support, click the question mark
in the upper right corner of the page, and click Open Help. The online help opens in a separate
browser window.
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� Checklist View
From the Costing Process Guide, the Checklist View offers administrators an easy and convenient way to
manage and track each of tasks required to set up the costing process. You can add, edit, clone, and
delete processes as well as toggle to view different costing processes. The page also displays the high-
level configuration parameters for the current costing process, including the active cost set as well as the
method and versions being used.

NOTE: TheMethod section only displays thosemethods that have been selected in the System
Configuration page to be used by your organization. The Active Cost Set version comes from the
Method Definition version.

� Desktop Client
While a majority of the setup and configuration tasks can be done using theWeb Client, there are times
when you may need access to Axiom system-level utilities. The Desktop Client provides all of the options
provided by theWeb Client as well as access to multiple reports. You can also manage security,
processes, and other system administration tasks.
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About this document
This document assumes the following:

l You are familiar with navigating and using Axiom Enterprise Decision Support, including theWeb
Client and the Desktop Client.

l You have been assigned the proper role profile and/or permissions to access the utilities and
screens described in this document.

l This document only covers the reporting capabilities and instructions of Axiom Enterprise Decision
Support. For more information regarding other parts of the system, we recommend that you visit
the online help accessible through the product.
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Web Client Reports
This section describes and provides instructions for several reports and dashboards created using Axiom
Intelligence.

� Axiom Intelligence reports
Axiom Intelligence includes pre-defined role-based dashboard reports that provide insight into your
health network and services to help you manage your business and maximize performance across the
continuum, ensuring the proper care at the rate place, time, and by the correct provider.

The following tables lists the pre-defined reports and dashboards available in Axiom Intelligence for
Axiom Enterprise Decision Support:

Report Description

COVID-19 Population and Utilization
Analysis Dashboard

Provides a visualization of the impact of the COVID-19
patient population on your organization, including
monitoring ongoing and dynamic changes to volume and
demographics as well as cost utilization data.

Health Network Summary Dashboard Provides an easy and clear way to understand your overall
performance as well as identify opportunities for
improvement by showing data for patients, volume, Case
Mix Index (CMI), ALOS, and margin analysis.

Inpatient Service Line Dashboard Displays a view of all the inpatient data for service lines,
with the ability to drill through to any service line at a trend
level, volume view, revenue view, and cost view.

Outpatient Service Line Dashboard Displays a view of all the outpatient data for service lines,
with the ability to drill through to any service line at a trend
level, volume view, revenue view, and cost view.

Professional Service Line Dashboard Displays a view of all the professional billing data for service
lines, with the ability to drill through to any service line at a
trend level, volume view, revenue view, and cost view.

2
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� Axiom Clinical Performance Measures (CPM)

NOTE: Axiom Clinical PerformanceMeasures is only accessible if your organization has a license for
Axiom CPM.

Axiom Enterprise Decision Support with Clinical PerformanceMeasures (CPM) helps organizations
establish a comprehensive view of service line performance across financial and clinical performance
measures. Reports and analytics facilitate the conversation between finance and clinical process
improvement teams, highlighting opportunities where quality and cost outcomes could be improved.

The following tables lists the reports included in the CPM Dashboard:

Report Description

Inpatient Executive Summary Displays KPI views of clinical and financial data to help
inform and drive decision making for executives.

Inpatient Volume Analysis report Provides volume trends and details for inpatient cases. To
return to the Inpatient Executive Summary Dashboard,
click the arrow in the upper right corner.

Critical Care Utilization Analysis report Provides benchmarking data regarding inpatient cases that
required critical care. To return to the Inpatient Executive
Summary Dashboard, click the arrow in the upper right
corner.

ALOS Analysis report Provides benchmarking data regarding the Average Length
of Stay for your organization. To return to the Inpatient
Executive Summary Dashboard, click the arrow in the
upper right corner.

Margin Analysis report Provides regarding details regarding margin analysis across
service lines. To return to the Inpatient Executive Summary
Dashboard, click the arrow in the upper right corner.

Mortality Analysis report Provides KPI metrics and details regarding mortality rates
at your organization and across service lines. To return to
the Inpatient Executive Summary Dashboard, click the
arrow in the upper right corner.

Readmission Analysis report Provides KPI metrics and details regarding readmission
rates at your organization and across service lines. To
return to the Inpatient Executive Summary Dashboard,
click the arrow in the upper right corner.
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Report Description

Patient Safety Indicator (PSI) Analysis
report

Provides metrics and details regarding PSI at your
organization and across service lines. To return to the
Inpatient Executive Summary Dashboard, click the arrow in
the upper right corner.

Hospital Acquired Condition (HAC)
Analysis report

Provides metrics and details regarding HAC at your
organization and across service lines. To return to the
Inpatient Executive Summary Dashboard, click the arrow in
the upper right corner.

Cost of Quality Variation report Provides KPI measurements and other details related to
determining potential cost savings opportunities. To
return to the Inpatient Executive Summary Dashboard,
click the arrow in the upper right corner.

Axiom Intelligence reporting
Using Axiom Intelligence reporting, you can perform ad-hoc analysis and explore your data using
interactive data visualization tools. The Axiom Intelligence reporting solution leverages Microsoft Power
BI to provide access to industry-leading business intelligence reporting.

NOTE: Axiom Intelligence reporting is a cloud-based feature that is only available in Axiom Cloud
systems. Axiom Intelligence reports rely on an engineered data model and specifically licensed
features, which are only available in conjunction with certain Axiom Enterprise Decision Support
products. If you currently license Axiom Enterprise Decision Support industry-specific products,
please review your Product Release Notes for details regarding the availability of Axiom Intelligence
reporting. Alternatively, if you would like to independently useMicrosoft PowerBI to query your
existing Axiom Enterprise Decision Support data set, please refer to this article to instruct your
information technology professionals to establish an OData connection.

About Axiom Intelligence reporting
Using Axiom Intelligence reporting, you can visually explore your Axiom Enterprise Decision Support
data. Axiom Intelligence reports display data using a variety of interactive data visualization tools, such
as charts, tables, maps, matrices, and KPIs. You can easily filter and drill this data to gain insights into
your organization.

Axiom Intelligence reports can be created, viewed, and edited from the Report Designer in theWeb
Client. Axiom Intelligence reports are stored in the Reports Library just like other reports.
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NOTE: Axiom Intelligence reporting is a cloud-based feature that is only available in Axiom Cloud
systems. Axiom Intelligence reports rely on an engineered data model and specifically licensed
features, which are only available in conjunction with certain Axiom Enterprise Decision Support
products. If you currently license Axiom Enterprise Decision Support industry-specific products,
please review your Product Release Notes for details regarding the availability of Axiom Intelligence
reporting. Alternatively, if you would like to independently useMicrosoft PowerBI to query your
existing Axiom Enterprise Decision Support data set, please refer to this article to instruct your
information technology professionals to establish an OData connection.

� Architecture of Axiom Intelligence reporting
The Axiom Intelligence reporting solution leverages Microsoft Power BI to provide access to industry-
leading business intelligence reporting. The Axiom Cloud provides the necessary infrastructure to
support using Power BI as part of your Axiom Enterprise Decision Support system.

Axiom Intelligence reporting requires a defined datamodel that specifies the Axiom Enterprise Decision
Support data to be available in reports. This model is provided by your Axiom Enterprise Decision
Support product installation, and is designed to provide access to themost useful data for business
intelligence reporting. All data within themodel can be used in Axiom Intelligence reports. Currently,
Axiom Enterprise Decision Support does not support modifying the provided model or creating
additional custom models.

Themodel data is cached for access in Axiom Intelligence reports, to provide optimal performance as you
explore the data. If changes aremade to the data in Axiom Enterprise Decision Support, the data must be
synchronized in order to update the data available to Axiom Intelligence reports. This synchronization
can occur on demand, or at scheduled intervals, or in response to certain triggering events. For more
information, seeManaging data for Axiom Intelligence reporting.

� Creating and accessing Axiom Intelligence reports
Axiom Intelligence reports are created in Axiom Enterprise Decision Support using an embedded
Microsoft Power BI editor. You can create a new report and launch this editor using the Report Designer
in theWeb Client. For more information, seeManaging Axiom Intelligence reports.

The data source shown in the report editor is the Axiom Enterprise Decision Support data defined in the
product model. You can use this data in a wide array of Power BI visualizations, and set up various
interactivity options for the report, such as filtering and drilling. For more information, see Using the
Axiom Intelligence report editor.

End users can viewAxiom Intelligence reports using theWeb Client browser. In theWeb Client, Axiom
Intelligence reports can be accessed as follows:

l Using the Report Designer page
l Using the Navigation panel in theWeb Client Task Bar
l Using links within a form home page (or within other forms and web reports)
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Axiom Intelligence reports are also visible in the Desktop Client in the Reports Library. When an Axiom
Intelligence report is launched from that location, it opens in theWeb Client browser. For more
information, see Viewing Axiom Intelligence reports.

Axiom Intelligence reports use the ABI file type, and are distinguished from other types of reports using a
special icon .

� Security considerations
Security for Axiom Intelligence reporting is controlled as follows:

l File security is controlled using the Files tab of security, just like any other report type in Axiom
Enterprise Decision Support. Users can only see and open report files if they have at least read-
only access, and they can only edit report files if they have read/write access. Additionally, any
user with read/write access to a folder in the Reports Library (or access to My Documents) can
create a new report file.

l Data security is controlled using the AI Tables tab of security. This is a special area of security that
controls data access within Axiom Intelligence reports only. While users are viewing or editing
Axiom Intelligence reports, their access to data is limited according to the permissions defined on
the AI Tables tab. Table permissions defined on the Tables tab do not affect data access in Axiom
Intelligence reports.

Data security for Axiom Intelligence reports is cached along with the report data. If any changes aremade
to security that impact access to Axiom Intelligence data, themodel must be synchronized so that the
changes take effect. This synchronization happens automatically when saving changes to security
settings. For more information, seeManaging security for Axiom Intelligence reporting.

Viewing Axiom Intelligence reports

In the Report Designer, you can browse all of the Axiom Intelligence reports that are available to you, and
open them to view report data using business intelligence tools and visualizations. In order to open an
Axiom Intelligence report, you must have at least read-only access to the report, as defined in Axiom
Enterprise Decision Support security. Axiom Intelligence reports can be opened from either theWeb
Client or the Desktop Client.

This topic discusses the default way to access and viewAxiom Intelligence reports. Your system may be
designed so that you can open these reports in other ways, such as:

l Using the Navigation panel in theWeb Client
l Using links within your home page or other files
l Using links within a task pane or ribbon tab in the Desktop Client

� Opening an Axiom Intelligence report using the Web Client
You can open Axiom Intelligence reports using the Report Designer page in theWeb Client.
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To access the Report Designer page:
l From the Enterprise Decision Support home page, in the Reporting section, click Report Builder.

All of the Axiom Intelligence reports that you have permission to access are listed underneath the Axiom
Intelligence Reports header. To open a report, click on it.
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Example Report Designer page

Reports are displayed in last-modified order, with themost recently created or modified reports on top.
You can hover your cursor over a report to see when the report was last modified and by whom.

� Opening an Axiom Intelligence report using the Desktop Client
You can open Axiom Intelligence reports from the Reports Library in the Desktop Client (Excel Client or
Windows Client). You can differentiate Axiom Intelligence reports from other types of Axiom Enterprise
Decision Support reports using the following icons:

Axiom form

Axiom Intelligence report

Web report

Spreadsheet Axiom file

To open an Axiom Intelligence report:
1. On the Axiom tab, in the Reports group, click Reports to bring up the Reports menu.

NOTE: In systems with installed products, this featuremay be present on a different ribbon
tab, such as theMain tab.
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TIP: You can also open reports from the Explorer task pane or Axiom Explorer.

2. Use the Reports Library folders at the bottom of themenu to navigate to the specific report that
you want to open, and then click on it.

The Axiom Intelligence report opens in theWeb Client using your default browser.

� Viewing data in an Axiom Intelligence report
When you open an Axiom Intelligence report, it displays a configured set of Axiom Enterprise Decision
Support data using visualizations. Visualizations are items such as charts, tables, maps, matrices, and
KPIs. The report may contain other visual elements for navigation, drilling, and filtering.

Depending on the report configuration, you can explore and filter the data using features such as:
l Filtering: Data can be filtered in various ways.

o You can use the Filters pane along the right-hand side of the screen to filter the entire
report, the current report page, or the currently selected visualization. These filters may be
saved in the report, or you can apply new filters as needed using the Filter Library panel.

o Selecting a field in a visualization can filter other visualizations that use the same field.

o The report may contain drop-down lists, slicers, or other visual elements that can be used
to filter data.

l Drilling: Visualizations can be associated with hierarchies, so that you can drill down the hierarchy
to see the visualization data at different levels.

l Bookmarks: You can use bookmarks to view designated areas of interest and apply predefined
filters. Click the Show Report Bookmarks icon to show the Bookmarks panel, and then select
from defined bookmarks (if present).

For more information on what you can do when viewing a report, see the Power BI documentation.

NOTE: Data in Axiom Intelligence reports is not live. Recent changes to Axiom Enterprise Decision
Support data may not be available in Axiom Intelligence reports if the data has not been
synchronized. For more information on howAxiom Intelligence data is managed, seeManaging data
for Axiom Intelligence reporting.

� Changing the color theme for an Axiom Intelligence report
Axiom Intelligence reports use a specified color theme in visualizations and other report elements. When
viewing an Axiom Intelligence report, you can change the color scheme as needed. Changing the color
scheme to use a different set of colors may make it easier to review certain visualizations.
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When an Axiom Intelligence report is open in viewing mode, any color scheme changes only apply to the
current report session. If you want to change the default color scheme for the report, you must make
the change in the report editor and save the report.

1. Click the Report Settings icon in theWeb Client Task Bar.

2. In the Report Settings panel, select the desired theme.

The report updates to use the specified theme.

Using saved filters in Axiom Intelligence reports

Filters that are used often in Axiom Intelligence reports can be saved to the centralized Filter Library for
reuse. Once a filter has been saved, you can open any Axiom Intelligence report and apply the filter to
that report.

The ability to save and reuse filters can improve ease-of-use by allowing you to easily apply frequently
used filters, without needing to define the filter each time. Additionally, when using the Filter Library, you
can change report filters without needing the ability to edit the report.

The Filter Library panel is available to any user who has at least read permission to one or more Axiom
Intelligence filters in the Filters Library. If you do not have this access, then the filter icon does not display
on the task bar.
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Example report showing relationship between Filter Library panel and the Filter pane

� Applying a saved filter
While you are in an Axiom Intelligence report, you can apply a saved filter in the Filter Library to that
report. When applying a saved filter, you can choose to apply it at the page level or the report level, and
you can choose whether to overwrite existing filters or append to existing filters. The data in the page or
report is then refreshed according to the applied filter.

Saved filters can be applied to any Axiom Intelligence report, whether it is in view-only mode or edit
mode. If the report is in view-only mode, then the filter will apply to the current session only. If the
report is in edit mode, and you choose to save the report after applying the filter, then the filter will
become saved in the report.

To apply a saved filter to an Axiom Intelligence report:
1. Click the Filter Library icon in theWeb Client Task Bar.
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Filter Library panel

2. In the Filter Library panel, review and set the following options as needed:

Item Description

Context Specifies the context where the filter will be applied. Select one of the
following:
l Report: Apply the filter to all pages of the report. The filter will be

placed in the Filters on all pages section of the report's Filter pane.
l Active Page: Apply the filter to the current page of the report. The filter

will be placed in the Filters on this page section of the report's Filter
pane.

Apply Filter
Action

Specifies whether the applied filter overwrites the existing filters or is
appended to the existing filters:
l Replace Existing: The selected filter replaces any existing filters in the

specified context.
l Append to Existing: The selected filter is added to any existing filters in

the specified context.

3. Click Apply Filter to select the filter to apply.

4. In the Filter Library dialog, select the filter that you want to apply, and then click OK.

This dialog shows all Axiom Intelligence filters that you have rights to access, as determined by
your security permissions to the Filter Library.
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Example Filter Library dialog

The selected filter is applied to the context specified in the Filter Library panel, using the specified action.
If the selected filter includes multiple filter cards, all of the cards are added to the context. Additionally,
the last filter that you applied displays at the bottom of the Filter Library panel, for reference.
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Example Filter Library showing the last filter applied

NOTE: Axiom Enterprise Decision Support does not perform any validation to determine whether the
selected filter is relevant to the current report or page. Depending on the report configuration and
the data shown, the selected filter may have no impact on the report or the page.

For example, imagine that you are in the following report. This report has an existing Year filter that is
applied to all pages of the report.
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Starting filters in report

Then, you use the Filter Library panel to apply a filter. The Filter Library panel is currently configured as
Context=Report and Apply Filter Action=Replace Existing. Your selected filter therefore overwrites the
current report-level filter, so that the previous Year filter is now replaced by an Entity filter.
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Report-level filter has been replaced with filter from library

If instead the Filter Library panel had been configured as Apply Filter Action=Append to Existing, then you
would now have two report-level filters—the existing filter of Year and the newly applied filter of Entity.
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Report-level filter has been appended with filter from library

And if instead the Filter Library panel had been configured as Context=Active Page, then the report-level
filter would have been left as is, and the filter would have overwritten or been appended to the page-
level filters.

� Saving a filter
While you are in an Axiom Intelligence report, you can save the current report-level filter or page-level
filter to the Filter Library for reuse. When saving a filter, all filter cards in the selected context are saved.
For example, if you are saving the report-level filter, and there are currently three filter cards in the Filters
on all pages section of the Filter pane, then all three cards are saved in the filter. If later the saved filter is
applied to another report, all three filter cards will be applied.

NOTE: When you save a filter, the context is only used to determine which filters are being saved
from the report. The context is not flagged on the saved filter. Once a filter is saved, it can then be
applied to any context.

In order to save a new filter, you must have read/write permission to at least one folder in the Filter
Library, or have access to theMy Documents folder. In order to overwrite an existing filter, you must
have read/write permission to the filter file. If you do not have read/write access to any Filter Library
folder or file, then the Save Filter button does not display on the Filter Library panel.
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To save an Axiom Intelligence report filter to the Filter Library:
1. Click the Filter Library icon in theWeb Client Task Bar.

Filter Library panel

2. In the Filter Library panel, review and set the Context to specify which report filters will be saved
to the Filter Library:

l Report: Select this option to save the filters in the Filters on all pages section of the
report's Filter pane.

l Active Page: Select this option to save the filters in the Filters on this page section of the
report's Filter pane.

3. Click Save Filter to save the filters in the specified context.

4. In the Save As dialog, select the folder where you want to save the filter, then enter the File name
and optionalDescription. Click Save to save the filter to the specified location.
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Keep in mind the following:
l If the filter is saved to a folder in the Filter Library, then any user with permission to that

folder will be able to apply the filter to their reports. Users can view the descriptions when
selecting filters to apply, so it is recommended to define a description that explains what
the filter will do.

l If you have access to theMy Documents folder, you can save the filter to that location. In
this case, only you will be able to reuse the filter.

For example, imagine that you are in the following report and you want to save the current report-level
filter for reuse in other reports.
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Example report-level filter with two filter cards

When you save this filter (with the Filter Library context set to Report) both of the filter cards in the
Filters on all pages section are saved to a single filter file in the Filter Library. If that saved filter is then
applied to another report, both filter cards will be applied to the context specified for the apply action.
Although the filter was saved from the report-level context, once it is saved it can be applied to either the
report-level or the page-level.

� Editing or deleting a filter
Saved Axiom Intelligence filters cannot be edited directly. If you want to edit the filter contents, you must
do the following:

l Apply the saved filter to a report.
l Edit the filter in the report as desired.
l Save the filter from the report, and select the same file name and folder location as the existing

filter. The existing filter will be overwritten with the new filter.

If a filter needs to be deleted, this can only be done in the Desktop Client, using Axiom Explorer or the
Explorer task pane. It is not possible to delete filters using the Filter Library panel in theWeb Client.

� More information for administrators
User access to filters is controlled by security access to the Filter Library, as defined on the Files tab of the
Security Manager. For users who should only be able to apply filters, you can grant read-only access to
the necessary files and folders. For users who should be able to save and apply filters, you can grant
read/write access to the necessary files and folders.
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Managing Axiom Intelligence reports

You can create Axiom Intelligence reports to perform ad-hoc analysis and explore Axiom Enterprise
Decision Support data using interactive data visualization tools.

In order to create an Axiom Intelligence report, you must have read/write access to at least one folder in
the Reports Library, as defined in Axiom Enterprise Decision Support security. Also, if you have access to
My Documents, you can create and save Axiom Intelligence reports there.

You can start the report creation process from either theWeb Client or the Desktop Client. However, all
Axiom Intelligence report creation and editing activity takes place in theWeb Client. If you initiate report
creation from the Desktop Client, you are automatically taken to theWeb Client.

NOTE: Axiom Intelligence reporting is a cloud-based feature that is only available in Axiom Cloud
systems. Axiom Intelligence reports rely on an engineered data model and specifically licensed
features, which are only available in conjunction with certain Axiom Enterprise Decision Support
products. If you currently license Axiom Enterprise Decision Support industry-specific products,
please review your Product Release Notes for details regarding the availability of Axiom Intelligence
reporting. Alternatively, if you would like to independently useMicrosoft PowerBI to query your
existing Axiom Enterprise Decision Support data set, please refer to this article to instruct your
information technology professionals to establish an OData connection.

� Creating an Axiom Intelligence report in the Web Client
In theWeb Client, you can create newAxiom Intelligence reports using the Report Designer page.

To create an Axiom Intelligence report in the Web Client:

1. Click themenu icon in the left side of the Task Bar to open the Navigation panel. Then, select
Report Designer.
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Alternatively, you can go to directly to the Report Designer page as follows:

Example Cloud
URL

https://ClientName.axiom.cloud/Reports

Where ClientName is the name of your Axiom Cloud system.

Example On-
Premise URL

http://ServerName/Axiom/Reports

Where ServerName is the name of the Axiom Application Server, and Axiom is
the default name of the virtual directory.

NOTE: If you do not see the Report Designer in the Navigation panel, this may mean that your
organization's Navigation panel has not been updated (or that your organization has
customized the panel to exclude it).

2. In the Report Designer page, click theNew Report button to the right of the Axiom Intelligence
Reports header.
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A newAxiom Intelligence report opens in the report editor.

3. Using the report editor, add visualizations to the report and configure them to show the desired
data. For more information, see Using the Axiom Intelligence report editor.

Example Axiom Intelligence report in the report editor
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4. In the left-hand side of the report editor toolbar, click File > Save As.

5. In the Save As dialog, select the folder where you want to save the report, then enter the File
name and optionalDescription. Click Save to save the report to the specified location.
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� Creating an Axiom Intelligence report in the Desktop Client
In the Desktop Client (Excel Client or Windows Client), you can access the Report Designer page from the
Reports menu.

To create an Axiom Intelligence report in the Desktop Client:
l On the Axiom tab, in the Reports group, select Reports > Report Designer.

NOTE: In systems with installed products, this featuremay be present on a different ribbon
tab, such as theMain tab.

TheWeb Client opens to the Report Designer page. From this point, all creation activities take place in
theWeb Client, and the steps are the same as described in the previous section.

� Editing an Axiom Intelligence report
You can edit existing Axiom Intelligence reports as needed, as long as the report was not installed by a
product package. You must have read/write access to the report file in order to edit it, as defined in
Axiom Enterprise Decision Support security.

Axiom Intelligence reports can only be edited in theWeb Client. Although you can open existing Axiom
Intelligence reports from within the Desktop Client, you cannot edit them in that client. Once the report
is open, all editing activities take place in theWeb Client.

Only one user at a time can open an Axiom Intelligence report for editing. If another user attempts to
edit the report while it is locked to another user, then it can only be opened as read-only. When a report
is opened as read-only in the editor, no changes can be saved, but Save As can be used to save a copy of
the file. Although the report is locked for editing, other users can continue to view the report as normal.

Product-controlled Axiom Intelligence reports are locked and cannot be edited. However, if you have
read/write access to the locked report, then you can open the report as read-only in the editor for
purposes of saving a copy of it with a new name.

Reporting Guide Axiom Enterprise Decision Support │ 32



To edit an Axiom Intelligence report:
1. Open the report that you want to edit.

2. In the right-hand side of the task bar, click theGo to Edit Mode icon .

The report opens in the report editor.

3. Using the report editor, make changes to the report as desired. For more information, see Using
the Axiom Intelligence report editor.

4. In the right-hand side of the report editor toolbar, click Save to save your changes.

You can also click theGo to Preview Mode icon at any time to view and interact with the
report as end users will see it. The report is automatically saved before you enter previewmode.
To return to the report editor from previewmode, click theGo to Edit Mode icon again.

If you want to save a new copy of the report instead ofmodifying the existing report, you can use
File > Save As in the left-hand side of the report editor toolbar. If you have opened the report as
read-only, then Save As is the only option.
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� Deleting an Axiom Intelligence report
Axiom Intelligence reports cannot be deleted in theWeb Client; they must be deleted in the Desktop
Client.

You can delete an Axiom Intelligence report if you have read/write permission to the parent folder, and if
the report was not installed by a product package. Product-controlled Axiom Intelligence reports are
locked and cannot be deleted.

To delete an Axiom Intelligence report:
1. On the Axiom tab, in the Administration group, clickManage > Axiom Explorer.

TIP: You can also use the Explorer task pane to delete an Axiom Intelligence report.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. Click
System Browser to open Axiom Explorer.

2. Navigate to the Reports Library, and then locate the report that you want to delete.

3. Right-click the report and then select Delete.

Using the Axiom Intelligence report editor

Using the Axiom Intelligence report editor, you can add visualizations and other elements to your report,
and define the data shown in each visualization.

Axiom Intelligence reports leverageMicrosoft Power BI to provide access to industry-leading business
intelligence reporting. This topic provides a brief overview of the features available when creating
reports. For more information on using visualizations, filters, and other features in the report editor, see
the Power BI documentation.

The Axiom Intelligence report editor is available as follows:
l When you create a newAxiom Intelligence report, the new report is automatically opened in the

editor.

l When viewing an existing Axiom Intelligence report, you can switch to edit mode. Open the report
that you want to edit, then click the edit icon in the Task Bar.
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� Report editor overview
The Axiom Intelligence report editor uses Microsoft Power BI technology embedded within Axiom
Enterprise Decision Support. When you open an Axiom Intelligence report in edit mode, a third toolbar
becomes available to provide access to report editing features. The panels along the right-hand side of
the editor provide access to visualizations and your Axiom Enterprise Decision Support data.

Example Axiom Intelligence report editor

To create the report, you can add data visualizations and other report elements to the report canvas.
You can move items by dragging and dropping them to different areas of the canvas, and you can resize
items by clicking and dragging the frame handles.

Axiom Intelligence reports can havemultiple pages. To add new pages or delete pages, use the page
controls at the bottom of the editor. To configure display options for the report and its pages, use the
Viewmenu.

� Fields and visualizations
The Fields panel along the right-hand side of the editor displays the available Axiom Enterprise Decision
Support data for the report. The data available to Axiom Intelligence reports is determined by your
Axiom Intelligencemodel, which is provided as part of the product installation. Currently, themodel
cannot bemodified.

The available fields are based on the table data in your Axiom Enterprise Decision Support system. Some
fields may directly correspond to tables and columns in Axiom Enterprise Decision Support, while others
may represent transformations or calculations of table data. See your product documentation for more
information on the data included in themodel.
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NOTE: The Fields panel shows all data fields used by themodel, regardless of whether the current
user has access to data in that field (as defined by that user's permissions on the AI Tables tab in
security). When a field is used in the report, the data resulting from that field depends on the user's
security permissions.

Axiom Enterprise Decision Support data can be viewed in the report using visualizations. You can create
and configure visualizations using the Visualizations panel along the right-hand side of the editor. Each
visualization is a different way to display data, including various chart types, tables, maps, matrices,
cards, and KPIs.

You can create new visualizations in any of the following ways:
l Click in an empty area of the report (so that nothing is selected), then select a visualization. The

selected visualization is added to the report. You can then add data to the visualization by
selecting fields in the Fields panel.

l Click in an empty area of the report (so that nothing is selected), then select a field from the Fields
panel. A visualization is automatically added to the report, displaying data from the selected field.
You can then change the visualization type by selecting a different visualization, and add more
fields to the visualization.

l Drag and drop a field from the Fields panel to a blank area of the report. A visualization is
automatically added to the report, displaying data from the field. You can then change the
visualization type by selecting a different visualization, and add more fields to the visualization.

Once a visualization has been added to the report, you can further configure it by using the Fields,
Format, and Analytics tools within the Visualizations panel. The available options depend on the
visualization type.

For more information on using visualizations, see the Power BI documentation.

NOTE: Data in Axiom Intelligence reports is not live. Recent changes to Axiom Enterprise Decision
Support data may not be available in Axiom Intelligence reports if the data has not been
synchronized. For more information on howAxiom Intelligence data is managed, seeManaging data
for Axiom Intelligence reporting.

� Filters
There are several different levels of filters available in Axiom Intelligence reports to filter data. Filters can
be set in the Filters section of the Visualization panel.

l Visual level filters apply to specific visualizations in the report. Select the visualization in the
report that you want to filter, then configure the filters. By default, all fields that are currently used
in the visualization are available for filtering. If you want to filter by a field that is not displayed in
the visualization, you can drag and drop the field to this area.
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l Page level filters apply to all visualizations on the current report page. Go to the page that you
want to filter, then drag and drop fields to this area in order to filter by those fields.

l Report level filters apply to all visualizations in the report. Drag and drop fields to this area in
order to filter by those fields.

NOTE: When defining page-level and report-level filters, you can leverage the Filter Library to store
frequently-used filters and apply saved filters. For more information, see Using saved filters in Axiom
Intelligence reports.

When viewing the report, end users can interact with these filters to change the data shown in the
report.

For more information on using filters, see the Power BI documentation.

� Bookmarks
You can create bookmarks within the report in order to:

l Direct end users to certain pages or visualizations within the report
l Save pre-set filter configurations

To work with bookmarks, click the Show Report Bookmarks icon in theWeb Client Task Bar .

The Bookmarks panel opens along the right-hand side of the editor. You can configure the report a
desired way, and then use this panel to save that configuration as a bookmark. When end users view the
report, they can select bookmarks to load the saved configurations. For more information on using
bookmarks, see the Power BI documentation.

� Report settings
Using the Report Settings panel, you can configure various general settings for an Axiom Intelligence
report, such as:

l An optional report title to display in the browser tab
l The color theme to apply to the report

To configure report settings:

1. Click the Report Settings icon in theWeb Client Task Bar.
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2. In the Report Settings panel, complete the settings as needed.

The following settings are available:
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Item Description

Report Title Optional. Defines alternate title text to display in the browser tab instead of the
full file name. By default, the file name is used as the report title.

Theme Specifies the color theme to apply to the report. The theme affects colors used
in visualizations and other report elements.

The color theme can also be changed when viewing the report, to change the
colors used in the current session only.

Help Code Optional. Associates the report with a custom help code, to provide report-
specific help. Clients can select any help code as defined in the Custom Help
Admin area.

Reports installed by a product packagemay use a help code from the product
help file.

Help Source By default, this is set to Database and should be left as is for client use.

Reports installed by a product packagemay use the Product help source in
order to display help from the applicable product help file.

� Previewing and saving the report
At any time, you can save the current report configuration by clicking Save in the right-hand side of the
report editor toolbar.

If you want to save a copy of the report, click File > Save as in the left-hand side of the report editor
toolbar. You can also save the current report using this menu.
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If you want to see how end users can interact with the report, you can use the preview feature.
l To preview the report, click Go to Preview Mode in the right-hand side of the task bar. This

automatically saves the report, and then opens it in viewer mode. You can then test the end user
experience as needed.

l To return to the editor and make further changes, click Go to Edit Mode in the right-hand
side of the task bar.

When you navigate away from the report or close the browser tab, you will be prompted to save the
report as follows:

l If you have not saved the report since entering edit mode, you will be prompted to save.
l If you have saved the report once during the current edit session, you will not be prompted to

save.
l Each time you switch from edit mode to preview, then back to edit mode, the save prompt is reset

and will display again if you do not save.
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Managing security for Axiom Intelligence reporting

Security for Axiom Intelligence reporting is controlled as follows:
l File security is controlled using the Files tab of security, just like any other report type in Axiom

Enterprise Decision Support. Users can only see and open report files if they have at least read-
only access, and they can only edit report files if they have read/write access. Additionally, any
user with read/write access to a folder in the Reports Library (or access to My Documents) can
create a new report file.

l Data security is controlled using the AI Tables tab of security. This is a special area of security that
controls data access within Axiom Intelligence reports only. While users are viewing or editing
Axiom Intelligence reports, their access to data is limited according to the permissions defined on
the AI Tables tab. Table permissions defined on the Tables tab do not affect data access in Axiom
Intelligence reports.

Any permission changes made to the AI Tables tab do not take effect immediately. Security changes
must be synchronized before they apply to the static data set used by Axiom Intelligence reporting.

� How Axiom Intelligence security permissions work
To define security for Axiom Intelligence data, you can grant full or filtered access on a per table basis, for
the tables used in the Axiom Intelligencemodel. This security is applied only when users are viewing data
within Axiom Intelligence reports.

Security permissions for Axiom Intelligence data are not configured in the sameway as table permissions
set on the Tables tab. For example:

l Data access in Axiom Intelligence reports is always read-only. Axiom Intelligence reports do not
support saving data. "Full access" in this context does not mean read/write access; it means the
user is eligible to view all eligible data for the table within Axiom Intelligence reports.

l Table types cannot be used when configuring security for Axiom Intelligence data. Security is set at
the table level only.

l The permissions set on the AI Tables tab have no impact on the permissions set on the Tables
tab, and vice versa. For example, a user can have full access to a table within Axiom Enterprise
Decision Support (via the Tables tab), but no access to the same table within Axiom Intelligence
reports (via the AI Tables tab).

Additionally, the configuration of the Axiom Intelligencemodel impacts the way that Axiom Intelligence
security permissions are applied to tables. Generally speaking, product-delivered models are configured
as follows:

l Tables with lookup relationships are configured to have dependent security in Axiom Intelligence
reporting. This means that if a table has a lookup to a reference table, any AI security filters
defined on the lookup reference table apply to both tables.
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For example, imagine that you have a table named Encounter with a lookup to the Entity table. If
the Entity table has an AI filter defined of Entity=3000, this filter also applies to the Encounter
table. This is different from regular Axiom Enterprise Decision Support table security, where filters
defined on lookup reference tables only apply when the lookup reference table is the primary
table for the query.

l Models are configured so that AI security can be set on certain important reference tables. This
security is then inherited by other tables that look up to these securable tables. This simplifies the
security setup and allows full use of business intelligence features within reports.

l If a table in themodel is not flagged as securable, and does not look up to a securable table, then
all users have access to the data in that table within Axiom Intelligence reports. This should be
reserved for supporting tables that do not contain financial data or other sensitive data.

Role inheritance and subsystem restrictions work as normal for Axiom Intelligence data permissions.

� Configuring security for Axiom Intelligence data
Access to data in Axiom Intelligence reports is controlled using the AI Tables tab. You can configure
permissions at the user and/or role level. If subsystems are used, the subsystem must also configure
permissions on this tab, to define the boundary of allowed permissions for users in that subsystem.

The left-hand side of the tab lists the tables that have been flagged as "securable" in the Axiom
Intelligence data model. As discussed in the previous section, product-delivered models are typically
configured so that only important reference tables are configured as securable. Any security defined on
these reference tables applies to the reference table itself, and any tables that look up to the reference
table.

When you select a table in the list, you can configure the security settings for the user or role within the
Configured Permissions section in the right-hand side of the tab.
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Example AI Tables tab

For each table, you can grant full or filtered access to its data as follows:

Item Description

Full AI Access Selecting this option means the user is eligible to view all data in this table,
within Axiom Intelligence reports.

If this option is enabled, the AI Filter box is hidden because it no longer applies.

AI Filter Defining a filter means the user is eligible to view all data in the table that meets
the filter, within Axiom Intelligence reports.

To define a filter, type the filter into the Filter box, or use the Filter Wizard .
After defining a filter, you can validate the filter syntax by clicking the Validate
filter button .
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As discussed in the previous section, the user's eligibility to view data from a table may be further
impacted by the security permissions set on tables with lookup relationships. For example, a user might
have Full AI Access enabled for the Dept table, but if that table looks up to another securable table, then
the ability to view data in the Dept table is also impacted by the user's permissions on the lookup
reference table.

If neither option is configured, then the user has no access to data in the table, within Axiom Intelligence
reports.

� Synchronizing security updates
When the Axiom Intelligencemodel and data are initially synchronized, the current security settings as
defined on the AI Tables tab are applied as well. If any changes aremade in Axiom Enterprise Decision
Support security that impact access to Axiom Intelligence data, these changes must be synchronized or
else they will not take effect in Axiom Intelligence reports.

The following types of security changes affect Axiom Intelligence reporting:
l Any changes to the AI Tables tab, for any user, role, or subsystem
l Adding a user to a role or a subsystem, if the role or subsystem has defined permissions on the AI

Tables tab
l Removing a user from a role or a subsystem, if the role or subsystem has defined permissions on

the AI Tables tab

When you save security settings in the Security Manager dialog, or using Open Security in Spreadsheet,
or using a Save Type 4 report, the security settings are automatically synchronized with Axiom
Intelligence reporting. This means that saving security may take longer in systems with Axiom
Intelligence reporting enabled.

Managing data for Axiom Intelligence reporting

Axiom Intelligence reports use a subset of Axiom Enterprise Decision Support data that has been selected
to support themost useful data analytics. This data set is static to provide optimal query performance
while exploring your data, but the data set can be refreshed as needed with the latest data.

� Defining the available data
The data available to Axiom Intelligence reports is determined by the datamodel. This model is
predefined and provided by the product package installation.

The data model is designed to provide access to the data that is deemed most useful to analytical
reporting, based on the data structures used by the product. The data model determines the fields that
are available for use in Axiom Intelligence reports. Some fields may directly correspond to tables and
columns in Axiom Enterprise Decision Support, while others may represent transformations or
calculations of table data. See your product documentation for more information on the data included in
themodel.

Currently, data models cannot be customized to include additional fields or to remove existing fields.
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� Refreshing the available data
When you install a product package that includes an Axiom Intelligence data model, themodel and its
data aremade available to Axiom Intelligence reporting. This creates the initial data set used for
reporting. If any changes aremade to the data in Axiom Enterprise Decision Support after the package
installation, this data is not available to Axiom Intelligence reporting until the data is synchronized.

Axiom Enterprise Decision Support uses a Scheduler event handler named System.ProcessBITable to
synchronize data for Axiom Intelligence reporting. This event can synchronize all data, or synchronize
data for a specific table—for example, if the table has just been modified. This event can be run using a
Raise Event Scheduler task or using a RunEvent command or function. The reserved variable name Table
can be used to pass in an optional table name.

The Axiom product that provided the data model will also provide a built-in methodology to trigger this
event handler and synchronize the data. The product may be designed to synchronize data after specific
activities are performed in the software (such as after running an import or a particular data utility),
and/or it may be designed to synchronize data at regular intervals using a scheduled job. The product
may also provide a way for you to manually trigger the data synchronization as needed from an Axiom
form or from a custom task pane.

Setting the fiscal year for Axiom Intelligence

To set the fiscal year for Axiom Intelligence:
1. In the Admin ribbon tab of the Desktop Client, click System Browser.

2. In the Axiom System area, click Document Templates > Support Utilities.
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3. Double-click SystemConfigurationTemplate.

4. In theMain ribbon tab, click Refresh Data.

5. In the BI_FiscalYearStartMonth row (row 20), type the number for the corresponding fiscal year
start month.

6. In theMain ribbon tab, click Save.

7. In the Admin ribbon tab, click Scheduler.
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8. Manually run the SyncBIModel event scheduler to complete the process.

Selecting a unique patient measure type

This utility allows you to select the unique patient identifier type used by your organization, which can be
use in Axiom Intelligence to create reports and dashboards centered around specific patient data.
Options include Patient ID, Medical Record Number, or MPI.

After the unique patient identifier type is configured, the system syncs themodel (performed
automatically as part of a Scheduler job) so that your organization can use the following measures to
create Axiom Intelligence reports and dashboards:

l Patient
l Per Patient versions of the following measures:

o Cases
o Cases (GC > 0)
o All financial measures (cost, revenue, margin, allowance, etc.)

TIP: In the search field at the top of the Fields panel in Axiom Intelligence, type Per Patient to find all
of themeasures that include the Per Patient measurement type.
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NOTE: Only DSS admins have access to this utility.
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To select a patient measure for Axiom Intelligence reporting:
1. From theDSS Admin task pane of the Desktop Client, in theDecision Support Imports and Data

Maintenance section, double-click DSS Measure Configuration.

NOTE: The utility opens in a separate web browser.

2. From the Select a column drop-down, select the unique patient identifier used by your
organization.

3. Click Save.

Pre-defined Axiom Intelligence reports
Axiom Intelligence includes pre-defined role-based dashboard reports that provide insight into your
health network and services to help you manage your business and maximize performance across the
continuum, ensuring the proper care at the rate place, time, and by the correct provider.

� COVID-19 Population and Utilization Analysis Dashboard
The COVID-19 Population and Utilization Analysis Dashboard provides a visualization of the impact of the
COVID-19 patient population on your organization, including monitoring ongoing and dynamic changes
to volume and demographics as well as cost utilization data.
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For more information, see Using the COVID-19 Population and Utilization Analysis Dashboard.

� Health Network Summary Dashboard
The Health Network Summary Dashboard provides an easy and clear way to understand your overall
performance as well as identify opportunities for improvement by showing data for patients, volume,
CaseMix Index (CMI), ALOS, and margin analysis.
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For more information, see Using the Health Network Summary Dashboard.

� Inpatient Service Line Dashboard
This dashboard displays a view of all the inpatient data for service lines, with the ability to drill through to
any service line at a trend level, volume view, revenue view, and cost view.
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NOTE: This dashboard requires that your organization uses DSS PtType, and Service Line uses
PrimaryService.name.

For more information, see Using the Inpatient Service Line Dashboard.

� Outpatient Service Line Dashboard
This dashboard displays a view of all the outpatient data for service lines, with the ability to drill through
to any service line at a trend level, volume view, revenue view, and cost view.

NOTE: Requires that your organization uses DSS PtType, and Service Line uses PrimaryService.name.
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For more information, see Using the Outpatient Service Line Dashboard.

� Professional Service Line Dashboard
This dashboard displays a view of all the professional billing data for service lines, with the ability to drill
through to any service line at a trend level, volume view, revenue view, and cost view.

NOTE: Requires that your organization uses DSS PtType, and Service Line uses PrimaryService.name.
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For more information, see Using the Professional Service Line Dashboard.

Using the COVID-19 Population and Utilization Analysis Dashboard

� Overview
This dashboard report allows you to monitor ongoing and dynamic changes to volume and
demographics related to the COVID-19 patient population while also tracking utilization activity and cost
of critical resources across your organization.

� Opening the dashboard
To open the dashboard:

1. From the Enterprise Decision Support home page, in the Reporting section, click Report Builder.
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2. In the Axiom Intelligence Reports section, click COVID-19 Population & Utilization Analysis.

� Navigating the dashboard
The COVID-19 ICD-10-CM Coding Guidelines page serves as themain home page for the dashboard and
includes the following sections:

l Confirmed COVID-19 Cases
l COVID-19 Deaths
l Exposure to COVID-19
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l Signs and Symptoms Associated with COVID-19

Slicers
This section allows you to filter data by date (days, weeks, months, years), entity, and patient type. From
the slicer drop-downs, you can select a combination of the available options to select the parameters to
include in the views. The data will dynamically update with the selection of the different parameters.

Link to CDC Guidelines
The dashboard includes a link to the guidelines created by the CDC used to create the COVID-19
population definitions in Axiom Enterprise Decision Support.
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COVID-19 Population Analysis report
This report provides visualization and data details related to the ongoing and dynamic changes to
volumes and understand these new populations across demographic, geographic, and operational
sectors.

For more information, see COVID-19 Population Analysis report.
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COVID-19 Utilization Analysis report
This report provides a way to quickly investigate and drill into various aspects of the COVID-19
populations to better understand the utilization activity and cost of critical resources such as beds,
equipment, drugs, and supplies. This insight is key to both resourcing in the short term and planning for
the future.

For more information, see COVID-19 Utilization Analysis report.
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COVID-19 Population Analysis report

� Overview
This page provides demographic, geographic, and operational data regarding COVID-19 patient
populations.

To return to the dashboard home page, click the COVID-19 CDC Coding tab at the bottom of the page.

The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by date (days, weeks, months, years), entity, and patient type. From
the slicer drop-downs, you can select a combination of the available options to select the parameters to
include in the views. The data and visuals in the report will dynamically update with the selection of the
different parameters.
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� Confirmed COVID-19 Cases and Deaths
This section displays the number of COVID-19 cases and deaths across the population based on the
parameters set in the Slicer section.

� COVID-19 Confirmed Cases Trend
This bar chart displays the number of new cases and a trend line of cumulative cases over time. Hover
your cursor over each bar to view a tool tip with details regarding the date and the number of cases for
that date.

� Cases by Sex, Age, and Race
These visuals display demographic information for the COVID-19 patient population. Hover your cursor
over the chart elements to view a tool tip with the number of each type (the Cases by Sex chart also
displays the percentage of total patients for each sex).
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Click image to view full size

� COVID-19 Confirmed Cases by Point of Origin
This chart shows the location in patients are admitted. Hover your cursor over each bar to view a tool tip
with a description of the admittance location description and the number of patients admitted at that
location.

� COVID-19 Confirmed Cases by Discharge Status
This visual shows a breakdown percentage of patients by discharge status. Hover your cursor over the
individual sections of the visual to view a tool tip of the discharge status description and number of
patients with that status.
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� Confirmed COVID-19 Cases by Patient Type
This graph provides a visual representation of the number of patients by type. Hover your cursor over
each square to view a tool tip with the patient type description and number of cases for that type.
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� Confirmed COVID-19 Cases by Patient Zip
This section displays the cases by location using a map. From here, you can do the following:

l Zoom in and out of themap by using the scroll button on your mouse. You can move themap by
holding down the left mouse button and moving themouse to the area to view.

l View the zip code and number of visits for that zip code by hovering your cursor over a dot on the
map.

l View information about visits specific to that zip code by clicking a dot on themap, and the
sections on the page will adjust accordingly.

� Encounter Detail
This table displays the details for each encounter for the population. From this table, you can do the
following:

l Change the report visuals for a specific encounter by clicking a row. The system greys out the
details for the other descriptions across the page except for data specific to the description you
selected.

l Sort the table by columns in ascending or descending order by clicking the column header.
l Drill through the data by right-clicking the row, and then selecting Drill Through.
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� Encounter Viewer
When you drill through to a specific encounter from the Encounter Detail table, the Patient/Encounter
View page displays, which includes details regarding:

l Patient Identifier
l Admit Date
l Discharge Date
l Patient Detail
l Encounter Detail
l Encounter Profitability
l Provider Detail
l Diagnosis Detail
l Procedure Detail
l CPT Detail
l Charge Detail

In each table section, you can sort the information by columns in ascending or descending order by
clicking the column header. To return to the COVID-19 Population Analysis report, click the arrow in the
upper-right corner of the page.
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� Viewing data in table format
You can view the underlying data for the visualizations and tables in the report by right-clicking the graph
or table, and clicking Show as a table. A data table displays underneath the graph or table. To return to
the dashboard, click Back to report in the upper left corner of the page.
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COVID-19 Utilization Analysis report

� Overview
This page provides the data related to the utilization activity and cost of critical resources needed to care
for COVID-19 patient populations.

To return to the dashboard home page, click the COVID-19 CDC Coding tab at the bottom of the page.
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The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by date (days, weeks, months, years), entity, and patient type. From
the slicer drop-downs, you can select a combination of the available options to select the parameters to
include in the views. The data and visuals in this report will dynamically update with the selection of the
different parameters.

� Confirmed COVID-19 Cases and Deaths
This section displays the number of COVID-19 cases and deaths across the population based on the
parameters set in the Slicer section.
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� Confirmed COVID-19 Cases by Patient Type
This bar chart displays the number of cases by patient types. Hover your cursor over each bar to view a
tool tip with details regarding the patient type description and the number of cases for that type.
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� Gross Revenue and Gross Revenue per Case
This section displays the gross revenue and gross revenue per case across the population based on the
parameters set in the Slicer section.

� Confirmed COVID-19 Cases by Rev Code
This graph provides a visual representation of the number of COVID-19 cases by revenue code. Hover
your cursor over each square to view a tool tip with the revenue code description and number of cases
for that revenue code.
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� COVID-19 Confirmed Cases Cost Item Utilization
This table displays the charge details data for each encounter, including the following:

l Encounter Sequence
l Cost Item Description
l Item Type
l Service Date
l Ordering Provider Description
l Department Description
l Volume
l Amount

From this table, you can do the following:

l Change the report visuals for a specific encounter by clicking a row. The system greys out the
details for the other descriptions across the page except for data specific to the description you
selected.

l Sort the table by columns in ascending or descending order by clicking the column header.

� Charge Detail
This table displays the charge item information for encounters, including the following:

l Encounter Sequence
l Cost Item Description
l Item Type
l Service Date
l Ordering Provider Description
l Department Description
l Volume
l Amount

From this table, you can do the following:
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l Change the report visuals for a specific encounter by clicking a row. The system greys out the
details for the other descriptions across the page except for data specific to the description you
selected.

l Sort the table by columns in ascending or descending order by clicking the column header.
l Drill through the data by right-clicking the row, and then selecting Drill Through.

� Encounter Viewer
When you drill through to a specific encounter from the Charge Detail table, the Patient/Encounter View
page displays, which includes details regarding:

l Patient Identifier
l Admit Date
l Discharge Date
l Patient Detail
l Encounter Detail
l Encounter Profitability
l Provider Detail
l Diagnosis Detail
l Procedure Detail
l CPT Detail
l Charge Detail

In each table section, you can sort the information by columns in ascending or descending order by
clicking the column header. To return to the COVID-19 Population Utilization report, click the arrow in the
upper-right corner of the page.
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� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show as a table. A data table displays underneath the visualization graphic or table. To
return to the dashboard, click Back to report in the upper left corner of the page.
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Using the Health Network Summary Dashboard

� Overview
The Health Network Summary Dashboard provides data regarding patients, volume, CaseMix Index
(CMI) ALOS, and margin analysis to help you view and manage performance and identify areas of
improvement.

� Opening the dashboard
To open the dashboard:

1. From the Enterprise Decision Support home page, in the Reporting section, click Report Builder.

2. In the Axiom Intelligence Reports section, click Health Network Summary.
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� Navigating the dashboard
The Health Network Summary page serves as themain home page for the dashboard and includes the
following sections:

Reporting Guide Axiom Enterprise Decision Support │ 74



Slicers
This section allows you to filter data by time (days, weeks, months, years), entity, and financial class.
From the slicer drop-downs, you can select a combination of the available options to select the
parameters to include in the views.

Service Line Selector
This section allows you to view the dashboard metrics by service line type. When you click a service line
button, the KPI data changes dynamically specific to that service line. To view the data for all the service
lines again, click the service line button again to disengage the filter.
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Patient Analysis
The Patients KPI card shows the number of patients based on the criteria selected in the Slicer and
Service Line Selector sections, including the percentage of change over the same period the previous
year. The Patients Rolling 12Months card displays a graph of the number of patients over a rolling 12-
month period. Hover your cursor over the graph to see the number of patients for a specific month. To
open the report that includes the data behind this KPI, click the drill icon in the Patients card.

Volume Analysis
The Volume KPI card shows the case volume based on the criteria selected in the Slicer and Service Line
Selector sections, including the percentage of change over the same period the previous year. The
Volume Rolling 12Months card displays a graph of the number of cases over a rolling 12-month period.
Hover your cursor over the graph to see the number of cases for a specific month. To open the report
that includes the data behind this KPI, click the drill icon in the Volume card.

Case Mix Index Analysis
The CaseMix Index KPI card shows the CaseMix Index (CMI) for In Patient based on the criteria selected
in the Slicer, including the percentage of change over the same period the previous year. The CMI Rolling
12Months card displays a graph of CMI data over a rolling 12-month period. Hover your cursor over the
graph to see the CMI data for a specific month. To open the report that includes the data behind this
KPI, click the drill icon in the Case Mix Index card.
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ALOS Analysis
The ALOS KPI card shows the Average Length of Stay (ALOS) for In Patient based on the criteria selected
in the Slicer, including the percentage of change over the same period the previous year. The ALOS
Rolling 12Months card displays a graph of the ALOS for patients over a rolling 12-month period. Hover
your cursor over the graph to see the days for a specific month. To open the report that includes the
data behind this KPI, click the drill icon in the ALOS card.

Margin Analysis
TheMargin KPI card shows the profit margin based on the criteria selected in the Slicer and Service Line
Selector sections, including the percentage of change over the same period the previous year. The Direct
Margin Rolling 12Months card displays a graph of the direct margin dollars over a rolling 12-month
period. Hover your cursor over the graph to see the amount for a specific month. To open the report
that includes the data behind this KPI, click the drill icon in theMargin card.

Reporting Guide Axiom Enterprise Decision Support │ 77



� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show as a table. A data table displays underneath the visualization graphic or table. To
return to the dashboard, click Back to report in the upper left corner of the page.

Patient Analysis report

� Overview
This page provides TBD.

To return to the Health Network Summary Dashboard, click the arrow in the upper right corner.
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The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by time (days, weeks, months, years), entity, and financial class.
From the slicer drop-downs, you can select a combination of the available options to select the
parameters to include in the views.

� Service Line Selector
This section allows you to view the report metrics by service line type. When you click a service line
button, the KPI data changes dynamically specific to that service line. To view the data for all the service
lines again, click the service line button again to disengage the filter.
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� Patient Segment Data
TBD

� Patient by Zip
TBD

� Patient by Service Line
TBD
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� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show as a table. A data table displays underneath the visualization graphic or table. To
return to the dashboard, click Back to report in the upper left corner of the page.
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Volume Analysis report

� Overview
This page provides TBD.

To return to the Health Network Summary Dashboard, click the arrow in the upper right corner.

The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by time (days, weeks, months, years), and financial class. From the
slicer drop-downs, you can select a combination of the available options to select the parameters to
include in the views.
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� Service Line Selector
This section allows you to view the report metrics by service line type. When you click a service line
button, the KPI data changes dynamically specific to that service line. To view the data for all the service
lines again, click the service line button again to disengage the filter.

� Volume by Entity
TBD

� Patient Cases and Visits
TBD

� Volume by Patient Type
TBD
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� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show as a table. A data table displays underneath the visualization graphic or table. To
return to the dashboard, click Back to report in the upper left corner of the page.
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Case Mix Index Analysis report

� Overview
This page provides TBD.

To return to the Health Network Summary Dashboard, click the arrow in the upper right corner.

The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by time (days, weeks, months, years) and financial class. From the
slicer drop-downs, you can select a combination of the available options to select the parameters to
include in the views.

� Case Mix Index
TBD
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� Case Mix Index by Entity
TBD

� Case Mix Index Rolling 12 Months
TBD

Reporting Guide Axiom Enterprise Decision Support │ 86



� Case Mix Index Detail Analysis
TBD

� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show as a table. A data table displays underneath the visualization graphic or table. To
return to the dashboard, click Back to report in the upper left corner of the page.
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ALOS Analysis report

� Overview
This page provides TBD.

To return to the Health Network Summary Dashboard, click the arrow in the upper right corner.
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The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by time (days, weeks, months, years) and financial class. From the
slicer drop-downs, you can select a combination of the available options to select the parameters to
include in the views.

� ALOS
TBD
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� ALOS Compared to GMLOS Rolling 12 Months
TBD

� GMLOS Target
TBD
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� ALOS by Entity
TBD

� ALOS Detail Analysis
TBD
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� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show as a table. A data table displays underneath the visualization graphic or table. To
return to the dashboard, click Back to report in the upper left corner of the page.
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Margin Analysis report

� Overview
This page provides TBD.

To return to the Health Network Summary Dashboard, click the arrow in the upper right corner.

The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by time (days, weeks, months, years), entity, and financial class.
From the slicer drop-downs, you can select a combination of the available options to select the
parameters to include in the views.
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� Service Line Selector
This section allows you to view the report metrics by service line type. When you click a service line
button, the KPI data changes dynamically specific to that service line. To view the data for all the service
lines again, click the service line button again to disengage the filter.

� Profitability Analysis
TBD

� ALOS Compared to GMLOS Rolling 12 Months
TBD

� Service Line Margins
TBD
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� Margin Analysis by Entity
TBD

� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show as a table. A data table displays underneath the visualization graphic or table. To
return to the dashboard, click Back to report in the upper left corner of the page.
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Using the Inpatient Service Line Dashboard

� Overview
This dashboard report displays a view of all the inpatient data for your service lines, with the ability to
drill through to any service line at a trend level, volume view, revenue view, and cost view.

� Opening the dashboard
To open the dashboard:

1. From the Enterprise Decision Support home page, in the Reporting section, click Report Builder.

2. In the Axiom Intelligence Reports section, click Inpatient Service Line Dashboard.
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� Navigating the dashboard
The Executive Inpatient Service Line Summary page serves as themain home page for the dashboard and
includes the following sections:
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Slicers
This section allows you to filter data by time (calendar year, quarter, month), entity, and financial class.
From the slicer drop-downs, you can select a combination of the available options to select the
parameters to include in the views.

Metrics Card
This section displays KPI data for cases and ALOS, gross and net revenue, direct and indirect cost, and
direct and net margin. As you select the different options from the slicer drop-downs, the totals in the
Metrics Card adjust accordingly.

Service Line Profitability Analysis
This section shows a profitability visualization of the direct margin per case vs. the average length of stay.
You can view details about a specific service line by placing your cursor on a circle. The system displays a
tool tip that provides information on the case volume compared to the previous year, the gross revenue
by financial class, and a breakdown of costs.

You can drill down further by right-clicking any dot, and from themenu, selecting the drillthrough pages
to display. For more information, see Using drillthrough pages in the section below.
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To view the underlying data for service lines, right click the row, and click Show Data. A data table will
display underneath the visualization chart. To return to the Executive Inpatient Service Line Summary
page, click Back to report in the upper left corner of the page.

To exclude a service line from the visualization, right click the service line dot, and click Exclude. To show
only one service line in the visualization, right click the service line square, and click Include.
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Key Metrics Detail by Primary Service Line
The Key Metrics Detail table shows the values related to profitability for each service line.

To view the underlying data for service lines, right click the row, and click Show Data. A data table will
display underneath the service line table. To return to the Executive Inpatient Service Line Summary
page, click Back to report in the upper left corner of the page.
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To exclude a service line from the table, right click the service line row, and click Exclude. To show only
one service line in the table, right click the service line, and click Include.

You can sort the information in the table by clicking the column to toggle between sorting the table data
by the column in ascending or descending order.

TIP: An arrow displays in the column in which the data is sorted. An up arrow indicates ascending
order. A down arrow indicated descending order.

� Using drillthrough pages
The following is a list of the drillthrough pages available from the Service Line Profitability Analysis and
Key Metrics Detail sections of the dashboard:

l Executive Inpatient Service Line Trend report
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l Inpatient Service Line Cost report
l Inpatient Service Line Revenue report
l Inpatient Service Line Volume report

� Including or excluding data
You can exclude data from a visualization chart or a table by right-clicking the image or table row, and
clicking Exclude. To show only one service line in the visualization or table, right click the image or a table
row, and click Include. You can also perform this action in the Executive Summary page of the dashboard
and the drillthrough pages.

Click image to view full size

� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show Data. A data table displays underneath the visualization graphic or table. To return to
the dashboard, click Back to report in the upper left corner of the page.
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Click image to view full size

� Copying data for other reports
If you have permissions to edit or create Axiom Intelligence reports, you can copy visuals to create a new
report. For tables, you can also copy values and selections.

To copy, right-click in the section, and select Copy Visual, Copy Selection (tables only), or Copy Value
(tables only).

NOTE: This function only applies to users that have permission to edit and manage Axiom
Intelligence reports.

Executive Inpatient Service Line Trend report

� Overview
This page provides trend details for a specific service line selected in the Inpatient Service Line
Dashboard.
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The top of the page displays the service line the page applies to. To return to the Inpatient Service Line
Dashboard, click the arrow in the upper right corner.

The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by time (calendar year, quarter, month), entity, and financial class.
From the drop-downs, you can select a combination of the available options to configure the parameters
to include in the views.

� Metrics Card
This section displays KPI data for visits, gross and net revenue, direct and indirect cost, and direct and
net margin. As you select different columns or rows in the Key Metrics Trend table, the totals in the
Metrics Card adjust accordingly.
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� Key Metrics Trend by Service Line
This section displays the values related to profitability for the corresponding service line indicated at the
top of the page. From this section, you can click a column or row to view themetric values for that
specific row or column. As you click a column, the other columns will gray out to indicate that the
information in theMetrics Card is specific to that column. See the animated GIF in theMetrics Card
section above to see how this works.

Inpatient Service Line Cost report

� Overview
This page provides cost details for a specific service line selected in the Inpatient Service Line Dashboard.

The top of the page displays the service line the page applies to. To return to the Inpatient Service Line
Dashboard, click the arrow in the upper right corner.
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The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by time (calendar year, quarter, month), entity, and financial class.
From the drop-downs, you can select a combination of the available options to configure the data
parameters for this page.

� Metrics Card
This section displays KPI data for visits, ALOS, total cost, direct and indirect cost. As you select different
areas of this page, the totals in theMetrics Card adjust accordingly.
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� Top (N) MSDRGs By Total Cost Per Case
This bar chart displays the total cost per case for each MSDRG. From this section, you can do the
following:

l View cost details about a specific MSDRG by hovering your cursor over a bar. The system displays
a tool tip that provides information on theMSDRG description and the total cost per case.
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l View cost details for a specific MSDRG by clicking a bar. The system greys out the other bars in the
chart and only shows metrics and details for that MSDRG. To enable theMSDRG data in the page
again, click the bar again.

� Variable Direct Cost Per Case by Financial Class
This pie chart breaks down the variable direct cost per case across financial classes. From this section,
you can do the following:

l View financial class details by hovering your cursor over a slice. The system displays a tool tip that
provides a description of the financial class and the variable direct cost per case.
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l View details for a specific financial class by clicking a slice. The system greys out the details across
the page except for data specific to the slice you selected. To enable the financial class data in the
page again, click the slice again.

� Admitting Provider Comparison: Cost Per Case, ALOS, Variable Direct Cost Per Case
This visual shows the variable direct cost per case for each provider. From this section, you can do the
following:
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l View provider details by hovering your cursor over a circle. The system displays a tool tip with the
provider's name, ALOS, gross and net revenue, direct and indirect cost, and direct and net margin.

l View details for a specific provider by clicking a circle. The system greys out the details across the
page except for data specific to the provider you selected. To enable all of the provider data on the
page again, click the circle again.
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� Variable Direct Cost Per Case by Day of Stay
This visual shows the variable direct cost per case by day of stay. From this section, you can do the
following:

l View variable direct cost per case by department details by hovering your cursor over a square.
The system displays a tool tip with a pie chart that shows the percentages for each department.

l View details for a variable direct cost by clicking a square. The system greys out the details across
the page except for data specific to the variable direct cost you selected. To enable the variable
cost data on the page again, click the square again.
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� Cost Per Case Detail
This section displays the value details related to the cost per case. From this section, you can do the
following:

l View the details for a specific department by clicking a row. The system greys out the details for
the other departments across the page except for data specific to the department you selected.

l Sort the table by columns in ascending or descending order by clicking the column header.

l Drill up or down through the data by right-clicking the row, and then selecting Drill Up or Drill
Down.
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� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show as a table. A data table displays underneath the visualization graphic or table. To
return to the dashboard, click Back to report in the upper left corner of the page.

Inpatient Service Line Revenue report

� Overview
This page provides revenue details for a specific service line selected in the Inpatient Service Line
Dashboard.

The top of the page displays the service line the page applies to. To return to the Inpatient Service Line
Dashboard, click the arrow in the upper right corner.
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The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by time (calendar year, quarter, month), entity, and financial class.
From the drop-downs, you can select a combination of the available options to configure the parameters
to include in the views.

� Metrics Card
This section displays KPI data for cases, ALOS, gross and net revenue, direct and indirect cost, and direct
and net margin. As you select different areas of this page, the totals in theMetrics Card adjust
accordingly.
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� Top (N) Payors by Net Revenue Per Case
This bar chart displays the net revenue per case for each payor. From this section, you can do the
following:

l View the top admitters for each payor hovering your cursor over a bar. The system displays a tool
tip that provides a pie chart that segments the admitters by net revenue.

Click image to view full size
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l View revenue details for a specific payor by clicking a bar. The system greys out the other payor
bars in the chart and only shows metrics and details for that payor. To show the payor data in the
page again, click the bar again.

� Gross Revenue by Payor
This pie chart breaks down the gross revenue across payors. From this section, you can do the following:

l View payor gross revenue details by hovering your cursor over a slice. The system displays a tool
tip that shows the details regarding the number of cases, ALOS, gross and net revenue, direct and
indirect cost, and direct and net margin.
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l View details for the gross revenue by payor by clicking a slice. The system greys out the details
across the page except for data specific to the slice you selected. To show the provider data in the
page again, click the slice again.

� Top (N) Cities with Highest Revenue Per Case
This bar chart shows the top number of cities that have the highest revenue per case. From this chart,
you can do the following:
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l View details regarding case net revenue for the city by hovering the cursor over a bar to display a
tool tip.

l View details for a specific city by clicking a bar. The system greys out the details across the page
except for data specific to the city bar you selected. To enable the city data on the page, click the
bar again.

� Revenue Detail by Financial Class / Payor
This section displays the values related to revenue by financial class or payor. From this section, you can
do the following:
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l View the details for a specific financial class by clicking a row. The system greys out the details for
the other financial classes across the page except for data specific to the financial class you
selected. To enable all of the table data in the page, click the row again.

l Sort the table by columns in ascending or descending order by clicking the column header.

l Drill up or down through the data by right-clicking the row, and selecting Drill Up or Drill Down.

TIP: You can also view drill down information by clicking + next to the financial class
description.
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� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show as a table. A data table displays underneath the visualization graphic or table. To
return to the dashboard, click Back to report in the upper left corner of the page.

Inpatient Service Line Volume report

� Overview
This page provides the volume details for a specific service line selected in the Inpatient Service Line
Dashboard.

The top of the page displays the service line the page applies to. To return to the Inpatient Service Line
Dashboard, click the arrow in the upper right corner.
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The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by time (calendar year, quarter, month), entity, and financial class.
From the drop-downs, you can select a combination of the available options to configure the data
parameters for this page.

� Metrics Card
This section displays KPI data for visits, gross and net revenue, direct and indirect cost, and direct and
net margin. As you select the different options from the different areas on the page, the totals in the
Metrics Card adjust accordingly.

� Top (N) MSDRGs by Cases with YOY Growth
This section displays a bar graph of the top cases with a graph line that shows the YOY growth
percentage. From here, you can do the following:

l View a breakdown of the top admitters by case volume by hovering your cursor over any bar.
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l View the KPIs specific to a case type by clicking a bar. The sections of the page will adjust to show
data specific to that diagnosis.

� Cases by Financial Class Description
This sections displays a pie chart that breaks down cases by financial class. From here, you can do the
following:

l View details regarding cases, gross and net revenue, direct and indirect cost, direct and net margin
for a financial class by hovering your cursor over a slice.
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l View the KPIs specific to a financial class by clicking a slice. The sections on the page will adjust to
show the data specific to that financial class.

� Discharges by Day of Week
This section displays a bar chart of the number of discharges broken down by days of the week. From
here, you can do the following:

l View the number of discharges for each day by hovering your cursor over a bar.
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l View the KPIs specific to a discharge by clicking a bar. The sections on the page will adjust to show
the data specific to that discharge.

� Cases by Discharge Status
This section displays the cases by discharge status. From here, you can do the following:

l View the number of cases for a type of discharge status by hovering your cursor over a bar.
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l View the KPIs specific to a discharge status by clicking a bar. The sections on the page will adjust to
show the data specific to that discharge.

� Visits by Zip Code
This section displays the cases by location using a map. From here, you can do the following:

l Zoom in and out of themap by clicking + or - on the right side of the page. You can move themap
by holding down the left mouse button and moving themouse to the area to view.
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l View the zip code and number of visits for a location by hovering your cursor over a dot on the
map.

l View information about visits specific to that location by clicking a dot on themap, and the
sections on the page will adjust accordingly.

� DRG Diagnosis Detail
This sections displays the revenue values related to profitability for each DRG. From this table, you can
do the following:

l View the details for a DRG by clicking a row. The system greys out the details for the other
descriptions across the page except for data specific to the description you selected.
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l Sort the table by columns in ascending or descending order by clicking the column header.
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l Drill up or down through the data by right-clicking the row, and then selecting Drill Up or Drill
Down.

� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show as a table. A data table displays underneath the visualization graphic or table. To
return to the dashboard, click Back to report in the upper left corner of the page.

Using the Outpatient Service Line Dashboard

� Overview
This dashboard displays a view of all the outpatient service lines, with the ability to drill through to any
service line at a trend level, volume view, revenue view, and cost view.
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� Opening the dashboard
To open the dashboard:

1. From the Enterprise Decision Support home page, in the Reporting section, click Report Builder.

2. In the Axiom Intelligence Reports section, click Outpatient Service Line Dashboard.
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� Navigating the dashboard
The Executive Outpatient Service Line Summary page serves as themain home page for the dashboard
and includes the following sections:

Slicers
This section allows you to filter data by time (calendar year, quarter, month), entity, patient type, and
financial class. From the slicer drop-downs, you can select a combination of the available options to
configure the parameters to include in the views.

Metrics Card
This section displays KPI data for visits, gross and net revenue, direct and indirect cost, and direct and
net margin. As you select service lines from the different areas of the page, the totals in theMetrics Card
adjust to show themetrics specific to that service line.
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Service Lines by Direct Margin Per Visit
This section provides a visualization of your direct margin for each visit across service lines. From this
section, you can do the following:

l View details about a specific service line by placing your cursor on a square. The system displays a
tool tip that provides information on the number of visits compared to last year, the gross
revenue by financial class, and a cost breakdown.
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l Viewmetrics specific to a service line by clicking a square. The system greys out the other service
line squares and only shows metrics and details for that service line. To enable all of the service
lines, click the square again.

l Open drillthrough pages for outpatient service line data by right-clicking any square, and selecting
a report. For more information, see Using drillthrough pages in the section below.

Key Metrics Detail by Primary Service Line
This section displays the values related to profitability for each service line. From this section, you can do
the following:

l View the underlying data for service lines by right-clicking the row, and clicking Show Data.
l Exclude a service line from the table by right-clicking the service line row, and clicking Exclude. To

show only one service line in the table, right click the service line, and click Include.
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l Sort the information in the table by clicking the column to toggle between sorting the table data
by the column in ascending or descending order.

TIP: An arrow displays in the column in which the data is sorted. An up arrow indicates
ascending order. A down arrow indicated descending order.

l Drill down further by right-clicking anywhere in the table, and from themenu, selecting the
drillthrough reports to display. For more information, see Using drillthrough pages in the section
below.

� Using drillthrough pages
The following is a list of the drillthrough pages available from the Service Lines by Direct Margin Per Visit
and Key Metrics Detail sections of the dashboard:

l Executive Outpatient Service Line Trend report
l Outpatient Service Line Cost report
l Outpatient Service Line Revenue report
l Outpatient Service Line Volume report

� Including or excluding data
You can exclude data from a visualization chart or a table by right-clicking the image or table row, and
clicking Exclude. To show only one service line in the visualization or table, right click the image or a table
row, and click Include. You can also perform this action in the Executive Summary page of the dashboard
and the drillthrough pages.

� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show Data. A data table displays underneath the visualization graphic or table. To return to
the dashboard, click Back to report in the upper left corner of the page.
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� Copying data for other reports
If you have permissions to edit or create Axiom Intelligence reports, you can copy visuals to create a new
report. For tables, you can also copy values and selections.

To copy, right-click in the section, and select Copy Visual, Copy Selection (tables only), or Copy Value
(tables only).

NOTE: This function only applies to users that have permission to edit and manage Axiom
Intelligence reports.

Executive Outpatient Service Line Trend report

� Overview
This page provides trend details for a specific service line selected in the Outpatient Service Line
Dashboard.

The top of the page displays the service line the page applies to. To return to the Outpatient Service Line
Dashboard, click the arrow in the upper right corner.
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The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by time (calendar year, quarter, month), entity, patient type, and
financial class. From the drop-downs, you can select a combination of the available options to configure
the parameters to include in the views.

� Metrics Card
This section displays KPI data for visits, gross and net revenue, direct and indirect cost, and direct and
net margin. As you select different columns or rows in the Key Metrics Trend table, the totals in the
Metrics Card adjust accordingly.
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� Key Metrics Trend by Service Line
This section displays the values related to profitability for the corresponding service line indicated at the
top of the page. From this section, you can click a column or row to view themetric values for that
specific row or column. As you click a column, the other columns will gray out to indicate that the
information in theMetrics Card is specific to that column.
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Outpatient Service Line Cost report

� Overview
This page provides cost details for a specific service line selected in the Outpatient Service Line
Dashboard.

The top of the page displays the service line the page applies to. To return to the Outpatient Service Line
Dashboard, click the arrow in the upper right corner.

The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by time (calendar year, quarter, month), entity, patient type, and
financial class. From the drop-downs, you can select a combination of the available options to configure
the data parameters for this page.

� Metrics Card
This section displays KPI data for visits, total cost, direct and indirect cost. As you select different areas of
this page, the totals in theMetrics Card adjust accordingly.

Reporting Guide Axiom Enterprise Decision Support │ 138



� Top (N) ICD Diagnosis by Total Cost Per Visit
This bar chart displays the total cost per visit for each ICD Diagnosis. From this section, you can do the
following:

l View cost details about a specific ICD Diagnosis by hovering your cursor over a bar. The system
displays a tool tip that provides information on the diagnosis description and the total cost per
case.
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l View cost details for a specific diagnosis by clicking a bar. The system greys out the other diagnosis
bars in the chart and only shows metrics and details for that diagnosis. To enable all of the
diagnosis data in the page again, click the bar again.

� Variable Direct Cost Per Visit by Financial Class
This pie chart breaks down the variable direct cost per visit across financial classes. From this section, you
can do the following:

l View financial class details by hovering your cursor over a slice. The system displays a tool tip that
provides a description of the financial class and the variable direct cost per case.
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l View details for a specific financial class by clicking a slice. The system greys out the details across
the page except for data specific to the slice you selected. To enable all of the financial class data in
the page again, click the slice again.

� Provider by Variable Direct Cost Per Visit
This visual shows the variable direct cost per visit for each provider. The larger the square, the higher the
cost per visit. From this section, you can do the following:

l View variable direct cost details by hovering your cursor over a provider square. The system
displays a tool tip with the provider's name, the number of visits, gross and net revenue, direct
and indirect cost, and direct and net margin.
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l View details for a specific provider by clicking a square. The system greys out the details across the
page except for data specific to the provider you selected. To enable all of the provider data in the
page again, click the square again.

� Cost Per Visit Detail
This section displays the revenue details related to the cost per visit. From this section, you can do the
following:

l View the details for a specific department by clicking a row. The system greys out the details for
the other departments across the page except for data specific to the department you selected.
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l Sort the table by columns in ascending or descending order by clicking the column header.

l Drill up or down through the data by right-clicking the row, and then selecting Drill Up or Drill
Down.

� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show as a table. A data table displays underneath the visualization graphic or table. To
return to the dashboard, click Back to report in the upper left corner of the page.
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Click image to view full size

Outpatient Service Line Revenue report

� Overview
This page provides revenue details for a specific service line selected in the Outpatient Service Line
Dashboard.

The top of the page displays the service line the page applies to. To return to the Outpatient Service Line
Dashboard, click the arrow in the upper right corner.
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The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by time (calendar year, quarter, month), entity, patient type, and
financial class. From the drop-downs, you can select a combination of the available options to configure
the parameters to include in the views.

� Metrics Card
This section displays KPI data for visits, gross and net revenue, direct and indirect cost, and direct and
net margin. As you select different areas of this page, the totals in theMetrics Card adjust accordingly.

� Top (N) Payors by Net Revenue Per Visit
This bar chart displays the net revenue per visit for each payor. From this section, you can do the
following:

l View the providers revenue details by hovering your cursor over a bar. The system displays a tool
tip that shows a pie chart that segments data by provider percentage.
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l View revenue details for a specific payor by clicking a bar. The system greys out the other payor
bars in the chart and only shows metrics and details for that payor. To show all of the payor data
in the page again, click the bar again.

� Gross Revenue by Payor
This pie chart breaks down the gross revenue across payors. From this section, you can do the following:

l View payor gross revenue details by hovering your cursor over a slice. The system displays a tool
tip that shows details regarding the number of visits, gross and net revenue, direct and indirect
cost, and direct and net margin.
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l View details for the gross revenue by payor by clicking a slice. The system greys out the details
across the page except for data specific to the slice you selected. To show all of the provider data
in the page again, click the slice again.

� Top (N) Cities with Highest Revenue Per Visit
This bar chart shows the top number of cities that have the highest revenue per visit. From this chart,
you can do the following:
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l View details regarding visit net revenue for the city by hovering the cursor over a bar to display a
tool tip.

l View details for a specific city by clicking a bar. The system greys out the details across the page
except for data specific to the city bar you selected. To enable all of the city data in the page, click
the bar again.

� Revenue Detail by Financial Class / Payor
This section displays the revenue values by financial class or payor. From this section, you can do the
following:

l View the details for a specific financial class by clicking a row. The system greys out the details for
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the other financial classes across the page except for data specific to the financial class you
selected. To enable all of the table data in the page, click the row again.

l Sort the table by columns in ascending or descending order by clicking the column header.
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l Drill up or down through the data by right-clicking the row, and selecting Drill Up or Drill Down.

TIP: You can also view drill down information by clicking + next to the financial class
description.

� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show as a table. A data table displays underneath the visualization graphic or table. To
return to the dashboard, click Back to report in the upper left corner of the page.

Outpatient Service Line Volume report

� Overview
This page provides the volume details for a specific service line selected in the Outpatient Service Line
Dashboard.
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The top of the page displays the service line the page applies to. To return to the Outpatient Service Line
Dashboard, click the arrow in the upper right corner.

The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by time (calendar year, quarter, month), entity, patient type, and
financial class. From the drop-downs, you can select a combination of the available options to configure
the data parameters for this page.
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� Metrics Card
This section displays KPI data for visits, gross and net revenue, direct and indirect cost, and direct and
net margin. As you select the different options from the different areas on the page, the totals in the
Metrics Card adjust accordingly.

� Top (N) Primary ICD Diagnosis
This section displays a bar graph of the top visits by ICD Diagnosis. From here, you can do the following:

l View a breakdown of providers by visit by hovering your cursor over any bar.
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l View the KPIs specific to a diagnosis by clicking a bar. The sections of the page will adjust to show
data specific to that diagnosis.

� Visits by Financial Class Description
This section displays a pie chart that breaks down visits by financial class. From here, you can do the
following:

l View details regarding visits, gross and net revenue, direct and indirect cost, direct and net margin
for a financial class by hovering your cursor over a slice.
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l View the KPIs specific to a diagnosis by clicking a slice. The sections on the page will adjust to show
the data specific to that diagnosis.

� Visits by Day of Week
This section displays a bar chart of the number of visits broken down by days of the week. From here,
you can do the following:
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l View the number of visits for each day by hovering your cursor over a bar.

l View the KPIs specific to a diagnosis by clicking a bar. The sections on the page will adjust to show
the data specific to that diagnosis.

� Visits by Zip Code
This section displays the visits by location using a map. From here, you can do the following:
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l Zoom in and out of themap by clicking + or - on the right side of the page. You can move themap
by holding down the left mouse button and moving themouse to the area to view.

l View the zip code and number of visits for a location by hovering your cursor over a dot on the
map.
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l View information about visits specific to that location by clicking a dot on themap, and the
sections on the page will adjust accordingly.

� ICD Diagnosis Detail
This section displays the revenue values related to profitability for each ICD Diagnosis. From this table,
you can do the following:

l View the details for a specific ICD Diagnosis by clicking a row. The system greys out the details for
the other descriptions across the page except for data specific to the description you selected.
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l Sort the table by columns in ascending or descending order by clicking the column header.

l Drill up or down through the data by right-clicking the row, and then selecting Drill Up or Drill
Down.

� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show as a table. A data table displays underneath the visualization graphic or table. To
return to the dashboard, click Back to report in the upper left corner of the page.
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Using the Professional Service Line Dashboard

� Overview
This dashboard report displays a view of all the professional billing service lines, with the ability to drill
through to any service line at a trend level, volume view, revenue view, and cost view.

� Opening the dashboard
To open the dashboard:

1. From the Enterprise Decision Support home page, in the Reporting section, click Report Builder.
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2. In the Axiom Intelligence Reports section, click Professional Service Line Dashboard.

Click image to view full size
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� Navigating the dashboard
The Executive Professional Service Line Summary page serves as themain home page for the dashboard
and includes the following sections:

Click image to view full size

Slicers
This section allows you to filter data by time (calendar year, quarter, month), entity, patient type, and
financial class. From the slicer drop-downs, you can select a combination of the available options to
configure the parameters to include in the views.

Click image to view full size

Metrics Card
This section displays KPI data for visits, gross and net revenue, direct and indirect cost, and direct and
net margin. As you select service lines from the different areas of the page, the totals in theMetrics Card
adjust to show themetrics specific to that service line.
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Click image to view animated GIF full size

Service Lines by Direct Margin Per Visit
This section provides a visualization of your direct margin for each visit across service lines. From this
section, you can do the following:

l View details about a specific service line by placing your cursor on a square. The system displays a
tool tip that provides information on the number of visits compared to last year, the gross
revenue by financial class, and a cost breakdown.

Click image to view full size
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l Viewmetrics specific to a service line by clicking a square. The system greys out the other service
line squares and only shows metrics and details for that service line. To enable all of the service
lines, click the square again.

Click image to view animated GIF full size

l Open drillthrough pages for professional billing service line data by right-clicking any square, and
selecting a report. For more information, see Using drillthrough pages in the section below.

Click image to view full size

Key Metrics Detail by Primary Service Line
This section displays the values related to profitability for each service line. From this section, you can do
the following:

l View the underlying data for service lines by right-clicking the row, and clicking Show Data.
l Exclude a service line from the table by right-clicking the service line row, and clicking Exclude. To

show only one service line in the table, right click the service line, and click Include.
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l Sort the information in the table by clicking the column to toggle between sorting the table data
by the column in ascending or descending order.

TIP: An arrow displays in the column in which the data is sorted. An up arrow indicates
ascending order. A down arrow indicated descending order.

l Drill down further by right-clicking anywhere in the table, and from themenu, selecting the
drillthrough reports to display. For more information, see Using drillthrough reports in the section
below.

� Using drillthrough pages
The following is a list of the drillthrough pages available from the Service Lines by Direct Margin Per Visit
and Key Metrics Detail sections of the dashboard:

l Executive Professional Service Line Trend report
l Professional Service Line Cost report
l Professional Service Line Revenue report
l Professional Service Line Volume report

� Including or excluding data
You can exclude data from a visualization chart or a table by right-clicking the image or table row, and
clicking Exclude. To show only one service line in the visualization or table, right click the image or a table
row, and click Include. You can also perform this action in the Executive Summary page of the dashboard
and the drillthrough pages.

Click image to view full size
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� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show Data. A data table displays underneath the visualization graphic or table. To return to
the dashboard, click Back to report in the upper left corner of the page.

Click image to view full size

� Copying data for other reports
If you have permissions to edit or create Axiom Intelligence reports, you can copy visuals to create a new
report. For tables, you can also copy values and selections.

To copy, right-click in the section, and select Copy Visual, Copy Selection (tables only), or Copy Value
(tables only).

NOTE: This function only applies to users that have permission to edit and manage Axiom
Intelligence reports.

Executive Professional Service Line Trend report

� Overview
This page provides trend details for a specific service line selected in the Professional Service Line
Dashboard.

The top of the page displays the service line the report applies to. To return to the Professional Service
Line Dashboard, click the arrow in the upper right corner.
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The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by time (calendar year, quarter, month), entity, patient type, and
financial class. From the drop-downs, you can select a combination of the available options to configure
the parameters to include in the views.

Click image to view full size

� Metrics Card
This section displays KPI data for visits, gross and net revenue, direct and indirect cost, and direct and
net margin. As you select different columns or rows in the Key Metrics Trend table, the totals in the
Metrics Card adjust accordingly.
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Click image to view full size

� Key Metrics Trend by Service Line
This section displays the values related to profitability for the corresponding service line indicated at the
top of the page. From this section, you can click a column or row to view themetric values for that
specific row or column. As you click a column, the other columns will gray out to indicate that the
information in theMetrics Card is specific to that column.

Professional Service Line Cost report

� Overview
This page provides cost details for a specific service line selected in the Professional Service Line
Dashboard.

The top of the page displays the service line the page applies to. To return to the Professional Service Line
Dashboard, click the arrow in the upper right corner.

Reporting Guide Axiom Enterprise Decision Support │ 168



The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by time (calendar year, quarter, month), entity, patient type, and
financial class. From the drop-downs, you can select a combination of the available options to configure
the data parameters for this page.

� Metrics Card
This section displays KPI data for visits, total cost, direct and indirect cost. As you select different areas of
this page, the totals in theMetrics Card adjust accordingly.
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� Top (N) ICD Diagnosis by Total Cost Per Visit
This bar chart displays the total cost per visit for each ICD Diagnosis. From this section, you can do the
following:

l View cost details about a specific ICD Diagnosis by hovering your cursor over a bar. The system
displays a tool tip that provides information on the diagnosis description and the total cost per
case.

Reporting Guide Axiom Enterprise Decision Support │ 170



l View cost details for a specific diagnosis by clicking a bar. The system greys out the other diagnosis
bars in the chart and only shows metrics and details for that diagnosis. To enable all of the
diagnosis data in the page again, click the bar again.

� Variable Direct Cost Per Visit by Financial Class
This pie chart breaks down the variable direct cost per visit across financial classes. From this section, you
can do the following:

l View financial class details by hovering your cursor over a slice. The system displays a tool tip that
provides a description of the financial class and the variable direct cost per case.
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l View details for a specific financial class by clicking a slice. The system greys out the details across
the page except for data specific to the slice you selected. To enable all of the financial class data in
the page again, click the bar again.

� Provider by Variable Direct Cost Per Visit
This visual shows the variable direct cost per visit for each provider. The larger the square, the higher the
cost per visit. From this section, you can do the following:

l View variable direct cost details by hovering your cursor over a provider square. The system
displays a tool tip with the provider's name, the number of visits, gross and net revenue, direct
and indirect cost, and direct and net margin.
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l View details for a specific provider by clicking a square. The system greys out the details across the
page except for data specific to the provider you selected. To enable all of the provider data in the
page again, click the square again.

� Cost Per Visit Detail
This section displays the value details related to the cost per visit. From this section, you can do the
following:

l View the details for a specific department by clicking a row. The system greys out the details for
the other departments across the page except for data specific to the department you selected.
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l Sort the table by columns in ascending or descending order by clicking the column header.

l Drill up or down through the data by right-clicking the row, and then selecting Drill Up or Drill
Down.

� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show as a table. A data table displays underneath the visualization graphic or table. To
return to the dashboard, click Back to report in the upper left corner of the page.
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Professional Service Line Revenue report

� Overview
This page provides revenue details for a specific service line selected in the Professional Service Line
Dashboard.

The top of the page displays the service line the page applies to. To return to the Professional Service Line
Dashboard, click the arrow in the upper right corner.

The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by time (calendar year, quarter, month), entity, patient type, and
financial class. From the drop-downs, you can select a combination of the available options to configure
the parameters to include in the views.

� Metrics Card
This section displays KPI data for visits, gross and net revenue, direct and indirect cost, and direct and
net margin. As you select different areas of this page, the totals in theMetrics Card adjust accordingly.
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� Top (N) Payors by Net Revenue Per Visit
This bar chart displays the net revenue per visit for each payor. From this section, you can do the
following:

l View the top providers for by net revenue by hovering your cursor over a bar. The system displays
a tool tip that provides a pie chart that segments data by provider percentage.
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l View revenue details for a specific payor by clicking a bar. The system greys out the other payor
bars in the chart and only shows metrics and details for that payor. To show all of the payor data
in the page again, click the bar again.

� Gross Revenue by Payor
This pie chart breaks down the gross revenue across payors. From this section, you can do the following:

l View payor gross revenue details by hovering your cursor over a slice. The system displays a tool
tip displays details regarding the number of visits, gross and net revenue, direct and indirect cost,
and direct and net margin.
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l View details for the gross revenue by payor by clicking a slice. The system greys out the details
across the page except for data specific to the slice you selected. To show all of the provider data
in the page again, click the slice again.

� Top (N) Cities with Highest Revenue Per Visit
This bar chart shows the top number of cities that have the highest revenue per visit. From this chart,
you can do the following:

l View details regarding visit net revenue for the city by hovering the cursor over a bar to display a
tool tip.
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l View details for a specific city by clicking a bar. The system greys out the details across the page
except for data specific to the city bar you selected. To enable all of the city data in the page, click
the bar again.

� Revenue Detail by Financial Class / Payor
This section displays the values related to the revenue by financial class or payor. From this section, you
can do the following:

l View the details for a specific financial class by clicking a row. The system greys out the details for
the other financial classes across the page except for data specific to the financial class you
selected. To enable all of the table data in the page, click the row again.
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l Sort the table by columns in ascending or descending order by clicking the column header.

l Drill up or down through the data by right-clicking the row, and selecting Drill Up or Drill Down.

TIP: You can also view drill down information by clicking + next to the financial class
description.

� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show as a table. A data table displays underneath the visualization graphic or table. To
return to the dashboard, click Back to report in the upper left corner of the page.
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Professional Service Line Volume report

� Overview
This page provides the volume details for a specific service line selected in the Professional Service Line
Dashboard.

The top of the page displays the service line the page applies to. To return to the Professional Service Line
Dashboard, click the arrow in the upper right corner.
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The following sections describe the different areas of this page.

� Slicers
This section allows you to filter data by time (calendar year, quarter, month), entity, patient type, and
financial class. From the drop-downs, you can select a combination of the available options to configure
the data parameters for this page.

� Metrics Card
This section displays KPI data for visits, gross and net revenue, direct and indirect cost, and direct and
net margin. As you select the different options from the different areas on the page, the totals in the
Metrics Card adjust accordingly.

� Top (N) CPTs
This sections displays a bar graph of the top visits by CPT. From here, you can do the following:

l View a breakdown of the top providers by visit by hovering your cursor over any bar.
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l View the KPIs specific to a diagnosis by clicking a bar. The sections of the page will adjust to show
data specific to that diagnosis.

� Visits by Financial Class Description
This sections displays a pie chart that breaks down visits by financial class. From here, you can do the
following:

l View details regarding visits, gross and net revenue, direct and indirect cost, direct and net margin
for a financial class by hovering your cursor over a slice.
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l View the KPIs specific to a diagnosis by clicking a slice. The sections on the page will adjust to show
the data specific to that diagnosis.

� Visits by Day of Week
This section displays a bar chart of the number of visits broken down by days of the week. From here,
you can do the following:

l View the number of visits for each day by hovering your cursor over a bar.
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l View the KPIs specific to a diagnosis by clicking a bar. The sections on the page will adjust to show
the data specific to that diagnosis.

� Visits by Zip Code
This section displays the visits by location using a map. From here, you can do the following:

l Zoom in and out of themap by clicking + or - on the right side of the page. You can move themap
by holding down the left mouse button and moving themouse to the area to view.
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l View the zip code and number of visits for a location by hovering your cursor over a dot on the
map.

l View information about visits specific to that location by clicking a dot on themap, and the
sections on the page will adjust accordingly.
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� CPT Detail
This sections displays the values related to profitability for each CPT. From this table, you can do the
following:

l View the details for a specific CPT description by clicking a row. The system greys out the details for
the other descriptions across the page except for data specific to the description you selected.

l Sort the table by columns in ascending or descending order by clicking the column header.
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l Drill up or down through the data by right-clicking the row, and then selecting Drill Up or Drill
Down.

� Viewing data in table format
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show as a table. A data table displays underneath the visualization graphic or table. To
return to the dashboard, click Back to report in the upper left corner of the page.

Axiom Clinical Performance Measures (CPM)
NOTE: Axiom Clinical PerformanceMeasures is only accessible if your organization has a license for
Axiom CPM.
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Axiom Enterprise Decision Support with Clinical PerformanceMeasures (CPM) helps organizations
establish a comprehensive view of service line performance across financial and clinical performance
measures. Reports and analytics facilitate the conversation between finance and clinical process
improvement teams, highlighting opportunities where quality and cost outcomes could be improved.

Inpatient Executive Summary dashboard

� Overview
This dashboard displays KPI views of clinical and financial data to help inform and drive decision making
for executives.

NOTE: This dashboard is only accessible if your organization has a license for Axiom CPM.

� Opening the dashboard

TIP: Along with the dashboard, you can also access the individual reports that make up the
dashboard.

To open the dashboard:
1. From the Enterprise Decision Support home page, in the Reporting section, click Report Builder.
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2. In the Axiom Intelligence Reports section, click Inpatient Executive Dashboard.
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� Navigating the dashboard
The dashboard includes two main sections: Slicers and KPI data cards
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Slicers
This section allows you to filter data by date range, entity, and financial class. From the drop-downs, you
can select a combination of the available options to define the data parameters to include in the
dashboard.

KPI data cards
Each KPI data card provides current year data, the goal set in the previous year, and what the data is
measuring. The amount of data is based on the date range you selected in the Slicer section.
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The card is interactive so that you can view KPI data throughout the date range. Hover your cursor over
the graph at the bottom of the card to view a tool tip of the data specific to a month. When you click on
the graph, the current year data and goal percentage in the parentheses will adjust to the selected time
period.

The red and green font indicate where there are problems, which you can investigate further by drilling
down into the specific reports that supply data for each card. Click the box in the top right corner to open
the report used to generate the KPI data. Click the following links to viewmore information about the
KPI report.

l Volume
l Utilization
l ALOS
l Margin
l Mortality
l Readmission
l PSI
l HAC

Inpatient Volume Analysis report

� Overview
This report provides volume trends and details for inpatient cases. To return to the Inpatient Executive
Summary Dashboard, click the arrow in the upper right corner.
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The following sections describe the different areas of this page.

� Opening the report

TIP: You can open this report individually or through the Inpatient Executive Dashboard.

To open the dashboard:
1. From the Enterprise Decision Support home page, in the Reporting section, click Report Builder.
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2. In the Axiom Intelligence Reports section, click Inpatient Volume Analysis.
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� Slicers
This section allows you to filter data by date range, entity, and financial class. From the drop-downs, you
can select a combination of the available options to define the data parameters to include in the report.

� Inpatient Cases Year Over Year Comparison
This bar chart displays the current and previous year's case volume, including a YOY growth line. To view
the number of cases for a month, hover your cursor over a bar.
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� Inpatient Case Volume Detail
This section displays the value details related to case volume. From this section, you can do the
following:

l View the details for a specific service line by clicking a row. The system greys out the details for the
other service lines across the page except for data specific to the service line you selected.
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l Sort the table by columns in ascending or descending order by clicking the column header.

l Drill up or down through the data by right-clicking the row, and then selecting Drill Up or Drill
Down.

� Including or excluding data
From some visualization charts and tables, you can exclude data by right-clicking the image or table row,
and clicking Exclude. To show only one data element in the visualization or table, right click the image or
a table row, and click Include.
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� Viewing data
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show Data. A data table displays underneath the visualization graphic or table. To return to
the dashboard, click Back to report in the upper left corner of the page.

� Copying data for other reports
If you have permissions to edit or create Axiom Intelligence reports, you can copy visuals to create a new
report. For tables, you can also copy values and selections.

To copy, right-click in the section, and select Copy Visual, Copy Selection (tables only), or Copy Value
(tables only).

NOTE: This function only applies to users that have permission to edit and manage Axiom
Intelligence reports.
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Critical Care Utilization Analysis report

� Overview
This report provides benchmarking data regarding inpatient cases that required critical care. To return to
the Inpatient Executive Summary Dashboard, click the arrow in the upper right corner.

� Opening the report

TIP: You can open this report individually or through the Inpatient Executive Dashboard.

To open the dashboard:
1. From the Enterprise Decision Support home page, in the Reporting section, click Report Builder.
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2. In the Axiom Intelligence Reports section, click Critical Care Utilization.
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� Slicers
This section allows you to filter data by date range, entity, and financial class. From the drop-downs, you
can select a combination of the available options to define the data parameters to include in the report.

� Inpatient Cases and Critical Care Metrics
This section shows the following metric information for the date range selected in the slicer section:

l Inpatient Cases - Total number of cases for the year, previous year goal, and percentage of goal
l Inpatient Cases with Critical Care - Total number of critical care inpatient cases, previous year

goal, and percentage of goal
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l % of Inpatient Cases with Critical Care - The percentage of total cases with critical care (usage
rate), previous year goal, and percentage of goal

� % of Cases w/ Critical Care: Target 50th Percentile National Peer Group
This section displays a gauge of the current overall utilization of critical care with a line that represents
the benchmark. Hover your cursor over the line to view the benchmark details.

� % of Cases with Critical Care: National Peer Group Benchmark Comparison
This section provides a way to view the critical care benchmark data across months, including values for
the 25th, 50th, and 75th percentiles.
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� % of Cases w/ Critical Care: Comparison to National Peer Group 50th Percentile
This section displays the value details related to the your critical care cases segmented by service line.
The table displays the total number of cases in need of critical care, the percentage of critical care cases,
the number of critical care cases compared to the previous year, and the benchmark value.

From this section, you can do the following:

l View the details for a specific service line by clicking a row. The system greys out the details for the
other service lines across the page except for data specific to the service line you selected.

l Sort the table by columns in ascending or descending order by clicking the column header.

l Drill up or down through the data by right-clicking the row, and then selecting Drill Up or Drill
Down.

� Including or excluding data
From some visualization charts and tables, you can exclude data by right-clicking the image or table row,
and clicking Exclude. To show only one data element in the visualization or table, right click the image or
a table row, and click Include.
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� Viewing data
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show Data. A data table displays underneath the visualization graphic or table. To return to
the dashboard, click Back to report in the upper left corner of the page.

� Copying data for other reports
If you have permissions to edit or create Axiom Intelligence reports, you can copy visuals to create a new
report. For tables, you can also copy values and selections.

To copy, right-click in the section, and select Copy Visual, Copy Selection (tables only), or Copy Value
(tables only).

NOTE: This function only applies to users that have permission to edit and manage Axiom
Intelligence reports.

ALOS Analysis report

� Overview
This report provides benchmarking data regarding the Average Length of Stay for your organization. To
return to the Inpatient Executive Summary Dashboard, click the arrow in the upper right corner.
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� Opening the report

TIP: You can open this report individually or through the Inpatient Executive Dashboard.

To open the dashboard:
1. From the Enterprise Decision Support home page, in the Reporting section, click Report Builder.

2. In the Axiom Intelligence Reports section, click ALOS Analysis.
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� Slicers
This section allows you to filter data by date range, entity, and financial class. From the drop-downs, you
can select a combination of the available options to define the data parameters to include in the report.

� ALOS Metrics
This section shows the following metric information for the date range selected in the slicer section:

l Inpatient Cases - Total number of cases
l ALOS - Average Length of Stay (ALOS)
l ALOS Target - The target ALOS based on the percentile
l # of Cases above Target - The number of cases above the benchmark
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l Opportunity Days - The number of days of opportunity
l Cost Savings Opportunity - The number of opportunity days multiplied by the average total cost

per day to determine the potential cost savings

� ALOS: Target 50th Percentile National Peer Group
This section displays a gauge of the current overall utilization with a line that represents the benchmark.
Hover your cursor over the line to view the benchmark details.

� ALOS: National Peer Group Benchmark Comparison
This section provides a way to view benchmark data across months, including values for the 25th, 50th,
and 75th percentiles..
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� ALOS Comparison to National Peer Group 50th Percentile
This section displays the value details related to the ALOS for each service line. The table displays the
current ALOS compared to the previous year, the specific benchmark and the difference to the
benchmark, the total number of cases above the benchmark, and howmany days/cost savings does it
represent.

From this section, you can do the following:

l View the details for a specific service line by clicking a row. The system greys out the details for the
other service lines across the page except for data specific to the service line you selected.

l Sort the table by columns in ascending or descending order by clicking the column header.

l Drill up or down through the data by right-clicking the row, and then selecting Drill Up or Drill
Down.

� Including or excluding data
From some visualization charts and tables, you can exclude data by right-clicking the image or table row,
and clicking Exclude. To show only one data element in the visualization or table, right click the image or
a table row, and click Include.
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� Viewing data
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show Data. A data table displays underneath the visualization graphic or table. To return to
the dashboard, click Back to report in the upper left corner of the page.

� Copying data for other reports
If you have permissions to edit or create Axiom Intelligence reports, you can copy visuals to create a new
report. For tables, you can also copy values and selections.

To copy, right-click in the section, and select Copy Visual, Copy Selection (tables only), or Copy Value
(tables only).

NOTE: This function only applies to users that have permission to edit and manage Axiom
Intelligence reports.

Margin Analysis report

� Overview
This report provides regarding details regarding margin analysis across service lines. To return to the
Inpatient Executive Summary Dashboard, click the arrow in the upper right corner.
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� Opening the report

TIP: You can open this report individually or through the Inpatient Executive Dashboard.

To open the dashboard:
1. From the Enterprise Decision Support home page, in the Reporting section, click Report Builder.
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2. In the Axiom Intelligence Reports section, clickMargin Analysis.
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� Slicers
This section allows you to filter data by date range, entity, and financial class. From the drop-downs, you
can select a combination of the available options to define the data parameters to include in the report.

� Metrics Card
This section displays KPI data for cases, ALOS, casemix, gross and net revenue, direct cost and margin,
and contribution margin percentage. As you select different areas of this page, the totals in theMetrics
Card adjust accordingly.
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� Margin Analysis Scatter Chart
This section shows a profitability visualization of the direct margin profitability analysis. You can view
details for a specific service line by placing your cursor on a circle. The system displays a tool tip that
provides information on the number of inpatient cases, the direct margin per case, and the ALOS.

� Margin Analysis Details
This section displays the details related to margin for each service line, including the number of cases,
gross revenue per case, net revenue per case, etc.

From this section, you can do the following:

l View the details for a specific service line by clicking a row. The system greys out the details for the
other service lines across the page except for data specific to the service line you selected.

l Sort the table by columns in ascending or descending order by clicking the column header.

l Drill up or down through the data by right-clicking the row, and then selecting Drill Up or Drill
Down.

� Including or excluding data
From some visualization charts and tables, you can exclude data by right-clicking the image or table row,
and clicking Exclude. To show only one data element in the visualization or table, right click the image or
a table row, and click Include.
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� Viewing data
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show Data. A data table displays underneath the visualization graphic or table. To return to
the dashboard, click Back to report in the upper left corner of the page.

� Copying data for other reports
If you have permissions to edit or create Axiom Intelligence reports, you can copy visuals to create a new
report. For tables, you can also copy values and selections.

To copy, right-click in the section, and select Copy Visual, Copy Selection (tables only), or Copy Value
(tables only).

NOTE: This function only applies to users that have permission to edit and manage Axiom
Intelligence reports.

Mortality Analysis report

� Overview
This report provides KPI metrics and details regarding mortality rates at your organization and across
service lines. To return to the Inpatient Executive Summary Dashboard, click the arrow in the upper right
corner.
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� Opening the report

TIP: You can open this report individually or through the Inpatient Executive Dashboard.

To open the dashboard:
1. From the Enterprise Decision Support home page, in the Reporting section, click Report Builder.
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2. In the Axiom Intelligence Reports section, clickMortality Analysis.
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� Slicers
This section allows you to filter data by date range, entity, and financial class. From the drop-downs, you
can select a combination of the available options to define the data parameters to include in the report.

� Mortalities by Service Line
This section allows you to view the providers and their mortality rates by hovering your cursor over a
service line square. When you click a square, the system greys out the details across the page except for
data specific to the service line you selected. To enable all of the data across service lines on the page
again, click the square again.
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� Mortality Rate Metric
This section shows the current year mortality rate and the goal set in the previous year. Hover your
cursor over the graph at the bottom of the card to view a tool tip of the data specific to a month. When
you click on the graph, the current year data and goal percentage in the parentheses will adjust to the
selected time period.
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� Mortality Rate Compared to Benchmark
This section displays a gauge that compares your current mortality rate with the benchmark.

� Mortality Rate Detail
This section displays the details related to morality rate for each service line, including the number of
mortalities, the current year mortality rate compared to the previous year, and the benchmark details.

From this section, you can do the following:

l View the details for a specific service line by clicking a row. The system greys out the details for the
other service lines across the page except for data specific to the service line you selected.

l Sort the table by columns in ascending or descending order by clicking the column header.

l Drill up or down through the data by right-clicking the row, and then selecting Drill Up or Drill
Down.

� Including or excluding data
From some visualization charts and tables, you can exclude data by right-clicking the image or table row,
and clicking Exclude. To show only one data element in the visualization or table, right click the image or
a table row, and click Include.
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� Viewing data
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show Data. A data table displays underneath the visualization graphic or table. To return to
the dashboard, click Back to report in the upper left corner of the page.

� Copying data for other reports
If you have permissions to edit or create Axiom Intelligence reports, you can copy visuals to create a new
report. For tables, you can also copy values and selections.

To copy, right-click in the section, and select Copy Visual, Copy Selection (tables only), or Copy Value
(tables only).

NOTE: This function only applies to users that have permission to edit and manage Axiom
Intelligence reports.

Readmission Analysis report

� Overview
This report provides KPI metrics and details regarding readmission rates at your organization and across
service lines. To return to the Inpatient Executive Summary Dashboard, click the arrow in the upper right
corner.
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� Opening the report

TIP: You can open this report individually or through the Inpatient Executive Dashboard.

To open the dashboard:
1. From the Enterprise Decision Support home page, in the Reporting section, click Report Builder.

2. In the Axiom Intelligence Reports section, click Readmissions.
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� Slicers
This section allows you to filter data by date range, entity, and financial class. From the drop-downs, you
can select a combination of the available options to define the data parameters to include in the report.

� 30-Day Readmissions and Rate
This section shows the number of readmissions and the readmission rate, including goals set up in the
previous year.
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� 30-Day Readmissions by Service Line
This section allows you to view the providers and their readmission rates by hovering your cursor over a
service line square. When you click a square, the system greys out the details across the page except for
data specific to the service line you selected. To enable all of the data across service lines on the page
again, click the square again.
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� 30-Day Readmissions by Rate and Month
This section displays a bar chart that shows the number of readmissions for each month for the date
range selected in the Slicer section above. The chart also shows the readmission rate trend across
months.

� Readmission by Primary ICD Diagnosis
This section shows the details regarding readmissions by primary ICD Diagnosis to help you understand
under what circumstances patients are returning, including the number of readmissions, ALOS, net
revenue per case, direct cost per case, and direct margin per case.

From this section, you can do the following:

l View the details for a specific diagnosis by clicking a row. The system greys out the details for the
other diagnoses across the page except for data specific to the diagnosis you selected.

l Sort the table by columns in ascending or descending order by clicking the column header.

l Drill up or down through the data by right-clicking the row, and then selecting Drill Up or Drill
Down.
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� Including or excluding data
From some visualization charts and tables, you can exclude data by right-clicking the image or table row,
and clicking Exclude. To show only one data element in the visualization or table, right click the image or
a table row, and click Include.

� Viewing data
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show Data. A data table displays underneath the visualization graphic or table. To return to
the dashboard, click Back to report in the upper left corner of the page.

� Copying data for other reports
If you have permissions to edit or create Axiom Intelligence reports, you can copy visuals to create a new
report. For tables, you can also copy values and selections.

To copy, right-click in the section, and select Copy Visual, Copy Selection (tables only), or Copy Value
(tables only).

NOTE: This function only applies to users that have permission to edit and manage Axiom
Intelligence reports.
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Patient Safety Indicator (PSI) Analysis report

� Overview
This report provides metrics and details regarding PSI at your organization and across service lines. To
return to the Inpatient Executive Summary Dashboard, click the arrow in the upper right corner.

� Opening the report

TIP: You can open this report individually or through the Inpatient Executive Dashboard.

To open the dashboard:
1. From the Enterprise Decision Support home page, in the Reporting section, click Report Builder.
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2. In the Axiom Intelligence Reports section, click PSI Analysis.
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� Slicers
This section allows you to filter data by date range, entity, and financial class. From the drop-downs, you
can select a combination of the available options to define the data parameters to include in the report.

� Total PSI
This section shows the current year PSIs and the goal set in the previous year. Hover your cursor over
the graph at the bottom of the card to view a tool tip of the data specific to a month. When you click on
the graph, the current year data and goal percentage in the parentheses will adjust to the selected time
period.
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� Total PSIs by Service Line
This section allows you to view the number of CPM indicator cases for each service line by hovering your
cursor over a service line square. When you click a square, the system greys out the details across the
page except for data specific to the service line you selected. To enable all of the data across service lines
on the page again, click the square again.
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� PSI Detailed Categories
This section provides an overview of the breakdown of PSI by category and the percentage of each.

� Including or excluding data
From some visualization charts and tables, you can exclude data by right-clicking the image or table row,
and clicking Exclude. To show only one data element in the visualization or table, right click the image or
a table row, and click Include.

� Viewing data
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show Data. A data table displays underneath the visualization graphic or table. To return to
the dashboard, click Back to report in the upper left corner of the page.

� Copying data for other reports
If you have permissions to edit or create Axiom Intelligence reports, you can copy visuals to create a new
report. For tables, you can also copy values and selections.
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To copy, right-click in the section, and select Copy Visual, Copy Selection (tables only), or Copy Value
(tables only).

NOTE: This function only applies to users that have permission to edit and manage Axiom
Intelligence reports.

Hospital Acquired Condition (HAC) Analysis report

� Overview
This report provides metrics and details regarding HAC at your organization and across service lines. To
return to the Inpatient Executive Summary Dashboard, click the arrow in the upper right corner.

� Opening the report

TIP: You can open this report individually or through the Inpatient Executive Dashboard.

To open the dashboard:
1. From the Enterprise Decision Support home page, in the Reporting section, click Report Builder.
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2. In the Axiom Intelligence Reports section, click HAC Analysis.
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� Slicers
This section allows you to filter data by date range, entity, and financial class. From the drop-downs, you
can select a combination of the available options to define the data parameters to include in the report.

� Inpatient Cases and Critical Care Metrics
This section shows the following metric information for the date range selected in the slicer section:

l Total HACs - Total number of HACs, previous year goal, and percentage of goal
l Total HACs Rate - Total rate of HACs, previous year goal, and percentage of goal
l Total Medical HACs - The number ofmedical HACs out of the total number of HACs, previous year

goal, and percentage of goal

Reporting Guide Axiom Enterprise Decision Support │ 235



l Total Surgical HACs - The number of surgical HACs out of the total number of HACs, previous year
goal, and percentage of goal

� Total HACs by Month and Rate
This section displays a bar chart that shows the number of HACs for each month for the date range
selected in the Slicer section above. The chart also shows the HAC rate trend across months.

� HAC Detail
This section displays a pie chart of the types of HACs and their percentages.
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� HACs by Service Line
This section allows you to view the number of HACs for each service line by hovering your cursor over a
service line square. When you click a square, the system greys out the details across the page except for
data specific to the service line you selected. To enable all of the data across service lines on the page
again, click the square again.
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� Including or excluding data
From some visualization charts and tables, you can exclude data by right-clicking the image or table row,
and clicking Exclude. To show only one data element in the visualization or table, right click the image or
a table row, and click Include.

� Viewing data
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show Data. A data table displays underneath the visualization graphic or table. To return to
the dashboard, click Back to report in the upper left corner of the page.
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� Copying data for other reports
If you have permissions to edit or create Axiom Intelligence reports, you can copy visuals to create a new
report. For tables, you can also copy values and selections.

To copy, right-click in the section, and select Copy Visual, Copy Selection (tables only), or Copy Value
(tables only).

NOTE: This function only applies to users that have permission to edit and manage Axiom
Intelligence reports.

Cost of Quality Variation report

� Overview
This report provides KPI measurements and other details related to determining potential cost savings
opportunities. To return to the Inpatient Executive Summary Dashboard, click the arrow in the upper
right corner.
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� Opening the report

TIP: You can open this report individually or through the Inpatient Executive Dashboard.

To open the dashboard:
1. From the Enterprise Decision Support home page, in the Reporting section, click Report Builder.
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2. In the Axiom Intelligence Reports section, click Cost of Quality Variation.
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� Slicers
This section allows you to filter data by date range, entity, and financial class. From the drop-downs, you
can select a combination of the available options to define the data parameters to include in the report.

� Quality Indicator Metrics
This section shows the following metric information for the date range selected in the slicer section:

l Total Quality Indicators - Total number of indicators for the year, previous year goal, and
percentage of goal
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l Total Cost per Case with Indicators - Total amount per case with indicators, previous year goal,
and percentage of goal

l Total Cost per case w/out Indicators - The amount per case without indicators, previous year
goal, and percentage of goal

l Total Cost per Case Difference - The difference between cases with and without indicators,
previous year goal, and percentage of goal

l Total Savings Opportunity - The amount of possible savings for the organization

� CPM Quality Indicators by Service Line
This section allows you to view the number of quality indicators for each service line by hovering your
cursor over a service line square. When you click a square, the system greys out the details across the
page except for data specific to the service line you selected. To enable all of the data across service lines
on the page again, click the square again.

� Cost of Quality Variation by Quality Indicator
This section displays the value details related to the cost of quality by quality indicator.

From this section, you can do the following:

l View the details for a specific quality indicator by clicking a row. The system greys out the details
for the other service lines across the page except for data specific to the quality indicator you
selected.
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l Sort the table by columns in ascending or descending order by clicking the column header.

l Drill up or down through the data by right-clicking the row, and then selecting Drill Up or Drill
Down.

� Including or excluding data
From some visualization charts and tables, you can exclude data by right-clicking the image or table row,
and clicking Exclude. To show only one data element in the visualization or table, right click the image or
a table row, and click Include.

� Viewing data
You can view the underlying data for visualization graphs and tables by right-clicking the image or table,
and clicking Show Data. A data table displays underneath the visualization graphic or table. To return to
the dashboard, click Back to report in the upper left corner of the page.

� Copying data for other reports
If you have permissions to edit or create Axiom Intelligence reports, you can copy visuals to create a new
report. For tables, you can also copy values and selections.

To copy, right-click in the section, and select Copy Visual, Copy Selection (tables only), or Copy Value
(tables only).

NOTE: This function only applies to users that have permission to edit and manage Axiom
Intelligence reports.
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Configuring Scheduler tasks for CPM processing and importing data
There are two Scheduler jobs used to process and import data to the CPM dashboard. In most cases,
you will not need to configure or change these job settings. However, you may want to adjust the timing
for when they occur.

To configure Scheduler tasks for CPM processing and importing data:
1. Open the Scheduler.

2. Select the Trigger DME Processing or Import DME Processing job, depending on the one to edit.

3. Do the following:

Scheduler Job Description

Trigger DME Processing a. To change the day the job runs, click the Tasks > Trigger
DME Processing tab on the left side of the screen.

b. Click Task Control.

c. In the Process task only if the value of this expression
is true box, after the equals sign in the formula, enter the
day of themonth to run the job. By default, the system
runs the job on the 15th.

d. To change the time the job runs, click the Scheduler Rules
tab on the left side of the screen.

e. Double-click theHours cell, and enter a new time (using
military time) to run the process.

Import DME Processing a. Click the Scheduling Rules tab on the left side of the
screen.

b. Double-click theHours cell, and enter a new time (using
military time) to run the process. It should run about an
hour after the Trigger DME Processing job.

4. After making your changes, In the Job tab, click Save.

Reporting Guide Axiom Enterprise Decision Support │ 245



Desktop Client Reports
This section describes and provides instructions for the reports currently available in the Desktop Client
version of Axiom Enterprise Decision Support. This chapter also includes topics on how to interact and
run reports in the Desktop Client interface.

The following table lists the Excel reports available:

Report Description

Physician Analysis reports Evaluates the dimensions and measures at the encounter
level across the organization with a focus on the Insurance
Plan, Payor, and Financial Class dimensions.

Patient Analysis reports Evaluates the dimensions and measures at the encounter
level across the organization. In many cases, these reports
include the Inpatient, Outpatient, and Professional Billing
patients. In some cases, however, some reports are limited
to Inpatients due to the different measures available for
these encounters, e.g., Average Length of Stay (ALOS).

Payor Analysis reports Evaluates the dimensions and measures at the encounter
level across the organization with a focus on the Insurance
Plan, Payor, and Financial Class dimensions. In many
cases, these reports the Inpatient, Outpatient, and
Professional Billing patients. In some cases, however,
some reports are limited to Inpatients due to the different
measures available for these encounters, e.g., Average
Length of Stay (ALOS).

Population Analysis reports Evaluates certain dimensions and measures at both the
encounter and cost detail levels across the organization.
Population Analysis reports focus on grouping patient in
such a way as to make comparisons across time or
physicians meaningful, e.g., populations within a particular
entity, service line, etc. In many cases, these reports
include the Inpatient, Outpatient, and Professional Billing
patients.

3
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Report Description

Service Line Analysis reports Evaluates health service operations. The extremely wide
and varied nature of health conditions and treatment
methods makes service lines a valuable way of classifying
the patients served by provider organizations into quasi-
homogenous populations.

Data Dictionary report View changes between the Axiom Databasemodel and the
Axiom Intelligence Analysis Services data model - including
table or column name changes as well as denormalization
of columns onto different tables.

Opening costing reports
The Costing Reports page provides links to the reports available in Axiom Enterprise Decision Support,
including:

l Data import validations
l Reclass and OH reconciliation
l Reconciliation summary
l RVU development
l Transaction Microcost reconciliation
l Unit cost calcs by method
l Unit cost reconciliation

To access costing reports:
1. From the Enterprise Decision Support home page, in the Reporting section, click Costing Report

Library.

Reporting Guide Axiom Enterprise Decision Support │ 247



2. To open a report, click the link.
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NOTE: The reports open as a tab in the Desktop Client version.

Using Reports
Axiom Enterprise Decision Support reports can query data from any table in the Axiom Enterprise
Decision Support database. This section provides basic information about spreadsheet-based Axiom
reports, and explains how to open existing reports and refresh them with data.

In addition to the report-specific functionality detailed in this section, you can use standard Axiom file
features and tools. Report files use the same functionality as other Axiom files to perform actions such as
changing views or navigating to file bookmarks.
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Using Axiom file features
This section explains the features available when working with Axiom files in the Desktop Client. Axiom
files are controlled Microsoft Excel spreadsheets that support Axiom Enterprise Decision Support
features for planning and reporting.

With a few noted exceptions, all of the features discussed here are available for use in:
l Plan files
l Reports
l Supporting files for file groups (Templates, Drivers, Utilities)

This section is for users who are working with Axiom files that have already been set up to query data,
save data, and use other Axiom Enterprise Decision Support features.

Drilling the data in an Axiom file

Axiom Enterprise Decision Support provides various options to drill the data in an Axiom file:
l Drill down. You can "drill down" a data row to view the data at a different level of detail. If

hierarchies have been set up for your data, you can drill down predefined hierarchy levels. You can
also drill down to the "bottom" of the data or choose any relevant column for drilling.

l Drill through. You can "drill through" the data in a specific cell to view the associated sub-GL detail
or transactional data. This feature is only available if drill through has been enabled for the source
data, using drill-through definitions.

Drilling data: Using Drill Down

You can drill down a row in an Axiom file to view the data at a different level of detail. For example, if a
row of data in the report shows budget totals for the Northwest region, you can drill the row to see the
values for each individual department in that region. This type of drilling is known as "drilling down."

Drilling down can be used in report files or plan files, but themost typical use case is in reports. In plan
files, most data is already at the lowest level of detail, so drilling down may only be useful if the plan file
has a summary sheet with drillable data.

If a row is eligible for drilling, you can drill down hierarchies that have been set up for the data. For
example, your system may have a Geography hierarchy such as: Country > Region > DEPT. You can also
choose to drill directly to the "bottom" of the data (all dimensions), or drill using any related column in
the data.

You can drill data rows that result from an Axiom query or that are built using GetData functions. A few
limitations apply, and some advanced configurations have special behaviors. For more details, see the
drill down setup discussion in the Axiom File Setup Guide.

Drilling can be disabled on a per sheet level. If drilling has been disabled for a sheet, then the Drill option
is disabled while you are on that sheet. This may be done if the data on the sheet is not conducive to
drilling.
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To drill down a row of data:
1. Place your cursor in the row of data that you want to drill.

If you are drilling a row of data that is part of a multiple-row calc method, then you can place your
cursor anywhere in themultiple-row calc method. The drill results will be for all rows of the calc
method.

2. On the Axiom tab, in the File Options group, click Drill, and then select the desired drill level from
theDrill Down sub-menu.

NOTE: In system with installed products, this option may be located on theMain tab.

Drill option Description

Hierarchies Your system may have defined hierarchies that outline logical drilling
paths. For example, you may have a Geography hierarchy that allows
you to drill from Country to Region to individual departments.

Hierarchies are defined per dimension (on the relevant reference
table), and are specific to your system.

On theDrillmenu, hierarchies are listed first if defined. Only
hierarchies relating to the current data are shown.

NOTES:
l If the data to be drilled comes from multiple data tables, then only

the hierarchies from shared lookup reference tables are available.
l If you are drilling an Axiom query, hierarchy options will be grayed

out on themenu if you are already at that level of detail. For
example, if the report is at the VP level already, VP is grayed out on
themenu. However, when you are drilling GetData functions, all
hierarchy options are present on themenu, because the GetData
functions may all have different "sum by" levels.

All Detail Selecting All Detail takes you directly to the very "bottom" of the
data. Essentially, you are drilling based on all dimensions at once,
rather than on one specific dimension.

The drill sheet will contain one column for each dimension (key
column) in the data, including a description column for each (if
applicable).

NOTE: If the row contains data from more than one data table, then
this option is only available if the tables share the exact same key
columns and all of the key columns are lookup columns.
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Drill option Description

Choose Columns Selecting Choose Columns allows you to drill based on any relevant
column for the current data, including non-lookup key columns.

In the Select Columns dialog, select the column (or columns) that you
want to drill by. You can select from any column in the primary data
table, as well as any column in lookup reference tables.

This drilling option is entirely free-format. There is no validation to
determine if a particular column selection makes sense in relation to
the current data.

NOTES:
l Calculated fields do not display and cannot be used for drilling.
l If the row contains data from multiple data tables, then only

columns from shared lookup reference tables can be selected.

A temporary file opens, named Drill_Filename.xlsx. This file contains a drill sheet named Drill_
DrillLevel, that shows the results of the selected drill. The top of the drill sheet displays your current drill
context.

If you want to continue to drill, you can do either of the following:
l Return to the original sheet (or a different sheet) in the original file, and then select a new drill

level. If you left the temporary drill file open, then a new drill sheet will be added to that file, with
the new drill results. If you closed the temporary file, then Axiom Enterprise Decision Support
creates a new temporary file.

l Select a row in the drill sheet, and continue drilling to a lower level of detail. A new drill sheet will
be created in the temporary file with the results.

When you are finished viewing the drill results, close the temporary file. While it is possible to use Save
As to save the temporary file, typically this is not useful. You can always perform the drill again at any
time to see the results. If you find yourself performing the same drill over and over, you may want to
create a new report that displays the data at the desired level. If you want to share the drill results with
someone else, the best approach is to create a snapshot copy of the temporary drill file.

Double-click drilling
If Axiom double-click actions are enabled for the sheet, then you can drill a row of data by double-clicking
it. In this case, a dialog opens, listing the drilling options for the current row selection. Select the desired
drill level and then click OK.

NOTE: Certain double-click actions may take priority over drilling.
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Drilling data: Using Drill Through

You can drill a specific data point in an Axiom file to see the associated sub-GL detail or transactional data.
This feature is only available if "drill through" has been enabled for the source data, using a drill-through
definition.

The drill-through feature can be used in either report files or plan files.

You can drill data values that result from an Axiom query or from a GetData function. A few limitations
apply, and some advanced configurations have special behaviors. For more details, see the drill through
discussion in the Axiom File Setup Guide.

Drilling can be disabled on a per sheet level. If drilling has been disabled for a sheet, then the Drill option
is disabled while you are on that sheet. This may be done if the data on the sheet is not conducive to
drilling.

To drill through the data in an Axiom file:
1. Place your cursor in the cell that contains the value you want to drill.

2. On the Axiom tab, in the File Options group, click Drill, and then select the desired drill from the
Drill Through sub-menu.

NOTE: In system with installed products, this option may be located on theMain tab.

IfDrill Through is not listed on the drilling menu, then the selected cell is not eligible for drill
through.

A temporary file opens, named Drill_Filename.xlsx. This file contains a drill sheet named Drill_
DrillLevel, that shows the results of the selected drill. The top of the drill sheet displays your current drill
context.

Double-click drilling
If Axiom double-click actions are enabled for the sheet, then you can drill a data value by double-clicking
it. In this case, a dialog opens, listing the drilling options for the current selection. Select the desired drill
level and then click OK.

Changing views in an Axiom file

If views have been defined for a sheet in a spreadsheet Axiom file, you can change the view to change
how information is presented in the sheet.

For example, you might have the option to switch between a Detail sheet view and a Summary sheet
view. You might have the option to toggle certain rows and columns as hidden or shown, such as to
select which quarters you want to view. The specific view options available depends on the file design.

To change the views in a sheet:
l On the Axiom tab, in the File Options group, click Change view.
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NOTE: In systems with installed products, this featuremay be located on theMain tab.

This displays a menu showing all views defined in the current sheet. You can click on a view name to
activate that view.

Some views are single-selection, which means that activating one view deactivates the prior view. Other
views allow for "additive" selections so that multiple views can be active at one time. Some views may
open a dialog where you can select specific sets of rows or columns to show. The specific behavior of
each view depends on the file designer. Ideally the name of the viewwill give you a good idea of what to
expect when that particular view is selected.

After any view is made active, the freeze panes setting for the sheet is also reapplied. Axiom Enterprise
Decision Support keeps track of the currently active views in a sheet and will reapply them after you
perform certain activities in a sheet, such as refreshing an Axiom query or inserting a calc method.

Jumping to GoTo bookmarks in an Axiom file

If an Axiom file has bookmarks defined in the file, you can go directly to bookmarked points by using the
GoTo feature.

To go to a bookmark:
l On the Axiom tab, in the File Options group, click GoTo.

NOTE: In systems with installed products, this featuremay be located on theMain tab.

A list appears underneath theGoTo button, listing sets of bookmarks. For example, theremay be a set of
bookmarks for each sheet in the file.

Selecting a set brings up a list of bookmarks in that set. Click a bookmark in the list to go directly to that
area.

Example GoTo bookmarks

Freezing or unfreezing panes in a sheet

Sheets in Axiom files can be configured to freeze panes at a certain location automatically when the file is
opened. You can toggle these frozen panes on and off by using the Freeze Panes option.
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This option is only available if the sheet is not protected. If you have security rights to unprotect the
sheet, the Freeze Panes option will become available once the sheet is no longer protected.

To freeze or unfreeze panes in a sheet:
l On the Axiom tab, in the File Options group, select or clear the Freeze Panes check box.

NOTE: In systems with installed products, this featuremay be located on theMain tab.

If panes are frozen, clearing the check box unfreezes the panes.

If panes are unfrozen, selecting the check box freezes the panes. If a sheet has freeze panes settings
configured on the Control Sheet, selecting the check box applies that setting, regardless of where your
cursor is in the spreadsheet. Otherwise, the Freeze Panes option works like theMicrosoft Excel feature,
and freezes panes at the current cursor position.

NOTE: If you have toggled freeze panes off, and then you use Change view to select a view (or if you
otherwise perform an action that causes a view to be reapplied), the freeze panes settings for the
sheet are reapplied.

Removing workbook and worksheet protections

Axiom Enterprise Decision Support applies a variety of workbook and worksheet protections to Axiom
files. If you have the appropriate user rights, you can temporarily remove the workbook or worksheet
protections using the unprotect options available on the Axiom ribbon.

NOTE: The workbook and worksheet protection toggles are intended to allow users to temporarily
remove and then reapply the protection settings of the existing file. If the sheet or file is not already
configured on the Control Sheet to enable protection, selecting these options does not change that
configuration. If you want to enable protection for a sheet or a file, use the Control Sheet settings.

� Remove worksheet protection
If a sheet is protected, you can temporarily unprotect it as follows:

l On the Axiom tab, in the Advanced group, click Protect > Worksheet to remove the check mark.

NOTE: In systems with installed products, this featuremay be located on the Admin tab—
either directly on the ribbon or under File Protection.

The sheet can now be edited as desired. If you do not have rights to remove worksheet protection, then
this item does not display on themenu.

The sheet protection will be automatically reapplied the next time the file is opened. If you want to
reapply it now, click Protect > Worksheet again to toggle the protection back on.
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The Control Sheet settings for an Axiom file determine whether protection is enabled for a sheet. Sheet
protection is most often applied to plan files / templates, but may also be applied to driver files and
reports as needed. Protection is always applied to Control Sheets.

� Remove workbook protection
If a workbook is protected, you can temporarily unprotect it as follows:

l On the Axiom tab, in the Advanced group, click Protect > Workbook to remove the check mark.

NOTE: In systems with installed products, this featuremay be located on the Admin tab—
either directly on the ribbon or under File Protection.

You can nowmake structure changes to the workbook, such as unhiding sheets or adding sheets. If you
do not have rights to remove workbook protection, then this item does not display on themenu.

The workbook protection will be automatically reapplied the next time the file is opened. If you want to
reapply it now, click Protect > Workbook again to toggle the protection back on.

For report files and driver files, the Control Sheet settings determine whether workbook protection is
enabled for the file. For plan files, workbook protection is applied automatically.

NOTE: For plan files, any structure changes made to the file should be temporary (such as unhiding
the Control Sheet to troubleshoot an Axiom query). If you delete or rename sheets, this may impact
Axiom query settings and use of calc method libraries. Structure changes to plan files should bemade
in the template, not the individual plan files.

� Remove all protection
Users with the appropriate permissions can turn off all protections and display controls at once by using
the Show Everything button on the Axiom Designer tab.

NOTE: In systems with installed products, this featuremay be located on the Admin tab—either
directly on the ribbon or under File Protection.

Printing Files and other File Output Options

Axiom Enterprise Decision Support has a variety of features that can be used to create file output and
share data with people throughout your organization.

Printing an Axiom file

You can print a spreadsheet Axiom file on a per sheet basis. You can decide to print one or more sheets,
or all available sheets.

Reporting Guide Axiom Enterprise Decision Support │ 256



Each sheet can have one or more defined print views. The print views can be used to print different
"views" of the sheet, and to set certain standard print options such as the print orientation. For example,
for a plan file, you might have one print view that prints a "summary" view of the sheet (with certain
columns and rows hidden for printing), and another print view that prints a "detail" view of the sheet
(with all columns and rows visible).

If a sheet has no predefined print views, then the sheet can be printed using the settings defined for the
spreadsheet using standard Excel printing features. For more information on defining print settings for a
spreadsheet, see theMicrosoft Excel Help. In theWindows Client, the spreadsheet print settings are
defined in theWorkbook Explorer, in the Page Setup section for each sheet.

NOTE: You can always print the file using standard spreadsheet print functionality, even if Axiom
Enterprise Decision Support print views have been defined.

To print an Axiom file:
1. On the Axiom tab, in the File Output group, select one of the following:

l If you want to be able to select print views from all sheets in the workbook, click Print.
l If you want to print only the current sheet, then click the arrow to the right of the Print

button, and then click Print This Sheet.

NOTE: In systems with installed products, this featuremay be located on theMain tab—
either directly on the ribbon or under Publish.

The Print Sheets dialog opens. This dialog lists the available print views for the entire workbook or
for the current sheet, depending on how you entered the dialog. To sort this list by the Sheet
Name or Print ViewName, click the column header.
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Example Print Sheets dialog

NOTES:
l If a sheet does not have a defined print view, then it is listed with a print view name of

"Default," and will use the print settings defined for the spreadsheet.

l Control Sheets cannot be printed using the Axiom Enterprise Decision Support printing
feature, whether they are visible or hidden. If you want to print a Control Sheet, use the
standard spreadsheet printing features.

2. In the Print Sheets dialog, select the sheet / print view combinations that you want to print.

If you want to print all print views for all sheets, then select the check box in the column header to
select all.

If you opened this dialog by using Print This Sheet and the sheet has only one available print
view, then that view is selected by default.

3. You can also do any of the following before printing:
l View and edit the print settings. If you want to view and potentially change the print

settings for a selected view, click the View/Edit link. In the Print Options dialog, you can
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change any of the print settings, for the current print job only (the changes are not saved in
the file).

l Preview a print view. If you want to preview a print view, click the Print Preview link. The
native spreadsheet Print Preview feature will open to preview the print job. Only one view
can be previewed at a time.

l Select a printer. If you want to print to a different printer than your default printer, click
Choose Printer at the bottom of the dialog. In the Printer Setup dialog, select the printer
that you want to use, and then click OK.

NOTE: In theWindows Client, the printer is always your default printer unless you
change it for a particular print job. In the Excel Client, the printer starts as your default
printer, but if you change the printer for a print job, the changed selection will be
remembered for any future print jobs in the current session.

4. Click Print.

The selected items are printed.

Print Options dialog

The Print Options dialog displays the print settings for the current print view. If desired, you can edit
settings for the current print job only. Any changes madewill not be saved in the file.

NOTE: Print options are read-only when using the Print Plan Files option to print multiple plan files.

This dialog displays all of the settings that will be applied to the print job, whether the setting is defined
in the associated Print tag or inherited from the spreadsheet settings. If a setting is blank, then that print
option is not defined and will not be applied to the print job.

Item Description

Print ViewName The name of the current print view.

ViewName The name of the sheet view to be applied when printing. These are the
same sheet views that are available from the Change Viewmenu.

For example, if the sheet view is configured to hide columns or rows,
those columns and rows will be hidden in the print copy. Row and
column sizing is also applied.

Paper Size The paper size for the print job, either Letter or Legal.

Orientation The print orientation for the print view, either Portrait or Landscape.

Repeat Rows The rows to repeat at the top of the page. Rows must be specified as a
range; for example: 1:3.

Print View Options
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Item Description

Repeat Columns The columns to repeat at the left of the page. Columns must be
specified as a range; for example: A:C.

Item Description

Fit To Pages Wide The number of pages on which to fit the print area. For example, if you
want the print area to fit on one page, specify 1.

Percent Zoom The percent zoom to apply to the print range. Specify the number
without a percent sign. For example, to zoom by 90%, specify 90.

Scaling

Item Description

Left Header Header text to display in the left-hand side of the header.

Center Header Header text to display in the center of the header.

Right Header Header text to display in the right-hand side of the header.

Left Footer Footer text to display in the left-hand side of the footer.

Center Footer Footer text to display in the center of the footer.

Right Footer Footer text to display in the right of the footer.

Headers and Footers

Printing multiple plan files

You can print multiple plan files in batch by using the Print Plan Files feature. You can select multiple
plan files within a file group, and then select one or more print views for each plan file. The available print
views for each plan file are based on the template that was used to create the plan file.

To print multiple plan files from a file group:
1. On the Axiom tab, in the File Output group, click the down arrow to the right of the Print button,

and then click Print Plan Files.

NOTE: In systems with installed products, this featuremay be located on theMain tab—
either directly on the ribbon or under Publish.

TIP: If you have access to the file group menu for a file group, then you can access Print Plan
Files from the file group menu. In this case, the current file group is pre-selected in the dialog.

2. In the Print Plan Files dialog, use the File Group list to select the file group that contains the plan
files that you want to print.
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Only one file group can be printed at a time. Once a file group is selected, the dialog displays a list
of the available plan files.

3. In the Select plan files to print section, select the plan files that you want to print.
l You can sort and filter the list using standard Axiom grid functionality to find the plan files

that you want to print.

l To select multiple plan files at once, highlight the plan files, and then right-click and select
Select. If you want to print all plan files that currently display in the dialog, select the check
box in the header row.

Once at least one plan file has been selected, you can select which print views to print.

4. In the Select views to print section (at the bottom of the dialog), select the views that you want
to print. You must do this for each source template used for the selected plan files.

l Click the Select print views link.

l In the Select Print Views dialog, select the sheet / print view combinations that you would
like to print, and then click OK.

If you want to see the settings that will be applied to the print job, click the View link. Print
settings are read-only in this context.

NOTE: All template sheets are listed in this context (except for Control Sheets), including
sheets that you may not normally see in plan files because they are hidden. If you select
a sheet that is hidden in one of the selected plan files, it will not be printed. Amessage
will inform you of the unprinted sheet when the printing process is complete.

l Repeat this process for each source template.

If all of the selected plan files were built using the same template, then there will be only one
template listed. If the selected plan files were built using multiple templates, then multiple
templates will be listed. The print selections for each template will only apply to the plan files that
were built using that template.

5. If you want to print to a different printer than your default printer, click Choose Printer at the
bottom of the dialog. In the Printer Setup dialog, select the printer that you want to use, and then
click OK.
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NOTE: In theWindows Client, the printer is always your default printer unless you change it
for a particular print job. In the Excel Client, the printer starts as your default printer, but if you
change the printer for a print job, the changed selection will be remembered for any future
print jobs in the current session.

6. Click Print.

The selected plan files are printed, using the print view selections.

If a selected print view is not found in a target plan file, a message displays at the end of the process,
listing the affected plan file and the relevant sheet / print view. This may occur if the print views in either
the template or the plan file have been modified after plan file creation.

Running file processing on an Axiom file

If a file is set up to use file processing, you can process the file to automatically create various file
outputs, such as:

l Save snapshot copies of the file and automatically email them to various recipients
l Print one or more sheets in the file using one or more print views
l Export data in the file to a CSV or TXT file
l Collect multiple output files into a single report package
l Process multiple reports in batch

File processing can be used in all spreadsheet Axiom files except file group templates, however, report
files are themost common use case.

NOTE: The file processing menu command and the associated task pane are only available to
administrators and to users with the Allow File Processing permission for the file.

To process a file using file processing:
1. Open the file. If you want to see what the file is configured to do during file processing before

executing it, you can check the settings in the File Processing task pane.

2. In the File Processing task pane, in the Actions section, click one of the following options to start
processing:

l Process File: The file is processed once "as is." The file is refreshed and the file processing
action is performed. No multipass filter or settings are applied.

l Process File Multipass: The file is processed multiple times, with a unique filter applied for
each pass. For example, if the file is set up to process by DEPT, then the file is processed
once for each department. The data queries in the file are automatically filtered to return
data for the current pass department only.

TIP: You can also process the file using the File Processingmenu on the Axiom tab. (In
systems with installed products, this featuremay be located on theMain tab.)
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Once file processing is initiated, the following occurs:
l The file is refreshed. If you are performing multipass processing, the file is refreshed using a data

filter for the current pass item.
l The file processing action is performed. If you are performing multipass processing, the action

may be performed after each pass, or it may be performed once all passes are complete,
depending on the file processing settings.

A status bar displays the progress of the file processing. When the processing is complete, a confirmation
box displays information about the process, such as howmany passes were performed, howmany files
were created, etc.

Note that the file itself is not saved as part of file processing. You can process a file even if you have read-
only rights to the file. However, if the file processing is set up to save to the database, you must have
rights to save data for that file.

Taking a snapshot copy of an Axiom file

You can take a “snapshot” of a spreadsheet Axiom file, so that you can save a copy as a normal Excel file
and then open it in Microsoft Excel (without needing Axiom Enterprise Decision Support). For example,
you may want to send a copy of a report to someone that does not have access to Axiom Enterprise
Decision Support.

When you create a snapshot of an Axiom file, the file is copied as an XLSX file, and the following occurs:
l All Control Sheets and any hidden sheets are automatically removed. You can choose whether to

include all remaining sheets, or only the active sheet.
l All Axiom formulas are replaced with values. You can choose whether to retain Excel formulas, or

replace them with values. If Excel formulas are preserved, certain formulas will be replaced with
values if they reference sheets or cells that are deleted as part of the snapshot processing.

l Rows and columns flagged for delete are deleted.

Due to the file format, any VBA macros in the file are also removed.

To take a snapshot of an Axiom file:
1. Open the file in Axiom Enterprise Decision Support.

2. On the Axiom tab, in the File Output group, click Snapshot.

NOTE: In systems with installed products, this featuremay be located on theMain tab—
either directly on the ribbon or under Publish.

The Snapshot File dialog opens.

3. In the Formula Replacements section, select one of the following:

l Convert All Formulas (default): All formulas are replaced with values.

l Retain Excel Native Formulas: All Excel formulas in the spreadsheet will be retained as is,

Reporting Guide Axiom Enterprise Decision Support │ 263



with one exception. If a cross-sheet formula references a sheet that will not be present in
the snapshot (depending on the Sheets To Snapshot setting), that formula will be replaced
with values.

NOTE: If the file contains a pivot table, this option must be selected in order for the
pivot table to work in the snapshot copy.

4. In the Sheets to Snapshot section, select one of the following:
l Limit to Active Sheet (default): Include only the active sheet in the snapshot.
l All Sheets In File: Include all sheets in the file (except any Control Sheets and hidden

sheets, which are always removed).

5. Click OK.

The snapshot file is created and is opened in Axiom Enterprise Decision Support. The navigation tab for
the file is titled either Sheetname_snapshot (if the snapshot contains only one sheet) or FileName_
snapshot (if the snapshot has multiple sheets). You can now use Save As features to save the file locally
or to a network location.

NOTE: If you are using the Excel Client and you want to save a copy of the snapshot as a PDF file, you
can use standard Excel functionality to do so. Use File > Save As, and then select PDF as the file type.
This is an Excel-specific feature that is not available in theWindows Client.

If you want to email a snapshot to someone directly, you can use the E-Mail Workbook feature. This
creates a snapshot and attaches it to an email (instead of opening it in Axiom Enterprise Decision
Support).

Emailing a snapshot of an Axiom file

You can email a snapshot of a spreadsheet Axiom file using the E-mail feature. Axiom Enterprise Decision
Support creates a snapshot copy of the file and attaches it to an email. The copy can then be viewed
outside of Axiom Enterprise Decision Support by someonewho may have no access to the system. When
you use this feature, Axiom Enterprise Decision Support creates a snapshot copy of the file just like it
would if you used the Snapshot feature.

The email can be sent using your default email client (such as Microsoft Outlook), or you can send the file
using the Axiom Enterprise Decision Support Scheduler email service. Note that the Scheduler email
service does not support HTML format for email.

Reporting Guide Axiom Enterprise Decision Support │ 264



NOTES:
l The name of the emailed file is either Sheetname_snapshot (if the snapshot contains only one

sheet) or FileName_snapshot (if the snapshot has multiple sheets). The name cannot be
changed.

l You can also email snapshot copies using the File Processing feature. File processing is typically
used when you want to automate the process and employ multipass processing to send the
same file to different people using different data. The E-mail feature is best used to send "one-
off" snapshots as needed.

To email a snapshot copy of an Axiom file:
1. Open the file in Axiom Enterprise Decision Support.

2. On the Axiom tab, in the File Output group, select E-mail.

NOTE: In systems with installed products, this featuremay be located on theMain tab—
either directly on the ribbon or under Publish.

The E-mail Active Workbook dialog opens.

3. For Send As, select Snapshot.

4. For Send using, select one of the following:

l Outlook: Send the email using the default email client on your local machine (for example,
Microsoft Outlook). The name of this option may be customized for your organization.

l Axiom Mail Service: Send the email using the Axiom Enterprise Decision Support Scheduler
email service.

5. Complete the following Snapshot Options in the dialog:

Option Description

Send file as Select XLS, XLSX, XLSM, or PDF. XLSX is selected by default.

Include Select one of the following:

l Entire Workbook: All sheets are included in the snapshot (except
Control Sheets and hidden sheets, which are always removed).

l Active Worksheet Only (default): Only the active worksheet is included
in the snapshot.
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Option Description

Formulas l Convert All Formulas (default): All formulas are converted to values.
l Retain Excel Native Formulas: Axiom formulas are converted to

values, but Excel formulas are left as is. Note that if an Excel formula
references a sheet that is not included in the snapshot, that formula
will be converted to a value.
NOTE: If the file contains a pivot table, this option must be selected in
order for the pivot table to work in the snapshot copy.

This option does not apply if PDF is the selected file type.

6. Click OK.

If you selected to send the file using your default email client, then a new email message opens, with the
snapshot file attached. You can then specify the recipient, subject, and body text for the email, and then
send it.

If you selected to send the file using the Axiom mail service, then an E-Mail dialog opens so that you can
specify the recipient, subject, and body text for the email. In the address boxes (To, Cc, and BCC), you
can either type an email address, or click the button to select an Axiom Enterprise Decision Support user.
If you select a user, the email will be sent using the user's email address as defined in Axiom Enterprise
Decision Support security. When you click OK, the email settings are saved to the database, to be sent
the next time the Scheduler SMTP Email Delivery task is run.

Emailing a hyperlink to an Axiom file

You can email a hyperlink to a spreadsheet Axiom file using the E-mail feature. Axiom Enterprise Decision
Support creates a URL hyperlink to the file and includes it in an email. The email recipient can click on the
link to launch the system and open the file directly, assuming that the recipient is an Axiom Enterprise
Decision Support user who has rights to access the file.

The email can be sent using your default email client (such as Microsoft Outlook), or you can send the file
using the Axiom Enterprise Decision Support Scheduler email service. Note that the Scheduler email
service does not support HTML format for email.
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NOTES:
l Alternatively, you can obtain a URL to an Axiom file using a variety of ways and then paste it

into an email that you createmanually. For example, you can use GetDocumentHyperlink or
right-click a file in Axiom Explorer to obtain a URL. The email hyperlink feature is provided as a
convenience to quickly send a hyperlink to the current file.

l The email hyperlink feature cannot be used to send a hyperlink to open a form-enabled file as
an Axiom form; the source file will always be opened as a spreadsheet.

l The hyperlink included in the email uses the same format as hyperlinks generated using
GetDocumentHyperlink, including the differing URL format for systems using SAML or
OpenID Authentication.

To email a hyperlink to an Axiom file:
1. Open the file in Axiom Enterprise Decision Support.

2. On the Axiom tab, in the File Output group, select E-mail.

NOTE: In systems with installed products, this featuremay be located on theMain tab—
either directly on the ribbon or under Publish.

The E-mail Active Workbook dialog opens.

3. For Send As, select Document Link.

4. For Send using, select one of the following:

l Outlook: Send the email using the default email client on your local machine (for example,
Microsoft Outlook). The name of this option may be customized for your organization.

l Axiom Mail Service: Send the email using the Axiom Enterprise Decision Support Scheduler
email service.

5. Optional. Complete theDocument Link Options in the dialog:

Option Description

Sheet Filter If desired, enter a filter to apply to the file when it is opened. You can type
the filter statement or use the Filter Wizard.

The filter is applied like a Quick Filter and affects any data queries in the
file. For example, Dept.Region='West'means that all data queried will
be limited to theWest region.
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Option Description

Cell Address If desired, specify the cell to bemade active when the document is
opened. For example:

Sheet1!D22

If the specified location would not be in view normally then the file will be
scrolled to that location; otherwise the file will open in its default viewwith
the cursor placed at that location.

6. Click OK.

If you selected to send the hyperlink using your default email client, then a new email message opens,
with the hyperlink included in the body text. You can then specify the recipient, subject, and additional
body text for the email, and then send it.

If you selected to send the hyperlink using the Axiom mail service, then an E-Mail dialog opens so that
you can specify the recipient, subject, and additional body text for the email. In the To and Cc boxes, you
can either type an email address, or click the button to select an Axiom Enterprise Decision Support user.
If you select a user, the email will be sent using the user's email address as defined in Axiom Enterprise
Decision Support security. When you click OK, the email settings are saved to the database, to be sent
the next time the Scheduler SMTP Email Delivery task is run.

Using spreadsheet features

All Axiom spreadsheet files—plan files, reports, templates, and drivers—areMicrosoft Excel
spreadsheets. In addition to Axiom Enterprise Decision Support features, you can use spreadsheet
features for formatting, formulas, and other functions.

NOTE: Your organization may choose to deploy certain files as web-enabled Axiom forms instead of
as spreadsheets. In this case you will interact with the file as if it were a web page, and spreadsheet
features will not be available.

� Using spreadsheet features in the Excel Client
When you work on Axiom files in the Axiom Enterprise Decision Support Excel Client, all of the features of
Microsoft Excel are available to you. You can use standard Excel features to format cells, create charts
and graphs, create formulas, etc.

Where appropriate, standard Excel menus and shortcuts can be used to perform their equivalent Axiom
Enterprise Decision Support function. For example, if you want to save an Axiom file, you can click Save
on the Axiom tab of the ribbon, or you can use the Excel menu Save command (or Excel's keyboard
shortcut of CTRL+S). However, note that you cannot use Excel's fileOpen command to open files that are
stored in the Axiom Enterprise Decision Support database—managed Axiom files must be opened using
Axiom menu commands.
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While you are working in the Excel Client, you can open "regular" Excel spreadsheets and work with them
as normal alongside any Axiom files that you have open. You do not need to open another Excel session
or close your Axiom Enterprise Decision Support session in order to work with regular Excel files.

� Using spreadsheet features in the Windows Client
The Axiom Enterprise Decision Support Windows Client emulates theMicrosoft Excel spreadsheet
environment. While the spreadsheet itself and the Axiom file features are essentially the same in either
client, the way that you work with spreadsheet features is different in theWindows Client.

In theWindows Client, you access spreadsheet features from the following locations:
l File menu: Similar to the File menu in Excel, this menu provides access to basic commands such as

Open, Close, Print, and Save.

l Home tab: Similar to the Home tab in Excel, this tab contains some common spreadsheet
formatting commands such as copy and paste, font and number formatting, and other cell and
sheet formatting options.

l Range Explorer: Using the Range Explorer, you can format cells and define cell-related features
such as validation and conditional formatting. Available from the Axiom Button and the right-click
menu.

l Workbook Explorer: Using theWorkbook Explorer, you can add and delete sheets, and work with
sheet-level settings. You can also define named ranges. Available from the Axiom Button and the
right-click menu.

l Display: In theDisplay group on the Axiom tab, you can toggle the formula bar and row / column
headings on and off.

For example, the following table details some common spreadsheet actions and how to perform them in
theWindows Client:

Action Windows Client

Open an external
spreadsheet file

From the Filemenu, click Open.

Change the name of a
sheet

On theHome tab, in the Cells group, click Format > Rename Sheet.

Add a sheet to a file On theHome tab, in the Cells group, click Insert > Insert Sheet.

Set rowwidth or
column height

On theHome tab, in the Cells group, click Format > Row Height or Format
> Column Width.

Hide or unhide a
sheet

On theHome tab, in the Cells group, click Format > Hide & Unhide.
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Closing Axiom files

You can close an Axiom file in one of the following ways:
l Click the X in the right-hand side of the file tab.
l Right-click the file tab and select Close or Close All. Note that using Close All will not close the

Home file.
l Click File > Close.
l Click the lower X in the right-hand side of the application window (Excel Client only).

If the file has any unsaved changes, you will be prompted to save the file before it is closed.

If you are using the Excel Client, and you close all open files, then the application will automatically close.
In theWindows Client, the application will remain open with a blank file area.

If close options are not available for a particular file, such as the Home file, that means the file has been
designated as "non-closeable" by a system administrator. This file is intended to always remain open
while you are in Axiom Enterprise Decision Support.

� Closing multiple files
When using Close All or Close All But This, or when closing the application with open files, Axiom
Enterprise Decision Support checks all files for unsaved changes before closing. If any are found, the Save
Modified Items dialog opens, listing each file with unsaved changes.

By default, all modified read/write files are selected to save before closing. If you do not want to save a
particular file, clear the check box for that file. You can also use the Select All and Clear All options.

If you choose to save files as part of the close, this will perform a full save (both saving the file and
performing a save-to-database if applicable).

Refreshing a report with data
To update a spreadsheet Axiom report with themost current data from the database, refresh the file. A
refresh does the following:

l Updates active Axiom queries with data, according to the update settings defined for the query
l Updates Axiom functions with data
l Performs an Excel calculation
l Reapplies the currently active views (if applicable)

To refresh a report:
l On the Axiom tab, in the File Options group, click Refresh.

This refreshes all sheets in the workbook. If you want to refresh the current sheet only, click the
down arrow on the right-hand side of the Refresh button, and then click Refresh Active Sheet.

In systems with installed products, this featuremay be located on theMain tab.
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You may be prompted to define values before the refresh occurs. If so, these values will be applied to the
report to impact the data refresh.

TIP: You can also use F9 to refresh the entire workbook, and SHIFT+F9 to refresh only the active
sheet.

Applying a Quick Filter to a report
Using the Quick Filter feature, you can apply a temporary filter to a report. This allows you to quickly view
the data at a different level of detail, without needing to alter the report configuration.

For example, you may be viewing an Income Statement report for the entire consolidated organization,
and you want to view the same report at a different level of detail, such as for just North America or just
the South region. You can use the Quick Filter to recalculate the report at the desired level of detail, and
then clear the filter when you are done.

The Quick Filter is combined with your table security filters and any filters that are currently defined in
the report, such as sheet filters and filters defined for Axiom queries.

To apply a Quick Filter to a report:
1. On the Axiom tab, in the File Options group, click Quick Filter.

NOTE: In systems with installed products, this featuremay be located on theMain tab.

2. At the top of the dialog, specify how the filter should be applied:
l Workbook (default): The Quick Filter is applied to all sheets in the workbook.
l Active Sheet: The Quick Filter is only applied to the currently active sheet.

This selection may determine which hierarchies and tables are available in the dialog to build the
filter. See Hierarchy and table availability in the Quick Filter dialog.

3. In theQuick Filter dialog, define a filter using one of the following methods:

l Data Hierarchies: Select the desired hierarchy levels(s) from the hierarchies listed in the
dialog. As you select items in the hierarchy, the corresponding filter is automatically built in
the Filter box.
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For example, you might have a hierarchy named Geography, which has local regions rolling
up into countries, and countries rolling up into world regions. You can select the desired
items that you want to see in the report, such as Europe, Asia, or North America as world
regions. For more information and examples, see Understanding hierarchy-based Quick
Filters.

l Manual Filter: You can manually type a filter into the Filter box using standard filter criteria
statement syntax. Fully qualified Table.Column syntaxmust be used.

l Advanced Filter: Click Advanced Filter to create a filter using any reference table columns
(not just hierarchy columns).

Example Quick Filter dialog

4. Click OK.

If the Quick Filter is applied to the entire workbook, a warning message informs you that the
entire workbook will be refreshed. If you do not want to see this message again in the future,
select Don't show this message again. Click OK to continue.
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If the Quick Filter is applied to the current sheet, that sheet is refreshed and no warning message
appears.

If the file has been configured with GetCurrentValue("QuickFilter") functions, then these functions will
display the currently applied Quick Filter for your reference. If not, you can view the current Quick Filter
by clicking theQuick Filter button again. The current filter displays in the Filter box.

� Clearing the Quick Filter
Once a Quick Filter has been applied to a report, the filter remains applied until one of the following
occurs:

l The file is closed. Quick Filters cannot be saved in the file and are always cleared when the file is
closed.

l A newQuick Filter is applied by using theQuick Filter button and selecting a different filter.
l The Quick Filter is manually cleared. To clear the Quick Filter, click theQuick Filter button again

and then click Clear Filter.

� Hierarchy and table availability in the Quick Filter dialog
The hierarchies and tables shown in the Quick Filter dialog are based on the Axiom queries in the report.
Axiom Enterprise Decision Support looks up the primary tables for the queries, and only shows the
hierarchies and reference tables that are relevant to those primary tables. This is done to help ensure
that the Quick Filter will be applicable to at least one query in the report.

If the filter applies to the entire workbook, then Axiom Enterprise Decision Support looks at the primary
tables for all Axiom queries in the workbook. If the filter applies to the active sheet only, then Axiom
Enterprise Decision Support looks at only the primary tables for the Axiom queries defined on the active
sheet.

NOTE: In the Advanced Filter view, only reference tables are shown unless the primary table has
potentially ambiguous lookup relationships. In that case, the primary data table is also shown so
that the selections can bemade directly on these lookup relationships, to avoid any ambiguity. For
example, if the primary data table has columns PrimaryPhysician and SecondaryPhysician that both
look up to Physician.Physician, then the selection must bemade through the primary data table so
that the correct path to Physician.Physician is used.

If the report uses GetData functions instead of an Axiom query, then all hierarchies and reference tables
are listed in the dialog because Axiom Enterprise Decision Support cannot determine the "primary table"
in this context. In this case, it is possible to define a Quick Filter that does not apply to any GetData
functions in the workbook. If this occurs, the filter will simply have no effect.
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� Understanding hierarchy-based Quick Filters
When you use hierarchies to create a Quick Filter, Axiom Enterprise Decision Support automatically
creates the filter based on your selections. When only one item it selected, the filter is simple—only data
that matches the selected item is included. For example, if you select Asia from a Geography hierarchy,
you will get a filter something like: Dept.WorldRegion='Asia'.

Simple Quick Filter

NOTE: Sometimes when you select a single "child" item underneath a "parent" item, the child and
parent will be joined with AND. For example: DEPT.VP='Jones' AND DEPT.Manager='Smith'.
This means that the DEPT table has other instances ofManager Smith that belong to different VPs,
so the compound statement is to ensure that you only get the data whereManager Smith is under
VP Jones. (You can manually edit the filter to remove the Jones portion of the statement if you want
to see all data for Manager Smith, regardless of VP). If instead Axiom Enterprise Decision Support
constructs the filter as just Dept.Manager='Smith', that means all instances ofManager Smith
are also under VP Jones.
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You can select multiple items in the same hierarchy or from different hierarchies. Items from the same
hierarchy are combined using OR, which means data matching any of the selected items is included.
Items from different hierarchies are combined using AND, which means only data that matches both
selected items is included.

Example 1

In example 1, we have selected two items from the same grouping level in a single hierarchy, so a simple
filter criteria statement is created using IN. The resulting filter will include all data from Asia and Europe.
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Example 2

In example 2, we have selected two items from different grouping levels, but within the same hierarchy.
In this case a compound filter criteria statement is created using OR. The resulting filter will include all
data that belongs to either Italy or US East.
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Example 3

In example 3, we have selected two items from different hierarchies, so a compound filter criteria
statement is created using AND. The resulting filter will include only data that belongs to both US East
and VP David Prince.

Processing a report
If a report is set up to use file processing, you can process the report to automatically perform actions
such as:

l Save snapshot copies of the file and automatically email them to various recipients
l Export data in the file to a CSV or TXT file
l Save data in the file to the database as part of a multipass process
l Collect multiple output files into a single report package
l Process multiple reports in batch
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This topic explains how to process a file that has already been configured for file processing. For details
on how to set up a file for file processing, see the Axiom File Processing Guide.

NOTES:
l The File Processing menu command and the associated task pane are only available to

administrators or to users with the Allow File Processing permission for the current file.
l Other file types can be set up to use file processing, but themost common use is in a report.

To process a file using file processing:
1. Open the file. If you want to see what the file is configured to do during file processing before

executing it, you can check the settings in the File Processing task pane.

2. In the File Processing task pane, in the Actions section, click one of the following options to start
processing:

l Process File: The file is processed once "as is." The file is refreshed and the file processing
action is performed. No multipass filter or settings are applied.

l Process File Multipass: The file is processed multiple times, with a unique filter applied for
each pass. For example, if the file is set up to process by DEPT, then the file is processed
once for each department. The data queries in the file are automatically filtered to return
data for the current pass department only.

TIP: You can also process the file using the File Processingmenu on the Axiom tab. (In
systems with installed products, this featuremay be located on theMain tab.)

Once file processing is initiated, the following occurs:
l The file is refreshed. If you are performing multipass processing, the file is refreshed using a data

filter for the current pass item.
l The file processing action is performed. If you are performing multipass processing, the action

may be performed after each pass, or it may be performed once all passes are complete,
depending on the file processing settings.

A status bar displays the progress of the file processing. When the processing is complete, a confirmation
box displays information about the process, such as howmany passes were performed, howmany files
were created, etc.

Note that the file itself is not saved as part of file processing. You can process a file even if you have read-
only rights to the file. However, if the file processing is set up to save to the database, you must have
rights to save data for that file.

Saving a report
When you save a report, the report file is updated in the Axiom Enterprise Decision Support file system. If
the report is configured to save data to the database, a save-to-database also occurs.

Reporting Guide Axiom Enterprise Decision Support │ 278



To save a report:
l On the Axiom tab, in the File Options group, click Save. (In systems with installed products, this

featuremay be located on theMain tab.)

Your file permission settings in Security determine whether you can save a particular report. If a report is
open with read/write permissions, then you can save it. If the report is open as read-only, then the
report file cannot be saved, but you may still be able to save data. You may also be able to save a copy of
the report.

NOTE: Some files may use a Control Sheet setting that causes the data in the report to zero when the
file is saved. This is a security precaution that is normally enabled in reports only. You can click
Refresh to restore the data.

� Save-to-database reports
Some reports may be configured to save data to the database. If the report is configured to save to the
database, then the file is validated before saving. If errors are found, the file still saves but the data save
is stopped and the errors are displayed in the Save Errors pane. These errors must be corrected before
data can be saved to the database. If no errors are found, then a confirmation message displays, with
information about the number of records saved.

Your file permission settings in Security determine whether you can perform a save-to-database for a
particular report. Note that the permission to save data is managed separately from the file access
permission. Therefore, it is possible that you could have read-only permissions for the file, but still have
rights to save data (or the opposite—you could have read/write permissions for the file, but not have the
rights to save data).

When you click Save, Axiom Enterprise Decision Support automatically performs all save actions that
your user rights allow and that the file is configured to perform. If desired, you can use the additional
save options to only save the file, or to only save data.

To save only the file:
l In the Axiom tab, in the File Options group, click the down arrow to the right of the Save button,

and then click Save File Only.

The plan file is saved. All save-to-database processes are ignored.

To save only the data:
l In the Axiom tab, in the File Options group, click the down arrow to the right of the Save button,

and then click Save Data Only.

Data from the file is saved to the database. The file itself is not saved.

NOTE: In systems with installed products, the additional save options may be located on theMain
tab. In all systems, you can also access these options by right-clicking the file tab.
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� Saving a copy of a report
You can save a copy of a report using Save As features. You might want to save a copy of a report to use
as a starting point to create a new report, or to create an archive copy beforemaking changes to the
report.

In most cases, you should save the report to the Axiom Enterprise Decision Support file system (in the
Reports Library). However, it is possible to save report files outside of the Axiom Enterprise Decision
Support system (as non-managed files). Non-managed files have limited functionality, and are not
covered by Axiom Enterprise Decision Support security or included in system processes.

To save a copy of a report to the Reports Library:
1. On the Axiom tab, in the File Options group, click the down arrow to the right of the Save button,

and then click Save As (Repository).

TIP: The Save As options are also available by right-clicking the file tab.

The Save As dialog opens, displaying the contents of the Reports Library.

NOTE: By default this dialog only displays files with the same file extension as the current file. If
you want to view all file types when using this dialog, select View > Show All Files. This setting
will be remembered.

2. In the left-hand side of the dialog, navigate to the folder in the Reports Library where you want to
save the file.

You must have read/write permissions to a folder in order to save a copy of the report there. A
lock icon displays next to folders where you do not have read/write permissions to any folder in
that folder tree.

3. In the File name box, type a name for the new report.

4. Optional. In theDescription box, type a description for the report.

5. Click OK.

To save a copy of a report locally (as a non-managed file):
1. On the Axiom tab, in the File Options group, click the down arrow to the right of the Save button,

and then click Save As (Local File).

TIP: The Save As options are also available by right-clicking the file tab.

The Save As dialog opens.

2. Navigate to the desired location on your local computer or on a network file share, and then click
Save.
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You can change the name of the file and its file format when saving. In the Excel Client, you can
save the file using any file format that your Excel version supports. In theWindows Client, you can
save the file as XLSM, XLSX, or XLS.

Working with Physician Analysis reports
Physician Analysis reports evaluate the dimensions and measures at the encounter level across the
organization with a focus on the Insurance Plan, Payor, and Financial Class dimensions. In many cases,
these reports include the Inpatient, Outpatient, and Professional Billing patients. In some cases,
however, some reports are limited to Inpatients due to the different measures available for these
encounters, e.g., Average Length of Stay (ALOS).

The Physician Analysis reports valuate patient information in a variety of ways. The following are a few
examples:

l Evaluate the physician variation in treatment patterns based on the day of stay for inpatients.
l Evaluate the utilization, total, and per-case revenues and costs at the department and the cost

item level for the top physicians within a Service Line.

NOTE: Service Lines are used to limit the encounters into homogenous patient groups where
physician comparisons aremeaningful. Comparing dissimilar patients by physician has very limited
value.

Like nearly every Axiom Enterprise Decision Support report, you can use either the Admit or Discharge
dates in the Physician Analysis reports to select the patient population to analyze. Additionally, you can
use either the Estimated Payments or Actual Payments when evaluating the net patient revenue and the
resulting margin.

These Physician Analysis reports are provided as examples of what is possible or as starter report
templates that you can copy and modify for physician analysis.

The following table describes the types of Physician Analysis reports available in the Desktop Client
version of Axiom Enterprise Decision Support::

Report Description

Key Performer Inpatient Period Comparison
report

Provides a high-level inpatient period
comparison volume activity and analysis of
margin performance

Physician Utilization Detail report Provides a comprehensive view of the providers’
utilization of department services for a selected
Service Line

Utilization by Day-of-Stay report Shows a day-of-stay utilization and costs for top
physicians in a select Service Line
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Key Performer Inpatient Period Comparison report
This report provides a high-level inpatient period comparison of volume activity and an analysis of
margin performance. It includes flexible Group By options for evaluating inpatient utilization and financial
performance for key performers such as physicians, DRGs, payors, or service lines.

This period comparison report evaluates key performers (either top or bottom) for inpatient cases, days,
ALOS, and summary financial measures. This is a highly flexible report that enables you to select a
dimension from the Fields table to use as a Primary Group By for row definition and sort by cases,
patient days, gross patient revenue, net patient revenue, or direct expenses on the Primary Group By.

� Opening the report
In the DSS Reporting task pane, in the Physician Analysis Reports section, double-click Key Performer
Inpatient Period Comparison.

� Refresh variables
The following table describes the variables you can configure for this report:

Option Description

Admit or Discharge Date Select whether to populate the report based on
encounter admit or discharge date.

Actual or Estimated Net Revenue Select whether to show estimated or actual net
revenue.

Group By The column to use as summarization level for
each row, often Service Line, Provider, etc.

Sort By Select which column in the report by which to
sort the rows (results always in Descending
order).

Top or Bottom Select to display either the top or bottom range
of report data.

Limit to Top Number of Physicians Select the number of report rows of data to
display.

Current Calendar Year The year for the current period of this report.

Current Starting Month Themonth the begin analysis for the prior year
time frame.

Prior Calendar Year The year for the prior period of this report.

Prior Year Starting Month Themonth to begin analysis for the prior year
time frame.
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Option Description

Number ofMonths to Compare The number ofmonths to compare between the
two time frames.

Limited Encounters (optional) Select the encounters in which to include in the
report by using the Filter Wizard.

� Report options
The following table describes the options available for this report:

Option Description

Group by Options (rows) l Primary Group By – controlled by the Fields
Table

l Sort By – Cases, Patient Days, Gross Patient
Revenue, Actual Patient Revenue, Direct
Expense of the Current Year

Measure Options l Discharge or Admit
l Actual or Estimate Net Revenue

Views l Variances – shows variance for each set of
measures, the default view

l Current Year Only – shows only current year
measures

l All – Shows current year, prior year and
variance

Quick Filtering Yes – Select from Folders or Tables

Drills No

Printable Yes

Primary Source Table Encounter

Design Notes Report based on a multiple nested AQ
architecture

� Report example
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Physician Utilization Detail report
This report provides a comprehensive view of the providers’ utilization of department services for a
selected Service Line. It displays the utilization of the top (highest) cost providers by department for a
select Service Line. Costs are reported in total and per case for the provider, with drill-down ability to the
department cost-item detail.

The columns represented on this report include Cases, Total Costs, and Cost Per Case for each provider.
You can report on the top 5, 10, 15, 20, or 25 providers (admitting or attending), and you can evaluate
utilization mix within a Service Line patient population, providing a view of the provider’s department
costs and utilization (volumes).

� Opening the report
In the DSS Reporting task pane, in the Physician Analysis Reports section, double-click Physician
Utilization Detail.

� Refresh variables
The following table describes the variables you can configure for this report:

Option Description

Select Type of Provider Select the provider type.

Select Patient Type Select the patient type.

Select Entity and Entities Select one or more entities.

Select Discharges From The starting year/month.

Select Discharges To The ending year/month.

Select Service Line Filter Select the service line to filter by.

Select Filter For Select the value to include in the filter for the service line.

Limit to Top Number of
Physicians

Select the number of report rows of data to display.

Select Department Sort Sort the departments by Number, Name, or Total Cost.

Select Cost Item Sort Sort the cost items by Number, Name, or Total Cost.

Limit Encounters (optional) Select the encounters in which to include in the report by using the
Filter Wizard.

� Report options
The following table describes the options available for this report:
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Option Description

Group by Options (rows) l Admitting or Attending
l Service Line
l Entity

Measure Options Months to aggregate data to specific months, quarters and years in
Fiscal and Calendar Years depending on the selection

Views l All
l Summary
l Cost Detail

Quick Filtering Yes – From the iDimensions, Costing, or DSS folder

Drills No

Printable Yes

Primary Source Table Encounter

Design Notes Report uses a combination of Axiom Queries and GetData
architecture

� Report example

Utilization by Day of Stay report
This report shows the day-of-stay utilization and costs for top physicians in a select Service Line. It
presents the total cost and per-case cost day-of-stay for top (high cost) providers for a select Service Line.

You can view this report at the summary day-of-stay or with department detail for each day-of-stay.

You can use this report to evaluate the utilization mix within a patient population, providing for each
day-of-stay among the top (high cost) physicians. The department detail at the cost-item level provides
full detail of utilization across the top cost physicians for the selected service lines.
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� Opening the report
In the DSS Reporting task pane, in the Physician Analysis Reports section, double-click Utilization by
Day of Stay.

� Refresh variables
The following table describes the variables you can configure for this report:

Option Description

Select Provider Type Select the provider type.

Select Entity and Entities Select one or more entities.

Select Service Line Filter Select the service line to filter by.

Select Filter For Select the value to include in the filter for the
service line.

Limit to Top Number of Physicians Select the number of report rows of data to
display.

Select Discharges From The starting year/month.

Select Discharges To The ending year/month.

Limit to Top Number of Physicians Select the number of report rows of data to
display.

Select Department Sort Sort the departments by Number, Name, or
Total Cost.

Limit Encounters (optional) Select the encounters in which to include in the
report by using the Filter Wizard.

� Report options
The following table describes the options available for this report:

Option Description

Group by Options (rows) Provider Type, Service Line Group, and Entity

Measure Options Months to aggregate data to specific months,
quarters and years in Fiscal and Calendar Years
depending on the selection

Views Summary, Department Detail, or All

Quick Filtering Yes from the !Dimensions, DSS, or Costing folder

Drills No
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Option Description

Printable Yes

Primary Source Table Encounter

Design Notes Report uses a combination of Axiom Queries
and GetData architecture.

Working with Patient Analysis reports
Patient Analysis reports evaluate the dimensions and measures at the encounter level across the
organization. In many cases, these reports include the Inpatient, Outpatient, and Professional Billing
patients. In some cases, however, some reports are limited to Inpatients due to the different measures
available for these encounters, e.g., Average Length of Stay (ALOS.)

The Patient Analysis reports evaluate patient information in a variety of ways. The following are a few
examples:

l Compare the patient volumes, revenues costs, and margins across two different time periods,
e.g., quarter to quarter or year to year.

l Evaluate the total and per-case revenues, costs (down to the Cost Category level), and margins for
a particular time frame across a defined patient population.

l Develop a trend of patient activity and financial performance by entity and patient type.

TIP: Trend reports allow you to see data anomalies and to understand patient performance
over time. An easy way to create a trend is to use a date field as a row or you can group by
refresh variable. Make the date dimension the last variable defined to create an easy-to-
analyze trend report. This type of reporting is not appropriate for a prior-period comparison
report as the encounter will only fall within one period.

l Evaluate the patient population across one, two, or three dimensions at the encounter level.
l Use any dimension or attribute on the encounter level to group patients together for performance

analysis.

NOTE: If a dimension or attribute is unexpectedly missing from a variable pick list, determine if that
field has been appropriately added to the DSSBreakFields table.

Like nearly every Axiom Enterprise Decision Support report, you can use either the admit or discharge
dates in the Patient Analysis reports to select the patient population to analyze. Additionally, you can
use either the estimated payments or actual payments when evaluating the net patient revenue and the
resulting margin.
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TIP: TheMargin Analysis report may be themost useful Patient Analysis report to use as a template
due to its flexibility and the key measures contained therein.

The following table describes the types of Patient Analysis reports available in the Desktop Client version
of Axiom Enterprise Decision Support::

Report Description

Encounter
Viewer

Provides a view of the entire data set for the patient's encounters, including service
line and population assignment groups, diagnosis and procedure codes, providers,
payments and cost details, payors, surgeries, and clinical details

Cost Category
Expense
Analysis
report

Provides a period comparison margin analysis with a focus on expenses at the Cost
Category level

Inpatient
Period
Comparison
Analysis
report

Provides a high-level inpatient period comparison margin analysis with flexible
Group By options for evaluating changes in inpatient utilization, averages, and
financial performance

Inpatient
Summary
Analysis
report

Provides an analysis of inpatient period comparison margin with statistics and
payor mix at the financial-class level

Margin
Analysis
report

Provides a summary of financial information for inpatient, outpatient, and
combined with two subtotals

Cost Category Expense Analysis report
This report provides a period comparison margin analysis with a focus on expenses at the Cost Category
level. This report is for viewing inpatient, outpatient, and in total data. The report includes absolute
measures as well as per-case or per-encounter data.

Themain purpose of this period comparison report is to evaluate inpatient, outpatient, and combined
changes in volumes, summary financial measures, and per-case/encounter analysis. You can use this
report to evaluate those changes across a variety of time frames for a selected encounter population,
e.g., an entity using a Report Filter.

� Opening the report
In the DSS Reporting task pane, in the Physician Analysis Reports section, double-click Cost Category
Expense Analysis.
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� Refresh variables
The following table describes the variables you can configure for this report:

Option Description

Entity (optional) Select the entities to include in the report.

Admit or Discharge Date Select whether to populate the report based on
encounter admit or discharge date.

Actual or Estimated Net Revenue Select whether to show estimated or actual net
revenue.

Current From The starting year/month of the current period.

Current To The ending year/month of the current period.

Prior From The starting year/month of the comparison
period.

Prior From The starting year/month of the comparison
period.

Prior To The ending year/month of the comparison
period.

� Report options
The following table describes the options available for this report:

Option Description

Group by Options (rows) None – fixed report structure with different
views

Measure Options Actual or Estimated Revenue

Views l Summary – Shows expenses using the
Report Group for Cost Categories

l Detail – Shows expenses at the Cost Category
level

l All – Displays both the Report Group and the
Cost Categories for expenses

Quick Filtering No – the Report Filter is available directly in the
Report

Drills No

Printable Yes

Primary Source Table Encounter
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Option Description

Design Notes Report based on a GETDATA architecture using
nested AQs against the COSTCAT Table for row
definitions

� Report example

Inpatient Period Comparison report
This report is a high-level inpatient period comparison margin analysis with flexible Group By options for
evaluating changes in inpatient utilization, averages, and financial performance.

This period comparison report evaluates inpatient changes in cases, days, ALOS, and summary financial
measures. This highly flexible report enables you to select from a variety of dimensions from the Fields
table to use as a primary and secondary Group By for row definition and sub-total on the Primary Group
By.

Reporting Guide Axiom Enterprise Decision Support │ 290



� Opening the report
In the DSS Reporting task pane, in the Physician Analysis Reports section, double-click Inpatient Period
Comparison.

� Refresh variables
The Inpatient Period Comparison report allows you to select how to group the data on each row. There is
a Primary Group By variable and a Secondary Group By variable. These variables are controlled by the
data populated for the Encounter.

The following table describes the variables you can configure for this report:

Option Description

Admit or Discharge Date Select whether to populate the report based on
encounter admit or discharge date.

Actual or Estimated Net Revenue Determines whether to show estimated or
actual net revenue.

Current Calendar Year The year for the current period of this report.

Current Starting Month Themonth to begin analysis for the current year
time frame.

Prior Calendar Year The year for the prior period of this report.

Prior Starting Month Themonth to begin analysis for the prior year
time frame.

Number ofMonths to Compare The number ofmonths to compare between the
two time frames.

Select Primary Group By The column to use as header for each row, often
Service Line, Provider, etc.

Select Secondary Group By The column to use as sub-header for each row,
often Service Line, Provider, etc.

Limit Encounters (optional) Select the encounters in which to include in the
report by using the Filter Wizard.

� Report options
The following table describes the options available for this report:
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Option Description

Group by Options (rows) l Primary Group By – Controlled by the Fields
table

l Secondary Group By – Controlled by the
Fields table.

Measure Options l Discharge or Admit
l Actual or Estimate Net Revenue

Views l Variances – Shows variance for each set of
measures, the default view

l Current Year Only – Shows only current year
measures

l All – Shows current year, prior year and
variance

Quick Filtering Yes – Select from Folders or Tables

Drills No

Printable Yes

Primary Source Table Encounter

Design Notes This report is based on a multiple nested AQ
architecture

� Report example
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Inpatient Summary Analysis report
This report analyses inpatient period comparison margin with statistics and payor mix at the financial-
class level. This period comparison report evaluates inpatient trends in the following areas:

l Volumes
l Days
l ALOS
l Summary financial measures, such as net patient revenue
l Direct margin and net margin
l Financial performance indicators
l Payor mix

By using this report, you can evaluate those trends across a variety of time frames and dimensions, e.g.,
entity, using the Quick Filter. The current period is trended on a monthly basis and the comparison to
the compare period is in total.

� Opening the report
In the DSS Reporting task pane, in the Physician Analysis Reports section, double-click Inpatient
Summary Analysis.

� Refresh variables
The following table describes the variables you can configure for this report:

Option Description

Admit or Discharge Date Select whether to populate the report based on
encounter admit or discharge date.

Actual or Estimated Net Revenue Determines whether to show estimated or
actual net revenue.

Current Calendar Year The year for the current period of this report.

Current Starting Month Themonth to begin analysis for the current year
time frame.

Compare Calendar Year The year to compare to the current year.

Compare Starting Month Themonth to compare to the current starting
month.

Number ofMonths to Compare The number ofmonths to compare between the
two time frames.

Limit Encounters (optional) Select the encounters in which to include in the
report by using the Filter Wizard.
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� Report options
The following table describes the options available for this report:

Option Description

Group by Options (rows) None – fixed report structure

Measure Options l Admit or Discharge
l Actual or Estimated Revenue
l Months to trend for the current period via

Refresh Variables and Views

Views l Default – hides empty columns
l All – displays empty columns

Quick Filtering Yes

Drills No

Printable Yes

Primary Source Table Encounter

Design Notes Report based on a GETDATA architecture

� Report example
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Margin Analysis report
This highly flexible and widely used report of inpatient and outpatient financial information that allows
you to select the Group By or rows in the report. It provides summary financial information for inpatient,
outpatient, and combined with two subtotals that you can control.

The columns on this report include the following:

l Cases
l Days
l ALOS
l Patient Revenue
l Actual Net Revenue
l Percent of Charges
l Variable Direct Expense
l Variable Direct Margin
l Fixed Direct Expense
l Direct Margin
l Indirect Expense
l Net Margin.

Net Revenue Per Case, Direct Margin Per Case, and Net Margin Per Case are included as metrics by each
Service Line. This report enables you to evaluate those trends across a variety of time frames and
dimensions, e.g., entity using the Quick Filter.

� Opening the report
In the DSS Reporting task pane, in the Physician Analysis Reports section, double-clickMargin Analysis.

� Refresh variables
The following table describes the variables you can configure for this report:

Option Description

Admit or Discharge Date Select whether to populate the report based on
encounter admit or discharge date.

Actual or Estimated Net Revenue Determines whether to show estimated or
actual net revenue.

Select Current From The starting year/month of the current period.

Select Current To The ending year/month of the current period.

Select Primary Group By The column to use as header for each row.
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Option Description

Limit Encounters (optional) Select the encounters in which to include in the
report by using the Filter Wizard.

� Report options
The following table describes the options available for this report:

Option Description

Group by Options (rows) Dimensions from the Fields table (!Dimensions)

Measure Options l Actual or Estimated Revenue
l Months to aggregate data to specific

months, quarters and years in Fiscal and
Calendar Years depending on the selection

Views l Inpatient
l Outpatient
l Combined

Quick Filtering Yes

Drills Yes

Printable No

Primary Source Table Yes

Design Notes Reports uses a combination of Axiom Queries
and GetData architecture

� Report example

Working with Payor Analysis reports
Payor Analysis reports evaluate the dimensions and measures at the encounter level across the
organization with a focus on the Insurance Plan, Payor, and Financial Class dimensions. In many cases,
these reports the Inpatient, Outpatient, and Professional Billing patients. In some cases, however, some
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reports are limited to Inpatients due to the different measures available for these encounters, e.g.,
Average Length of Stay (ALOS).

The Payor Analysis reports evaluate patient information in a variety of ways. The following are a few
examples:

l Evaluate the payor mix and financial performance of the patient population for selected time
periods, e.g. Medicare versus Medicaid, etc.

l Evaluate the total and per case revenues, costs and margins for a particular time frame across
financial classes with the ability to see the Payors associated with the Financial Class

Like nearly every Axiom Enterprise Decision Support report, you can use either the Admit or Discharge
dates in the Payor Analysis reports to select the patient population to analyze. Additionally, you can use
either the Estimated Payments or Actual Payments when evaluating the net patient revenue and the
resulting margin.

These Payor Analysis reports are provided as examples of what is possible or as starter report templates
that you can copy and modify for payor analysis.

The following table describes the types of Patient Analysis reports available in the Desktop Client version
of Axiom Enterprise Decision Support::

Report Description

Insurance Plan Inpatient
Analysis and Graph report

A combination report that includes a graph
in a separate worksheet that shows
inpatient data by payor, displaying volume
and key financial metrics information.

Payor Analysis report Evaluates the dimensions and measures at
the encounter level across the organization
with a focus on the Insurance Plan, Payor,
and Financial Class dimensions.

Insurance Plan Inpatient
Analysis and Graph report

Evaluate the total and per case revenues,
costs, and margins for a particular time
frame across financial classes with the
ability to see the Payors associated with
the Financial Class.

Insurance Plan Inpatient Analysis and Graph report
This is a combination report that includes a graph in a separate worksheet that shows inpatient data by
payor, displaying volume and key financial metrics information.
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The purpose of this report is to provide financial information such as payor mix and insurance plan
performance for inpatients by payor. The first visual represents the selected financial class or payor
activity based on the selected sort measure. The second visual provides a chart of the net patient
revenue per case for the selected payor.

This visual analysis report allows you to evaluate themix and net patient revenue per case of a selected
financial class and payor across a variety of time frames and dimensions, e.g., entity, using the Quick
Filter. The View by Payor allows you to examine trends within a service line across insurance providers.

� Opening the report
In the DSS Reporting task pane, in the Payor Analysis Reports section, double-click Insurance Plan
Inpatient Analysis and Graph.

� Refresh variables
The following table describes the variables you can configure for this report:

Option Description

Select Financial Class or Payor Select which level of payor for the report.

Select a Payor or Select Financial Class Select the payors or financial class to include in
the report.

Admit or Discharge Date Select whether to populate the report based on
encounter admit or discharge date.

Actual or Estimated Net Revenue Select whether to show estimated or actual net
revenue.

Current From The starting year/month of the current period.

Current To The ending year/month of the current period.

Sort By Select which column in the report in which to
sort the rows.

Limited Encounters (optional) Select the encounters in which to include in the
report by using the Filter Wizard.

� Report options
The following table describes the options available for this report:
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Option Description

Group by Options (rows) Choose from the following: Cases, Patient Days,
ALOS, Gross Patient Revenue, Net Patient
Revenue, Direct Expense, Direct Margin, Indirect
Expense, and Net Margin

Measure Options l Actual or Estimated Revenue
l Months to aggregate data to specific

months, quarters and years in Fiscal and
Calendar Years depending on the selection
(see Refresh Variables)

Views One Default View

Quick Filtering Yes – Select from Folders or Tables (i.e., Entity,
Service Line, MSDRG)

Drills No

Printable Yes

Primary Source Table Encounter

Design Notes Report uses a combination of Axiom Queries
and GetData architecture

Reporting Guide Axiom Enterprise Decision Support │ 299



� Report example

Payor Analysis report
This report evaluates the dimensions and measures at the encounter level across the organization with a
focus on the Insurance Plan, Payor, and Financial Class dimensions.

� Opening the report
In the DSS Reporting task pane, in the Payor Analysis Reports section, double-click Payor Analysis.

� Refresh variables
The following table describes the variables you can configure for this report:
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Option Description

Admit or Discharge Date Select whether to populate the report based on
encounter admit or discharge date.

Insurance Plan Group Select from payor description or financial class.

Current From The starting year/month of the current period.

Current To The ending year/month of the current period.

Prior From The starting year/month of the comparison
period.

Prior To The starting year/month of the comparison
period.

Encounter.ServiceLine1 The Service Line filer for the report.

Sort By Select which column in the report in which to
sort the rows.

Limited Encounters (optional) Select the encounters in which to include in the
report by using the Filter Wizard.

� Report example

Payor Analysis by Insurance Plan report
This report evaluates the total and per case revenues, costs, and margins for a particular time frame
across financial classes with the ability to see the Payors associated with the Financial Class.
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� Opening the report
In the DSS Reporting task pane, in the Payor Analysis Reports section, double-click Payor Analysis by
Insurance Plan.

� Refresh variables
The following table describes the variables you can configure for this report:

Option Description

Select Payor Description Select a payor description.

Admit or Discharge Date Select whether to populate the report based on
encounter admit or discharge date.

Current From The starting year/month of the current period.

Current To The ending year/month of the current period.

Sort By Select which column in the report in which to
sort the rows.

Limited Encounters (optional) Select the encounters in which to include in the
report by using the Filter Wizard.
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� Report example

Working with Population Analysis reports
Population Analysis reports evaluate certain dimensions and measures at both the encounter and cost
detail levels across the organization. Population Analysis reports focus on grouping patient in such a way
as to make comparisons across time or physicians meaningful, e.g., populations within a particular
entity, service line, etc. In many cases, these reports include the Inpatient, Outpatient, and Professional
Billing patients. However, there is a Professional Billing specific report that enables one to evaluate the
financial performance including net margin at the Cost Detail level. This report is designed for clients that
havemedical group or physician practice encounter information. In some cases, reports use a view to
limit the population to only Inpatients due to the different measures available for these encounters, e.g.,
Average Length of Stay (ALOS).
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The Population Analysis reports evaluate patient information in a variety of ways. The following are a few
examples:

The Population Analysis reports evaluate patient information in a variety of ways. The following are a few
examples:

l Compare two time period in order to understand the changes between a current period and a
prior period for trending purposes for cases, patient days, ALSO, payer mix, etc.

l Evaluate the Department and Cost Detail Utilization for a defined Patient Population
l Evaluate the performance of Professional Services at the CPT level within the Cost Detail table

where charges, costs and payments have been applied

Like nearly every Axiom Enterprise Decision Support report, you can use either the Admit or Discharge
dates in the Population Analysis reports to select the patient population to analyze. Additionally, you can
use either the Estimated Payments or Actual Payments when evaluating the net patient revenue and the
resulting margin. These reports also leverage the newAdvanced Filtering capabilities to isolate the
population desired using limit filters across other encounter related tables, such as Encounter
Procedures or Encounter Diagnosis.

These Population Analysis reports are provided as examples of what is possible or as starter report
templates that you can copy and modify to meet your unique needs. The Population Trends analysis is a
good example of using a multi-worksheet reporting approach. The Department Summary and Detail
reports are examples of returning Cost Category detailed information at the Department and Cost Detail
levels. As previously mentioned, the Professional Utilization Department Analysis is a good template for
those set up for and needing margin results at the CPT level within Cost Detail.

The following table describes the types of Population Analysis reports available in the Desktop Client
version of Axiom Enterprise Decision Support::

Report Description

Population Trends report Provides a more detailed view of a patient
population’s volumes and financial information
in a multi-worksheet styled report

Population Utilization Department Detail report Provides a more comprehensive view of
providers’ utilization of department services for
a selected Service Line at the Cost Item level

Population Utilization Department Summary
report

Provides an analysis of the utilization of a
population by Department

Professional Utilization Department Analysis
report

Provides an analysis of the utilization of a
population by Department, Provider, and Cost
Item with the ability to reflect the actual margin
at the Department and CPT level.
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Population Trends report
This report provides a more detailed view of a patient population’s volumes and financial information. It
is an example of a multi-tab or worksheet report. Each worksheet contains specific information about the
population selected. This report provides volume and financial information for selected patient
populations by displaying IP Trends, OP Trends, Payor Mix, and the top-N Admitting Physicians.

The IP columns represented on this report are the following:

l Cases
l ALOS
l Patient Days
l Charges
l Net Revenue (Actual or Estimated)
l Direct Expense
l Indirect Expense
l Net Margin

The OP columns displayed on this report are the following:

l Encounters
l Charges
l Net Revenue (Actual or Estimated)
l Direct Expense
l Direct Margin
l Indirect Expense
l Net Margin

The Payor Mix tab displays the following:

l Encounters
l Total Patient Charges
l Payor Mix
l Actual or Estimated Net Patient Revenue.

This report enables you to evaluate those trends across a variety of time frames and dimensions, e.g.,
entity using the Quick Filter.

� Opening the report
In the DSS Reporting task pane, in the Population Analysis Reports section, double-click Population
Trends.
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� Refresh variables
The following table describes the variables you can configure for this report:

Option Description

Report Filter Group Select the column from the Encounter table to
filter the report

Report Filter Select the element in the Encounter column to
filter the entire report data

Select Trend Detail Select the row detail for the IP Trend and OP
Trend worksheets

Admit or Discharge Date Select whether to populate the report based on
encounter admit or discharge date

Net Revenue Type Select whether to show estimated or actual net
revenue

Current Calendar Year Select the year for the current period of this
report

Current Starting Month Select themonth to begin analysis for the
current year time frame

Prior Calendar Year Select the year for the prior period of this report

Prior Starting Month Select themonth to begin analysis for the prior
year time frame

Number ofMonths to Compare Select the number ofmonths to compare
between the two time frames

Limit to Top Number of Physicians Select the number of report rows of data to
display

Cost Categories to Show (IP and OP Trends) Select the Cost Categories to include in the
report

Limit Encounters (optional) Select the encounters in which to include in the
report by using the Filter Wizard.

� Report options
The following table describes the options available for this report:
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Option Description

Group by Options (rows) l Service Line 1, Service Line 2, or Service Line
3. You can specify the name.

l Trend Detail – Options include but are not
limited to Insurance Plan, Service Line,
DischargeMonth, Diagnosis, Procedure,
Attending Provider, and Admitting Provider
(See the Fields table for more information on
available sorts)

Measure Options l Actual or Estimated Revenue
l Months to aggregate data to specific

months, quarters, and years in Fiscal and
Calendar Years depending on the selection

Views l IP Trends – Summary, Cost Category Per
Case, or All

l OP Trends – Summary, Cost Category Per
Case, or All

l Payor Mix – Financial Class, Payors, Financial
Class Key Indicators, Payor Key Indicators, or
All

l Admitting Physicians – Summary, Cost
Category Per Case, or All

Quick Filtering Yes

Drills No

Printable Yes

Primary Source Table Encounter

Design Notes Report uses combined GetData and Axiom
Architecture
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� Report examples

Inpatient trends

Outpatient trends
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Payor mix analysis

Admitting physician inpatient Analysis

Population Utilization Department Detail report
This report provides a more comprehensive view of providers’ utilization of department services for a
selected Service Line at the Cost Item Level. The purpose of report is to analyze the utilization of a
population by Department, Provider, and Cost Item.

There aremultiple views available for this report within two groups:

l Display Total Patient Revenue, Total Expense, Direct Expense and Indirect Expense
l Display by Cost Category Detail

This report provides the ability to see totals by Department, by Provider and down to the Cost Item
level. The Provider is based on the Provider stored in the Cost Detail table – it is not pulling information
from the Encounter Provider or Encounter tables.
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This report enables you to evaluate utilization mix within a patient population, providing a view of the
patient’s charges and volumes by department. The additional view by Cost Category allows you to
analyze themix of expenses by department across the selected patient population.

� Opening the report
In the DSS Reporting task pane, in the Population Analysis Reports section, double-click Population
Utilization Department Detail.

� Refresh variables
The following table describes the variables you can configure for this report:

Option Description

Report Filter Group Select the column from the Encounter table to
filter the report.

Report Filter Select the element in the Encounter column to
filter the entire report data.

Select Trend Detail Select the row detail for the IP Trend and OP
Trend worksheets.

Admit or Discharge Date Select whether to populate the report based on
encounter admit or discharge date.

Net Revenue Type Select whether to show estimated or actual net
revenue.

Current Calendar Year Select the year for the current period of this
report.

Current Starting Month Select themonth to begin analysis for the
current year time frame.

Prior Calendar Year Select the year for the prior period of this report.

Prior Starting Month Select themonth to begin analysis for the prior
year time frame.

Number ofMonths to Compare Select the number ofmonths to compare
between the two time frames.

Limit to Top Number of Physicians Select the number of report rows of data to
display.

Cost Categories to Show (IP and OP Trends) Select the Cost Categories to include in the
report.

Limit Encounters (optional) Select the encounters in which to include in the
report by using the Filter Wizard.
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� Report options
The following table describes the options available for this report:

Option Description

Report Filter Group Select the column from the Encounter table to
filter the report

Report Filter Select the element in the Encounter column to
filter the entire report data

Group by Options (rows) l Admit or Discharge
l Service Line
l Entity

Measure Options Months to aggregate data to specific months,
quarters and years in Fiscal and Calendar Years,
depending on the selection

Views Department Totals, Provider Totals, Cost Item
Detail, Department Totals by Cost Category,
Provider Totals by Cost Category, Cost Item
Detail by Cost Category, All

Quick Filtering Yes – From the !Dimensions, Costing, or DSS
folder

Drills No

Printable Yes

Primary Source Table Encounter

Design Notes Uses a combination of Axiom Queries and
GetData architecture
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� Report example

Population Utilization Department Summary report
The purpose of report is to analyze utilization at the department level of a specific patient population.

There are two views available for this report:

l Display Total Patient Revenue, Total Expense, Direct Expense, and Indirect Expense
l Display by Cost Category

This report enables you to evaluate utilization mix within a patient population providing a view of the
patient’s charges and volumes by department. The additional view by Cost Category allows you to
analyze themix of expenses by department across the selected patient population.

� Opening the report
In the DSS Reporting task pane, in the Population Analysis Reports section, double-click Population
Utilization Department Summary.

� Refresh variables
The following table describes the variables you can configure for this report:

Option Description

Report Filter Group Select the column from the Encounter table to
filter the report.
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Option Description

Report Filter Select the element in the Encounter column to
filter the entire report data.

Select Entity Select one or more Entities to display in the
report.

Admit or Discharge Date Select whether to populate the report based on
encounter admit or discharge date.

Current From The year and month to begin the Admit or
Discharge period of this report.

Current To The year and month to end the Admit or
Discharge period of this report.

Limit Encounters (optional) Select the encounters in which to include in the
report by using the Filter Wizard.

� Report options
The following table describes the options available for this report:

Option Description

Group by Options (rows) Service Line 1, Service Line 2, or Service Line 3.
You can specify the names.

Measure Options Months to aggregate data to specific months,
quarters, and years in Fiscal and Calendar years,
depending on the selection.

Views l Department Summary – Total Patient
Revenue, Total Expense, Direct Expense, and
Indirect Expense

l Departments by Cost Category
l All

Quick Filtering Yes – From the !Dimensions, Costing, or DSS
folder

Drills No

Printable Yes

Primary Source Table Encounter

Design Notes Uses a combination of Axiom Queries and
GetData architecture
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� Report example

Professional Utilization Department Analysis report
The Professional Utilization Department Utilization Analysis report analyzes the utilization of a
population by Department, Provider, and Cost Item. This is a unique report as it is designed to evaluate
performance at the CPT or Cost Item level to includemargin analysis. In order to use this report, users
will need to ensure that payments have been applied to the Cost Item or CPT level. This is generally done
and only possible with Professional Billing claims were payments are associated to the line item rather
than the claim level.

NOTE: If you have Professional Billing information in your system and are not set up to apply actual
payments or expected payments at the CPT or Cost Item level, please contact you Implementation
Consultant or Client Success for additional assistance.

� Opening the report
In the DSS Reporting task pane, in the Population Analysis Reports section, double-click Population
Utilization Department Analysis.

� Refresh variables
The following table describes the variables you can configure for this report:
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Option Description

Report Filter Group The column from the Encounter table to filter
the report.

Report Filter The element in the Encounter column to filter
the entire report data.

Select Entity Select the entity to display in the report.

Select Payment Option Select Actual or Estimated to determine what
values to use for net patient revenue and the
resulting margin to be calculated in the report.

Select Date Option Select the date to use to determine whether to
populate the report based on encounter admit
or discharge date.

Load Detail Determine if a Department summary is desired
or the Cost Detail is to be used in the report

Current From The Year and Month to begin the Admit or
Discharge period of this report.

Current To The Year and Month to end the Admit or
Discharge period of this report.

Limit Encounters To remove a limit encounters filter, on the
Report sheet, simply double-click the Limit
Encounters filter, and then click Apply.

� Report options
To select a different view, in theMain ribbon tab, click Change View, and select one of the following:

l Department Summary
l Departments by Cost Category

Working with Service Line Analysis reports
Service line analytics and reporting are instrumental in evaluating health service operations. The
extremely wide and varied nature of health conditions and treatment methods makes service lines a
valuable way of classifying the patients served by provider organizations into quasi-homogenous
populations. These service line classifications creating quasi-homogenous populations are vital to
comparative report across multiple dimensions, such as:

l Comparing services offered across multiple care settings or multiple hospitals
l Comparing physician performance using risk adjusted service lines
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l Comparing alternative treatment plans for quality and patient outcomes
l Comparing insurance plans or payers relative to the services rendered and reimbursed by service

line provides a means of normalization for comparative purposes

The following table describes the types of Service Line Analysis reports available in the Desktop Client
version of Axiom Enterprise Decision Support:

Report Description

Service Line Inpatient Period
Comparison report

Trend performance for a selected service line across two
different time periods. It is a flexible report that enables
you to determine the current and prior periods and how
many monthly periods to include within the report.

Service LineMargin Analysis report Evaluate performance across service lines by Inpatient,
Outpatient or Combined. It is a report that provides an
Inpatient, Outpatient or Combined View and also has
totals and per case values.

Service Line Payor Inpatient Analysis
report

Provides a service line payor mix related report with
multiple refresh variables. It is designed to provide a
template for other payor analysis type of reporting. The
report is useful in comparing payors and insurance plans
to each other using key financial metrics and across time.

Service Line Inpatient Period Comparison report
This report provides the ability to trend performance for a selected service line across two different time
periods. It is a flexible report that enables you to determine the current and prior periods and howmany
monthly periods to include within the report. Encounters can be selected by Admit or Discharge date and
Net Revenue can be determined based on Actual or Estimated.

This report also provides an option to Limit the Encounters to specific patients based on other tables,
e.g., certain procedures in the ENC_CPT or ENC_Proc tables, or for selected physicians in the ENC_
Provider table.

� Opening the report
In the DSS Reporting task pane, in the Service Line Analysis section, double-click Service Line Inpatient
Period Comparison.

� Refresh variables
The following table describes the variables you can configure for this report:
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Option Description

Admit or Discharge
Date

Select whether to populate the report based on encounter admit or
discharge date

Actual or Estimated
Net Revenue

Select whether to show estimated or actual net revenue

Current Year Select the year for the current year of this report

Current Starting
Month

Select themonth to begin analysis for the current year time frame

Prior Year Select the year for the current period of this report

Prior Year Starting
Month

Select themonth to begin analysis for the current year time frame

Number ofMonths
to Compare

Select the number ofmonths to compare between the two time frames

Primary Group By Select the column to use as definition for each row, often Service Line 1.

Secondary Group by Select the column to use as sub-definition for each row, for example
Attending Provider, Discharge Status, etc.

Limit Encounters
(optional)

Select the encounters in which to include in the report by using the Filter
Wizard.

� Report options
The following table describes the options available for this report:

Option Description

Group by Options (rows) l Service Line 1, Service Line 2, or Service Line 3. You can
specify the name.

l Data elements from the DSSBreakFields Table.

Measure Options l Actual or Estimated Revenue.
l Months, quarters, and years in Fiscal and Calendar

Years depending on the selection.

Views l Alerts – limits the columns in the report to the period
data and the associated alert for each row.

l Variances – suppress the alert and reflects the actual
variance from period to period in percentages.

l All – shows both values for each periods the variance
and the alert.

Quick Filtering Yes
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Option Description

Drills No

Printable Yes

Primary Source Table Encounter

Design Notes Report uses combined GetData and Axiom Architecture

� Report example

Service Line Margin Analysis report
This report provides the ability to evaluate performance across service lines by Inpatient, Outpatient or
Combined. It is a report that provides an Inpatient, Outpatient or Combined View and also has totals
and per case values. Expenses are classified as Variable or Fiexed, which allows you to evaluate the
contribution margin by service line. Encounters can be selected by Admit or Discharge date and Net
Revenue can be determined based on Actual or Estimated.

This report also provides an option to Limit the Encounters to specific patients based on other tables,
e.g., certain procedures in the ENC_CPT or ENC_Proc tables, or for selected physicians in the ENC_
Provider table.

� Opening the report
In the DSS Reporting task pane, in the Service Line Analysis section, double-click Service Line Margin
Analysis.

� Refresh variables
The following table describes the variables you can configure for this report:
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Option Description

Admit or Discharge Date Select whether to populate the report based on encounter
admit or discharge date

Actual or Estimated Net Revenue Select whether to show estimated or actual net revenue

Current From Select the starting year and month of the report

Current To Select the ending year and month of the report

Group By Select the column to use as a header for each row, often
Service Line 1, Service Line 2, etc.

Limit Encounters (optional) Select the encounters in which to include in the report by
using the Filter Wizard.

� Report options
The following table describes the options available for this report:

Option Description

Group by Options (rows) Service Line 1, Service Line 2, or Service Line 3. You can
specify the name.

Measure Options l Actual or Estimated Revenue
l Months to aggregate data to specific months, quarters,

and years in Fiscal and Calendar Years depending on
the selection

Views l Inpatient – Shows cases, patient days, ALOS and
financial performance for Inpatient cases

l Outpatient – Shows encounters and financial
performance for Outpatient cases

l Combined – shows both Inpatient and Outpatients
datal

Quick Filtering Yes

Drills No

Printable Yes

Primary Source Table Encounter

Design Notes Report uses combined GetData and Axiom Architecture
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� Report example

Service Line Payor Inpatient Analysis report
This report provides a Service Line payor mix related report with multiple refresh variables. It is designed
to provide a template for other payor analysis type of reporting. The report is useful in comparing payors
and insurance plans to each other using key financial metrics and across time. The report compares data
across a current and prior period, which is controlled by the user. It is designed to be used as an
inpatient report, but can bemodified to have alternative views or patient types.

This report is also a good example of how to control the sorting of a report. A number of options exist to
determine who the top plans, payors or financial classes are by sort on cases, patient days, ALOS or
other monetary measures such as Net Patient Revenue or Net Margin. The complete list of sorting
options are listed below.

� Opening the report
In the DSS Reporting task pane, in the Service Line Analysis section, double-click Service Line Payor
Inpatient Analysis.

� Refresh variables
The following table describes the variables you can configure for this report:

Option Description

Option Description

Admit or Discharge Date Select whether to populate the report based on encounter
admit or discharge date

Actual or Estimated Net Revenue Select whether to show estimated or actual net revenue

Service Line Filter 1 Select the Service Line field to use in the report
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Option Description

Service Line Filter 2 Select the Service Line filter from for the report

Insurance Plan Description Select from financial class description, payor description or
insurance plan description or code

Current From Select the starting year and month of the current period

Current To Select the ending year and month of the current period

Prior From Select the starting year and month of the comparison
period

Prior To Select the ending year and month of the comparison
period

Sort By Select the column in the report by which to sort the rows,
options include:

l Cases
l Patient Days
l ALOS
l Gross Patient Revenue
l Net Patient Revenue
l Direct Expenses
l Direct Margin
l Indirect Expenses
l Net Margin

Limit Encounters (optional) Select the encounters in which to include in the report by
using the Filter Wizard.

� Report options
The following table describes the options available for this report:

Option Description

Group by Options (rows) Financial Class, Payor or Insurance Plan. You can specify
the level of the group by based on the Refresh Variables.

Measure Options l Actual or Estimated Revenue.
l Months to aggregate data to specific months, quarters,

and years in Fiscal and Calendar Years depending on
the selection. You control the From and To for both the
Current and the Prior Periods.
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Option Description

Views l Alerts – limits the columns in the report to the period
data and the associated alert for each row.

l • Variances – suppress the alert and reflects the actual
variance from period to period in percentages.

Quick Filtering Yes

Drills No

Printable Yes

Primary Source Table Encounter

Design Notes Report uses combined GetData and Axiom Architecture

� Report example

Running the AxiomData Dictionary report
Use this report to view changes between the Axiom Databasemodel and the Axiom Intelligence Analysis
Services data model - including table or column name changes as well as denormalization of columns
onto different tables.

To run the Axiom Data Dictionary report:
1. In theDSS Admin task pane of the Desktop Client, in theDecision Support Reporting section,

click Axiom Intelligence Reports > Decision Support, and double-click DSS and AI Data
Dictionary.
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2. To filter the columns, click the arrow in the column header, select the check mark next to the items
to include or exclude, and click OK.
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